NetSim User Manual

Contents

1 NetSim – Introduction .................................................................................................................... 7
   1.1 Introduction to modeling and simulation of networks .................................................................. 7
   1.2 Versions of NetSim – Academic, Standard & Pro ................................................................. 7
   1.3 Components (Technology Libraries) in Pro and Std versions ............................................. 9

2 Getting Started in NetSim ............................................................................................................. 11
   2.1 System Requirements ............................................................................................................. 11
       2.1.1 NetSim Client (installs locally): ..................................................................................... 11
       2.1.2 License Server (for running HostID/ Dongle locked floating licenses, not applicable for node locked licenses): ............................................................. 11
   2.2 Installing NetSim ..................................................................................................................... 11
       2.2.1 Silent installation ........................................................................................................... 21
   2.3 Setting up License Server ....................................................................................................... 23
       2.3.1 Installing NetSim RLM Dongle Driver Software (Dongle Based Licenses) 23
       2.3.2 Running NetSim License Server .................................................................................. 25
       2.3.3 Running NetSim Software .......................................................................................... 26
       2.3.4 Menus in the NetSim Home Screen ............................................................................. 26
       2.3.5 Creating “New” Simulations ......................................................................................... 31
       2.3.6 Environment Settings: ................................................................................................. 32
   2.4 Modeling and Simulation of a simple network ......................................................................... 35
       2.4.1 Creating a Network scenario .......................................................................................... 36
       2.4.2 Configuring devices and links in the scenario ............................................................... 38
       2.4.3 Display settings ............................................................................................................ 39
       2.4.4 Copy/Paste ................................................................................................................... 40
       2.4.5 Modeling Traffic .......................................................................................................... 41
       2.4.6 Logging Packet/ Event Trace ....................................................................................... 43
       2.4.7 Run Simulation ............................................................................................................ 43
       2.4.8 NetSim Interactive Simulation ..................................................................................... 44
   2.5 Saving & Opening experiments and Printing results .............................................................. 54
       2.5.1 Opening Saved Experiments: Open Network – All Networks ................................... 54
       2.5.2 Saving an Experiment ................................................................................................ 54
   2.6 NetSim Keyboard Shortcuts ................................................................................................... 55
3 Workspaces and Experiments ................................................................. 56
  3.1 What is an Experiment and what is a workspace in NetSim? .......... 56
  3.2 How does a user create and save an experiment in workspace? .... 57
  3.3 Should each user have a workspace? ............................................ 60
  3.4 How does a user export an experiment? ....................................... 60
  3.5 How does a user delete an Experiment in a workspace? ............... 61
  3.6 How does a user create a new workspace? .................................. 61
  3.7 How does a user switch between workspaces? ............................ 63
  3.8 How does a user export a workspace? ......................................... 65
  3.9 How does a user import a workspace? ......................................... 67
  3.10 How does a user import an experiment? ................................... 69
  3.11 How does a user delete a workspace? ....................................... 70
  3.12 How does a user open and modify source codes? ....................... 71
  3.13 Can I use NetSim’s default code for my experiments? ............... 72

4 Simulating different networks in NetSim ........................................... 73
  4.1 Internetworks .............................................................................. 74
      4.1.1 Internetworks Examples ..................................................... 74
      4.1.2 Internetwork Documentation ............................................. 74
  4.2 Legacy Networks ......................................................................... 75
      4.2.1 Legacy Networks Examples ............................................... 75
      4.2.2 Legacy Network Documentation ...................................... 75
  4.3 Cellular Networks ....................................................................... 76
      4.3.1 Cellular Networks Examples ........................................... 76
      4.3.2 Cellular Networks Documentation .................................. 76
  4.4 Advanced Routing ....................................................................... 77
      4.4.1 Advanced Routing Examples ........................................... 77
      4.4.2 Advanced Routing Documentation .................................. 77
  4.5 MANETs .................................................................................... 78
      4.5.1 MANET Examples .......................................................... 78
      4.5.2 MANET Documentation .................................................. 78
  4.6 Wireless Sensor Networks (WSN) ................................................ 79
      4.6.1 Wireless Sensor Networks (WSN) Examples ..................... 79
      4.6.2 WSN Library Documentation .......................................... 79
  4.7 Internet of Things ........................................................................ 80
      4.7.1 Internet of Things (IOT) Examples ................................... 80
8 Writing Custom Code in NetSim ................................................................. 164

8.1 Writing your own code ........................................................................... 164
  8.1.1 Microsoft Visual Studio 2019 Installation Settings ......................... 164
  8.1.2 Modifying code ............................................................................... 165
  8.1.3 Building Dlls ................................................................................. 167
  8.1.4 Running Simulation ........................................................................ 168
  8.1.5 Source Code Dependencies ......................................................... 169

8.2 Implementing your code - Examples ...................................................... 170
  8.2.1 Hello World Program ..................................................................... 170
  8.2.2 Introducing Node Failure in MANET ........................................... 171

8.3 Debugging your code ............................................................................. 173
  8.3.1 Via GUI ......................................................................................... 173
  8.3.2 Via CLI ......................................................................................... 181
  8.3.3 Co-relating with Event Trace ....................................................... 183
  8.3.4 Viewing & Accessing variables .................................................... 186
  8.3.5 Print to console window in NetSim .............................................. 193

8.4 Creating a new packet and adding a new event in NetSim ...................... 194

8.5 NetSim API's ....................................................................................... 200

9 Advanced Features .................................................................................... 203

9.1 Random number Generator and Seed Values ........................................ 203

9.2 Interfacing MATLAB with NetSim (Std/Pro versions) .......................... 203
  9.2.1 Implement Rician Distribution of MATLAB without using .m file ...... 205
  9.2.2 Debug and understand communication between NetSim and MATLAB 214
  9.2.3 Implement Rician Distribution of MATLAB in NetSim using .m file: 219

  9.2.4 Plot a histogram in MATLAB per a Rician distribution (using .m file) 220

9.3 Interfacing tail with NetSim ................................................................... 224

9.4 Adding Custom Performance Metrics .................................................... 229

9.5 Adding Custom Plots ............................................................................ 232

9.6 Environment Variables in NetSim ....................................................... 235

9.7 Best practices for running large scale simulations .............................. 236

10 NetSim Emulator ..................................................................................... 238

10.1 Introduction .......................................................................................... 238

  10.1.1 Simulating and Analyzing Emulation Examples ........................... 238

11 Troubleshooting in NetSim ..................................................................... 239
11.1 CLI mode .................................................................................................................. 239
11.2 I/O warning displayed in CLI mode ............................................................................. 239
  11.2.1 Connection refused at server<111> error displayed: ........................................ 239
  11.2.2 Unable to load license config dll(126): ............................................................... 240
  11.2.3 “Error in getting License” error in CLI mode: ....................................................... 240
  11.2.4 Unable to load license config dll displayed: ....................................................... 241
11.3 Configuration.netsim ................................................................................................. 242
  11.3.1 Invalid attribute in configuration file attributes: .................................................. 242
  11.3.2 Error in tags in configuration file attributes: ....................................................... 242
  11.3.3 Error lines in configuration.xsd in the Configuration file: .................................. 243
11.4 Simulation terminates and “NetSim Backend has stopped working” displayed: ....... 244
11.5 Monitor screen resolution is less than 1024X768: ..................................................... 244
11.6 Licensing ...................................................................................................................... 245
  11.6.1 No License for product (-1) error ......................................................................... 245
11.7 Troubleshooting VANET simulations that interface with SUMO ......................... 245
  11.7.1 Guide for Sumo ..................................................................................................... 245
  11.7.2 Guide for Python .................................................................................................. 245
  11.7.3 VANET Simulation .............................................................................................. 247
  11.7.4 Python ................................................................................................................ 247
  11.7.5 NetSim Core Protocol Library ............................................................................. 247

12 Known Issues in NetSim v11.1 ..................................................................................... 248

13 NetSim Videos ............................................................................................................. 248

14 R&D projects in NetSim ............................................................................................. 248

15 NetSim FAQ/Knowledgebase ....................................................................................... 248
1 NetSim – Introduction

1.1 Introduction to modeling and simulation of networks

A network simulator enables users to virtually create a network comprising of devices, links, applications etc, and study the behavior and performance of the Network.

Some example applications of network simulators are

- Protocol performance analysis
- Application modeling and analysis
- Network design and planning
- Research and development of new networking technologies
- Test and verification

The typical steps followed when simulating any network are:

- **Building the model** – Create a network with devices, links, applications etc
- **Running the simulation** - Run the discrete event simulation (DES) and log different performance metrics
- **Visualizing the simulation** - Use the packet animator to view the flow of packets
- **Analyzing the results** - Examine output performance metrics such as throughput, delay, loss etc. at multiple levels - network, link, queue, application etc.
- **Developing your own protocol / algorithm** - Extend existing algorithms by modifying the simulator’s source C code

1.2 Versions of NetSim – Academic, Standard & Pro

NetSim is used by people from different areas such as academics, industry and defense to design, simulate, analyze and verify the performance of different networks.

NetSim comes in three versions- Academic, Standard and Pro. The academic version is used for lab experimentation and teaching. The standard version is used for R & D at educational institutions while NetSim Pro version addresses the needs of defense and industry. The standard and pro versions are available as components in NetSim v12 from which users can choose and assemble. The academic version is available as a single product and includes all the technologies shown below. A comparison of the features in the three versions are tabulated below:
<table>
<thead>
<tr>
<th>Features</th>
<th>Academic</th>
<th>Standard</th>
<th>Pro</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Technology Coverage</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Internetworks</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Legacy &amp; Cellular Networks</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Mobile Adhoc networks</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Software Defined Networks</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Wireless Sensor Networks</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Internet of Things</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Cognitive Radio Networks</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>LTE/LTE-A Networks</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>5G NR mmWave Networks</td>
<td></td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>VANET</td>
<td>N</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td><strong>Performance Reporting</strong></td>
<td></td>
<td></td>
<td>Y</td>
</tr>
<tr>
<td>Performance metrics available for Network and Sub-networks</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td><strong>Packet Animator</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Used to animate the packet flow in network</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td><strong>Packet Trace</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Available in tab ordered .txt format for easy post processing</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td><strong>Event Trace</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Available in tab ordered .txt format for easy post processing</td>
<td>N</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td><strong>Protocol Library Source Codes with Documentation</strong></td>
<td>N</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Protocol C source codes and appropriate header files with extensive documentation</td>
<td>N</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td><strong>External Interfacing</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Interfacing with SUMO</td>
<td>N</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MATLAB</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Wireshark</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Integrated debugging</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Users can write their own code, link their code to NetSim and debug using Visual Studio</td>
<td>N</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td><strong>Plots</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Allows users to plot the value of a parameter over simulation time</td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td><strong>Simulation Scale</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>100 Nodes</td>
<td>500 Nodes</td>
<td>~ 10,000 Nodes</td>
<td></td>
</tr>
<tr>
<td><strong>Custom Coding and Modeling Support</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Emulator (Add on)</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Connect to real hardware running live application</td>
<td>N</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td><strong>Military Radio (Add On)</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TDMA and DTDMA</td>
<td>N</td>
<td>N</td>
<td>Y</td>
</tr>
<tr>
<td><strong>Target Users and Segment</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Educational (Lab Experimentation)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Educational (Research)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Commercial (Industrial and Defense)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
# 1.3 Components (Technology Libraries) in Pro and Std versions

In NetSim v12, users can choose and assemble components (Technology libraries) for Standard and Pro versions. The components are as follows:

<table>
<thead>
<tr>
<th>Component No</th>
<th>Networks / Protocols</th>
<th>International Standards</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Component 1</strong> &lt;br&gt;(Base. Required for all components)</td>
<td>Internetworks &lt;br&gt;Ethernet - Fast &amp; Gigabit, ARP, Routing - RIP, OSPF, WLAN - 802.11 a / b / g / p / n / ac &amp; e, Propagation models - HATA Urban / Suburban, COST 231 HATA urban / Suburban, Indoor Home / Office / Factory, Friis Free Space, Log Distance, Shadowing - Constant, Lognormal, Fading - Rayleigh, Nakagami IPv4, Firewalls, Queuing - Round Robin, FIFO, Priority, WFQ, TCP - Old Tahoe, Tahoe, Reno, New Reno, BIC, CUBIC, Window Scaling, SACK UDP</td>
<td>IEEE 802.3, IEEE 802.11 a/b/g/n/ac/p/e</td>
</tr>
<tr>
<td><strong>Component 2</strong></td>
<td>Legacy &amp; Cellular Networks &lt;br&gt;Aloha – (Pure &amp; Slotted) GSM CDMA</td>
<td>3GPP, ETSI, IMT-MC, IS-95 A/B, 1xRTT, 1x-EV-Do, 3xRTT</td>
</tr>
<tr>
<td><strong>Component 3</strong></td>
<td>Advanced Routing &lt;br&gt;Multicast Routing - IGMP, PIM, Access Control Lists, Detailed Layer 3 switch mode, Virtual LAN (VLAN), Public IP, Network Address Translation (NAT)</td>
<td>IETF RFC’s 1771 &amp; 3121</td>
</tr>
<tr>
<td><strong>Component 4</strong></td>
<td>Mobile Adhoc Networks &lt;br&gt;MANET - DSR, AODV, OLSR, ZRP</td>
<td>IETF RFC 4728, 3561, 3626 IEEE 802.16d</td>
</tr>
<tr>
<td><strong>Component 5</strong></td>
<td>Software Defined Network (SDN)</td>
<td>Open Flow v1.3</td>
</tr>
<tr>
<td><strong>Component 6</strong> &lt;br&gt;(Component 4 required)</td>
<td>Internet of things (IOT) with RPL protocol Wireless Sensor Networks (WSN)</td>
<td>IEEE 802.15.4 MAC, MANET in L3 RFC 6550</td>
</tr>
<tr>
<td><strong>Component 7</strong></td>
<td>Cognitive Radio Networks &lt;br&gt;WRAN</td>
<td>IEEE 802.22</td>
</tr>
<tr>
<td><strong>Component 8</strong> &lt;br&gt;(Component 4 required)</td>
<td>Long-Term Evolution Networks: LTE, LTE - Advanced, LTE Device to Device (LTE D2D), LTE Femto Cell, LTE VANET</td>
<td>3GPP</td>
</tr>
<tr>
<td><strong>Component 9</strong> &lt;br&gt;(Component 4 required)</td>
<td>VANETs: IEEE 1609 WAVE, Basic Safety Message (BSM) protocol per J2735 DSRC, Interface with SUMO for road traffic simulation</td>
<td>IEEE 1609</td>
</tr>
<tr>
<td>Component 10 (Pro version only)</td>
<td>5G NR mmWave Networks: 3GPP 38 Series. Full Stack covering SDAP, PDCP, RLC – UM, TM, MAC, PHY – FR1 and FR2, mmWave propagation.</td>
<td>3GPP</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----</td>
</tr>
</tbody>
</table>
| Military Radio Add on (Pro version only) | Military Radio (Only in PRO Version)  
TDMA Link 16, Dynamic TDMA, Frequencies – HF, VHF, UHF Bands, Frequency Hopping | ---- |
| Network Emulator Add On | Network Emulator  
Connect real hardware running live applications to NetSim Simulator | ---- |
2 Getting Started in NetSim

2.1 System Requirements

2.1.1 NetSim Client (installs locally):

- Hardware: i3 equivalent or above, 4 GB RAM (minimum)
- Monitor resolution: Min - 1024*768, Max - 1920*1080. Optional Scale and layout setting: 100%
- Operating system: Win 8 or Win 10
- Software: MS Office, Adobe Reader
- Development Tools: Visual Studio
  - NetSim v8 / v8.1 / v8.3 / v9 / v9.1: Microsoft Visual Studio 2010 (or higher), Community edition (or higher for writing and debugging custom code)
  - NetSim v10 / v11 / v11.1: Microsoft Visual Studio 2015 (or higher), Community edition (or higher) is required for writing and debugging custom code
  - NetSim v12: Microsoft Visual Studio 2017 (or higher), Community edition (or higher) is required for writing and debugging custom code

2.1.2 License Server (for running HostID/ Dongle locked floating licenses, not applicable for node locked licenses):

Any one system will have to be made as the license server, and it is to this PC that the license is locked, either via its MAC ID or via a dongle. The dongle is a USB device which controls the licensing. The system (hardware / OS) requirements is same as that applicable for NetSim clients. USB Port is required for connecting and running the dongle. Client systems should be able to communicate with license server through the network.

2.2 Installing NetSim

Install the 32-bit or 64-bit build of NetSim depending on your PC platform.
Based on the NetSim version under installation the version type being displayed in the following windows will change. For example, you will see NetSim Standard for a standard version install. Click on Yes button to install the software.

Setup prepares the installation wizard and software installation begins with a Welcome Screen.
Click on the **Next** button. In the next screen, License agreement will be displayed.

Read the agreement carefully, scroll down to read the complete license agreement. Click "**I Agree**" button else quit the setup by clicking **Cancel** button.

If you agree with the license agreement, you will be prompted to select the components to be installed. The list of components is available for selection and assembly only in the Standard and Pro version. Other versions of NetSim are available as a single package.

Click on the **Next** button.
**Note:** Select all the supporting applications for complete installation of the software. In the next screen, you will be requested to enter the installation path. Select the path in which the software needs to be installed and click on **Next** button.

On the next screen, you will be requested to enter the Start menu folder name.

Click on the **Install** button to start the installation. The installation process begins.
After the installation of required NetSim files, the installation of third party tools begin.

For NetSim Standard Version and Pro Version, Wireshark installation will start by default (if not deselected during 3rd party software selection). Click on Next to start Wireshark installation. In the following window, click on I Agree.
Select all the components and click on Next.

Click on Next to go to Install Location window as shown below.
Specify the destination and click on **Next**.

Select **Install Npcap** and click on **Next**.
Select **Install USBPcap** and click on **Install**. After the installation of the software, you will be requested to click **Next** and then **Finish** to complete the installation process.

To start Python software installation, select the checkbox of "Add python 3.7 to PATH", then select **Install Now** and the Installation begins.
Click on **Close** once setup was successful.

To install Pywin32, Click on **Next**

Select the Python directory and Click on **Next**.
Click on **Next** and the installation Pywin32 begins.

Click on **Finish**. This completes the Installation of python software.
Select “Run NetSim” and then click on the Finish button. This completes the installation of NetSim Software.

To run NetSim double click on NetSim icon on Dekstop. NetSim License Server Information screen will appear. Enter the Server IP address where the rlm.exe is running and click OK.

![NetSim License Server Information](image)

**Note:** During the installation of NetSim Academic version the supporting software installed is Npcap.

### 2.2.1 Silent installation

Steps for silent installation in NetSim are as follows:

1. For example, let us take the NetSim Standard 64-bit setup. Right click on NetSim Standard 64bit setup → Go to properties and copy the location as shown below:
2. Open command prompt and paste the copied location as shown below:

```bash
> cd <setup location>
```

Then, press enter.

3. Run Execute Command with the following parameters,

```
NetSim_Standard_12_0_18_HW_64bit.exe /S /silent=1
```

I. `silent=1`: will install NetSim and third party tools silently

II. `/S`: will Install NetSim itself Silently
4 Users can click on “Yes” as shown below to begin installation of NetSim Standard.

NOTE: Complete installation of NetSim may take upto 2 to 3 minutes.

2.3 Setting up License Server

2.3.1 Installing NetSim RLM Dongle Driver Software (Dongle Based Licenses)

This section guides you to install the RLMDongle Driver software from the CD-ROM.

1 Insert the CD-ROM disc in the CD drive.
2 Double click on My Computer and access the CD Drive.
3 Double click on Driver_Software folder.
4 Double click on HASPUserSetup.exe

Each prompt displayed during the process tells you what it is about to do and prompts to either continue or Exit.

Setup prepares the installation wizard and the software installation begins with a Welcome Screen. Click on the Next button.

Note: Any other program running during the installation of the Dongle will affect the proper installation of the software.
In the next screen, the License agreement is displayed. Read the license agreement carefully, scroll down to read the complete license agreement. If the requirement of the license agreement is accepted select the "I accept" button else quit the setup by clicking Cancel button.

Click on the Next button

The installation process begins.
After the installation of the software, you will be requested to click Finish button to complete the installation process. Now the RLM driver software is installed successfully.

If the driver has been successfully installed then upon connecting the Dongle in the USB port red light would glow (Refer picture below). If the driver is not correctly installed this light will not glow when the dongle is connected to the USB port.

2.3.2 Running NetSim License Server

- Copy the NetSim License Server folder and paste it on Desktop. Check that it has the license file. If not copy the paste the license file into the License server folder
- Double click on NetSim License Server folder from Desktop.
- Double click on rlm.exe
- For hardware dongle-based users: After the Driver Software installation, connect the RLM dongle to the system USB port. Double click on My Computer and access the CD Drive. This CD contents will have the NetSim License server folder.
**Note:** For running **NetSim, rlm.exe** must be running in the server (license server) system and the server system IP address must be entered correctly. Without running **rlm.exe**, **NetSim** won’t run. When you run rlm.exe, the screen will appear as shown below.

![Running NetSim Software](image)

### 2.3.3 Running NetSim Software

After running rlm.exe, double click the NetSim icon in the Desktop. The screen given below will be obtained. Enter the Server IP address where the rlm.exe is running and click OK.

![NetSim Standard](image)

### 2.3.4 Menus in the NetSim Home Screen

You see the NetSim Home Screen when you run NetSim software for the first time, after checking out a license from the NetSim License Server.

See the following image for an example of the NetSim Home screen.

![NetSim License Server Information](image)
You see the following items on the NetSim Home screen:

1. **New Simulation**: Use this menu to simulate different types of networks in NetSim. You can simulate the following types of networks: Internetworks, Legacy Networks, Mobile Adhoc networks, Cellular Networks, Wireless Sensor Networks, Internet of Things, Cognitive Radio Networks, LTE/LTE-A Networks (LTE/LTE-A, LTE femtocell, LTE D2D, LTE Vanet), 5G NR mmWave (newly added component in v12), and VANETs.

2. **Open Simulation**: Use this menu to load saved configuration files from the current workspace. You can view, modify or re-run existing simulations. Along with this, users can also export the saved files from the current workspace to their preferred location on their PC's.

3. **Examples**: Use this menu to perform simulations of different kinds categorized technology-wise. Users can choose any network which they want to work and further go down by using a double click on it or by a click on the arrow pointer which will take you to the next level. By a click on any simulation file will open a pre-existing simulation file which users can run and analyze the results. Users can click on the book icon present in the right-hand side of each network which opens the corresponding pdf files.
This helps the users with all information about the current simulation as well as the entire network technology.

Similarly, on the other side, users can find experiments section which has various experiments covering all the technologies in NetSim. Users can choose their experiment by either a double click on it or by a click on the pointer arrow which will take you the samples. Click on the sample to open the particular experiment in NetSim. All the settings to carry out a particular experiment are already done. Users can click on the book icon present in the right-hand side of each experiment. This will open the corresponding pdf file for the experiment which consists of detailed description of that particular experiment.

4. **License Settings:** Use this menu to perform the following. Click on License Settings provides users with three sub-menus related to License information.

**License Server Information:** Use this menu to view details about the NetSim License Server that is hosted locally to check the licenses you need to run NetSim.

See the following image for an example of what the NetSim Home screen displays, if you click the License Server Information menu item.
You will see the following details on the NetSim Home screen, if you click the License Server Info menu item: the type of platform on which NetSim is running, the version of RLM, the Dongle RLM ID, the IP address of the NetSim License Server, and the path to the license files in the server hosting NetSim License Server.

**End User License Agreement:** Use this menu to view the end user license agreement. You will see the following details on NetSim Home screen, if you click the End User License Agreement menu item: Grant of License and Use of the Services, License Restrictions, License Duration, Upgrade and Support Service etc.

**Configure Installed Components/Libraries:** Use this menu to allow NetSim users to simulate only specific types of networks (by the licenses and libraries associated with the types of networks). You control access to types of networks by selecting libraries for specific types of networks that NetSim License Server checks out when NetSim users start NetSim.

NetSim Home screen displays libraries for components for which you have purchased licenses.

**Note:** You can select or clear libraries and control access to NetSim users, only if you are using floating licenses.

See the following image for an example of what the NetSim Home screen displays, if you click the Configure Installed Components/Libraries menu item.
Use the License Settings menu as follows:

- Select the checkboxes for the component libraries (types of networks) that NetSim users must be allowed to simulate.
- Clear the checkboxes for the component libraries (types of networks) that NetSim users must not be allowed to simulate.

The Internetwork component is greyed out. You cannot clear the Internetworks component because Internetworks is a base component that is required for all the other components to work.

5. **Documentation**: Use this section to open the following NetSim help documents: These include the **User Manual** which consists of complete description about all the features in NetSim and how it can be used by the end users, the **Technology Libraries** which provides users with an access to a detailed description of various Network Technologies present in NetSim through individual pdf files, and **NetSim Source code help** which comes along with Standard and Pro Versions of NetSim, allows users to gain a better understanding of the underlying code structure for in-depth analysis.

6. **Learn**: Use this section to learn more about the software which includes the following: **Videos** section can be used to view videos related to NetSim in TETCOS YouTube channel. This channel helps users by providing frequent updates on what’s new in NetSim, topics related to various network technologies covering different versions of
NetSim, and monthly webinars. The *Experiments Manual* section grants you access to a well-designed experiments manual covering various networking concepts which helps users to easily understand different networks and also gain ideas to carry out their own experimentation in NetSim.

7. **Support**: Use this section to reach TETCOS helpdesk. *Contact Technical Support* link can be used to raise a *trouble ticket*, you can also write to us via *Email* to [support@tetcos.com](mailto:support@tetcos.com), and *Answers/FAQ* link grants you access to our *Knowledge Base* which contains answers to all your questions most of the time. Users can utilize the wealth of information present in it, which are further classified into the following: FAQs, Technologies/Protocols, Modelling/UI/Results, and Writing your own code in NetSim.

8. **Contact Us**: Use this section to contact us and know more information about our product. You can write to us via *Email* to [sales@tetcos.com](mailto:sales@tetcos.com) or contact us via *Phone* to our official number +91 76760 54321.

9. **Website**: Use this link [www.tetcos.com](http://www.tetcos.com) to visit our website which consists of vast information that will assist you through all walks of NetSim.

2.3.5 **Creating “New” Simulations**

The Simulation window loads up once user selects the desired network technology from the New Menu.

**To create a Network scenario**

Click on New Simulation and select the desired kind of network to simulate.
Save

To save experiment, select File → Save, then specify the Experiment Name, Description (Optional) and click Save. The short cut for the same is Ctrl + S.

Save as

To save an already existing/saved experiment by a different name after performing required modifications/changes to it (without overwriting the existing copy), Save As option can be used. Select File → Save As, then specify the Experiment Name, Description (Optional) and click Save. The short cut for the same is Shift + Ctrl + S and F12.

2.3.6 Environment Settings:

The settings menu provides user’s access to the simulation environment settings.
The Environment Settings window is used to switch between Grid View and Map View backgrounds in supported network technologies. For Grid view, users can configure the Grid environment length in meters.

2.3.6.1 Grid Co-ordinates

The Grid coordinate system has its origin at the upper left of the drawing area, and positive Y is down while positive X is to the right.
For Map view users can configure the latitude and longitude respectively.

Users can zoom in and out of the map to add devices in specific geographical locations.
Learn

This menu contains link to NetSim Videos on TETCOS Youtube Channel and NetSim Experiments manual.

Documentation

This menu contains link to NetSim User Manual, Technology Libraries and NetSim Source Code Help.

2.4 Modeling and Simulation of a simple network

This section will demonstrate how to create a basic network scenario and analyze in NetSim. Let us consider Internetworks. To create a new scenario, Go to New Simulation ➔ Internetworks.
2.4.1 Creating a Network scenario

In this example, a network with two subnets is designed. Let us say the subnet 1 consists of two wired nodes connected via a Switch and the other subnet consists of one wired node. Both the subnets are connected using a Router. Traffic in the Network flows from a wired node in subnet 1 to the wired node in subnet 2.

Perform the following steps to create this network design.

**Step 1: Drop the devices.** Click on Node icon and select → Wired Node
Click on the environment (the grid) where you want the Wired Node to be placed. In this way, place two more wired nodes. Similarly, to place a Switch and a Router, click on the respective device and click on the environment at the desired location.

![Diagram of wired and wireless devices](image)

**Note:** The (x, y) position of any device on the grid is given by top left corner of the icon and not the center of the icon.

**Step 2: Connecting devices on the environment.** With respect to establishing connection between devices, and in order to connect two devices, you will have to select the link and then left click on one device, free the mouse button, then click on the second device and free the mouse button. The wired links may disappear if you right click anywhere in the Environment. Clicking and dragging without freeing the mouse pointer would displace the device in the environment.

![Diagram of connected devices](image)
For example, select link and the click on Switch followed by router to connect them. In this manner, continue to link all devices.

![Diagram of network setup](image)

### 2.4.2 Configuring devices and links in the scenario

**Step 1:** To configure any device, right click on the device and select properties

![Properties menu for device](image)

User can set values according to their requirement. Modify the properties of any device and click on Ok. In this example default values are accepted.
Step 2: To configure the links, right click on any Link and select Properties.

In above scenario, default values are accepted.

2.4.3 Display settings

In NetSim, users can Turn-On or Turn-Off display information such as IP Address of the devices, Link speed etc. For doing this click on Display settings as shown below
2.4.4 Copy/Paste

In NetSim simple copy paste can be used. Using this feature users can copy all the properties of a device and create a new device with similar properties.

**Working of Copy/ Paste with example**

Right click on the device, click on copy on the device that users need to use it to drop similar device

In this example we have considered a Wired Node for which the Device Name and Device Icon is modified. Right click on the device and select Copy.
Right click on the grid environment on the appropriate position that you need to drop the device click on Paste. A new device with similar properties will be added to the grid at the specific location as shown below:

Remove in the device options, is used to delete the device from the grid environment. Given below is an example of removing the device User_Device_4 which was previously pasted.

2.4.5 **Modeling Traffic**

After the network is configured, user needs to model traffic from Wired Node 2 to Wired Node 3. This is done using the application icon. Click on the Application icon present on the ribbon.
In screen shot shown below the Application type is set to CBR, source_ID is 2 and Destination_ID is 3. Click on OK.

![Configure Application](image)

Application Configuration:

1. In a wired network with routers and switches OSPF, Spanning tree etc takes times to converge and hence it is a good practice to set the application start time greater than OSPF convergence time. In general, the applications can start at 20s for smaller networks and should be increased as the size of the network grows.

2. If applications are started before OSPF convergence, then
   - Packets generated before OSPF table convergence may be dropped at the gateway router.
   - The application may also stop if ICMP is enabled in the router.
   - If TCP is enabled TCP may stop after the re-try limit is reached (since the SYN packets would not reach the destination)

3. For MANET networks the application start time should be a min of 5s, since that amount of time is required for convergence of OLSR/ZRP

4. Jumbo Frames are not supported in NetSim Ethernet Protocol
2.4.6 Logging Packet/ Event Trace

Packet and Event Trace files are useful for detailed simulation analysis. By default, these are not enabled since it slows down the simulation. To enable logging of Packet Trace / Event Trace click on the icon in the tool bar as shown below. Set the file name and select the required attributes to be logged. For more information, please refer sections 7.5 and 7.6 respectively.

![Packet Trace and Event Trace icons](image)

2.4.7 Run Simulation

For simulating the network scenario created, click on Run Simulation present in the Ribbon

![Run Simulation](image)

Set the Simulation Time to 10 seconds. Click on OK.
2.4.8 **NetSim Interactive Simulation**

NetSim allows users to interact with the simulation at runtime via a socket or through a file. User Interactions make simulation more realistic by allowing command execution to view/modify certain device parameters during runtime.

**Working:** This section will demonstrate how to perform Interactive simulation for a simple network scenario.

Let us consider Internetworks. To create a new scenario, go to New → Internetworks

Click & drop Wired Nodes and Router onto the Simulation Environment and link them as shown below or otherwise Open the scenario for Interactive Simulation which is available in “<NetSim Install Dir>\Docs\Sample_Configuration\Internetworks\Interactive Simulation”

- Click on Application icon present in the top ribbon and set the Application type as CBR. The Source_Id is 1 and Destination_Id is 2.
- Set Start Time as 30 Sec
- Enable Plots and Packet trace options
- Click on run simulation option and In the Run time Interaction tab set Interactive Simulation as True and click on Accept
Click on run simulation and set Simulation Time as 500 sec. (It is recommended to specify a longer simulation time to ensure that there is sufficient time for the user to execute the various commands and see the effect of that before Simulation ends) and click OK.

Simulation (NetSimCore.exe) will start running and will display a message “waiting for first client to connect” as shown below:

After Simulation window opens, goto Network scenario and right click on Router_3 or any other node and select NetSim Console option.
• Now Client (NetSimCLI.exe) will start running and it will try to establish connection with NetSimCore.exe. After connection is established the window will look similar like this shown below:

• After this the command line interface can be used to execute the supported commands

*Note: Commands are not a case sensitive*

1. Simulation specific (Not applicable for file based interactive simulation)
   - Pause
   - PauseAt
   - Continue
   - Stop
   - Exit
   - Reconnect

**Pause**: To pause the currently running simulation

**PauseAt**: To pause the currently running simulation with respect to particular time (Ex: To Pause simulation at 70.2 sec use command as **PauseAt 70.2**)

**Continue**: To start the currently paused simulation

**Stop**: To stop the currently running simulation (NetSimCore.exe)

**Exit**: To exit from the client (NetSimCLI.exe)
**Reconnect**: To reconnect client (NetSimCLI.exe) to simulation (NetSimCore.exe) when we rerun simulation again

2. Ping Command

- The ping command is one of the most often used networking utilities for troubleshooting network problems
- You can use the ping command to test the availability of a networking device (usually a computer) on a network
- When you ping a device you send that device a short message, which it then sends back (the echo)
- If you receive a reply then the device is in Network, if you don’t then the device is faulty, disconnected, switched off, incorrectly configured
- You can use the `ping` cmd with an IP address or Device name
- ICMP_Status should be set as True in all nodes(Wired_Node and Router)

- Right click on Wired_Node_1 and go to properties. Under General properties enable Wireshark Capture option as “Online”

**Ping Command Results:**

Ping `<IP address>` e.g. ping 11.4.1.2
Ping `<NodeName>` e.g. ping Wired_Node_2
After simulation open packet trace and filter ICMP_EchoRequest and ICMP_EchoReply from CONTROL_PACKET_TYPE/APP_NAME column.

Open Wireshark and apply filter ICMP. We can see the ping request and reply packets in Wireshark.

3. Route Commands
- route print
- route delete
- route add

In order to view the entire contents of the IP routing table, use following commands route print.
• You will see the routing table entries with network destinations and the gateways to which packets are forwarded when they are headed to that destination. Unless you've already added static routes to the table, everything you see here will be dynamically generated.

• In order to delete a route in the IP routing table, you will type a command using the following syntax:

   `route delete destination_network`

• So, to delete the route with the destination network 11.5.0.0, all we'd have to do is type this command:

   `route delete 11.5.1.2`

• To check whether the route has been deleted or not, check again using the `route print` command.

• To add a static route to the table, you will type a command using the following syntax:

   `route ADD destination_network MASK subnet_mask gateway_ip metric_cost interface`

• So, for example, if you wanted to add a route specifying that all traffic bound for the 11.5.1.2 subnet went to a gateway at 11.5.1.1:

   `route ADD 11.5.1.2 MASK 255.255.0.0 11.5.1.1 METRIC 100 IF 2`
• If you were to use the **route print** command to look at the table now, you would see your new static route

![Route Print Command](image)

**Note:** Entry added in IP table by routing protocol continuously gets updated. If a user tries to remove a route via route delete command, there is always a chance that routing protocol will re-enter this entry again. Users can use ACL / Static route to override the routing protocol entry if required.

3. ACL Configuration:

Routers provide basic traffic filtering capabilities, such as blocking Internet traffic, with access control lists (ACLs). An ACL is a sequential list of permit or deny statements that apply to addresses or upper-layer protocols. These lists tell the router what types of packets to: permit or deny. When using an access-list to filter traffic, a permit statement is used to “allow” traffic, while a deny statement is used to “block” traffic.

**Commands to configure ACL:**

- To view ACL syntax use: **acl print**
- Before using ACL’s, we must first verify that acl option enabled. A common way to enable ACL use command: **ACL Enable**
- Enters configuration mode of ACL using: **aclconfig**
- To view ACL Table: **Print**
- To exit from ACL configuration use command: **exit**
- To disable ACL use command: **ACL Disable** (use this command after exit from acl configuration)

To view ACL usage syntax use: **acl print**
Step to Configure ACL:

- To create a new rule in the ACL use command as shown below to block UDP packet in Interface_2 and Interface_3 of the Router_3
- Disable TCP in all nodes (Wired Node and Router)
- Click on run simulation option and In the Run time Interaction tab set Interactive Simulation as True and click on Accept
- Set the Simulation Time as 500 sec or more. Click Ok
- Right click on Router_3 and select NetSim Console. Use the command as follows:

```
NetSim> acl enable
ACL is enable
NetSim> aclconfig
ROUTER_3/ACLCONFIG> acl print
Usage: [PERMIT, DENY] [INBOUND, OUTBOUND, BOTH] PROTO SRC DEST SPORT DPORT IFID
ROUTER_3/ACLCONFIG> DENY BOTH UDP ANY ANY 0 0 2
OK!
ROUTER_3/ACLCONFIG> DENY BOTH UDP ANY ANY 0 0 3
OK!
ROUTER_3/ACLCONFIG> print
DENY BOTH UDP ANY/0 ANY/0 0 0 2
ROUTER_3/ACLCONFIG> exit
NetSim> acl disable
ACL is disable
NetSim>
```
ACL Results:

The impact of ACL rule applied over the simulation traffic can be observed in the IP_Metrics_Table in the simulation results window. In Router_3 number of packets blocked by firewall has been shown below.

*Note: Results will vary based on time of ACL command are executed*

- Check Packet animation window whether packets has been blocked in Router_3 or not after entering ACL command to deny UDP traffic
- Before applying ACL rule there is packet flow from Wired_Node_1 to Wired_Node_2
- After applying ACL rule Packet flows up to Router_3 only

The impact of ACL rule applied over the simulation traffic can be observed in the Application throughput plot. Throughput graph will show a drop after ACL is set. If ACL is disabled after a while, application packets will start flowing across the router. The Application throughput plot will show a drop and increase (Moving throughput graph) in throughput after setting ACL and disabling ACL respectively.

**Example:** ACL rule applied at around 50sec user can see the drop in throughput in the graph, since router blocks UDP packets in the plot. Once ACL has been disabled at around 240sec router permits packets and hence throughput can be observed in the plot shown below
2.5 Saving & Opening experiments and Printing results

2.5.1 Opening Saved Experiments: Open Network – All Networks

Click on Open Simulation (Ctrl+O).

Open saved experiment file you want to open.

2.5.2 Saving an Experiment

**During Simulation:** Users can save by using the short cut CTRL + S

**After Simulation: From Network Window:** Click on File → Save button on the top left. Next, specify the Experiment Name, Description (Optional) and click on Save.

Upon saving a number of files would get saved inside the folder, including

- Configuration file (.netsim format) & metrics file (xml format)
- Trace Files (csv format), if enabled, and
- Plot data (txt format)
## 2.6 NetSim Keyboard Shortcuts

NetSim keyboard shortcuts can be used for frequently performed tasks. The keyboard shortcuts that are currently supported are listed in the table below:

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Home Screen</strong></td>
<td></td>
</tr>
<tr>
<td>Ctrl + N</td>
<td>Open a New Network</td>
</tr>
<tr>
<td>Ctrl + O</td>
<td>Open a Saved Network</td>
</tr>
<tr>
<td><strong>Design Window (Any Network)</strong></td>
<td></td>
</tr>
<tr>
<td>Ctrl + C</td>
<td>Copy</td>
</tr>
<tr>
<td>Ctrl + V</td>
<td>Paste</td>
</tr>
<tr>
<td>Ctrl + A</td>
<td>Select All</td>
</tr>
<tr>
<td>Ctrl + R</td>
<td>Open Run Simulation Window</td>
</tr>
<tr>
<td>Ctrl + S</td>
<td>Save the Experiment</td>
</tr>
<tr>
<td>Shift + Ctrl + S</td>
<td>Save As (To Save under different name)</td>
</tr>
<tr>
<td>Ctrl + P</td>
<td>Open Image/Screenshot of the network scenario that is designed in the GUI</td>
</tr>
<tr>
<td>Alt+ F4</td>
<td>Close Window</td>
</tr>
<tr>
<td>F1</td>
<td>User Manual Help</td>
</tr>
<tr>
<td>Ctrl + '+'/-'</td>
<td>Zoom In/Zoom Out</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>Delete the devices in the Environment with links</td>
</tr>
<tr>
<td><strong>Simulation Console</strong></td>
<td></td>
</tr>
<tr>
<td>Ctrl + C</td>
<td>Terminates Simulation in Mid way. Results will be calculated till the time at which the simulation is terminated</td>
</tr>
<tr>
<td><strong>Packet Animation Window</strong></td>
<td></td>
</tr>
<tr>
<td>Space bar</td>
<td>To Play/Pause animation</td>
</tr>
</tbody>
</table>
3 Workspaces and Experiments

3.1 What is an Experiment and what is a workspace in NetSim?

When you design & simulate a network in NetSim it is saved as an experiment. This experiment is saved within a Workspace. In a logical sense, a workspace contains all the source code files, executable files, icons, data files etc.

A workspace can contain one or more experiments.

In general, users need not change the workspace and can use the default workspace.

New workspaces need to be created by users when:

1. The user wants to modify the underlying source code of NetSim as is typically in research applications. The modified code will be saved in that workspace.
2. A user chooses to save and organize a large number of experiments. These can be saved under different workspaces provided by that user.
3. The same PC/NetSim build is shared between multiple users

The default workspace of NetSim will have the Master Source code and the Master Binaries (Compiled files)

A default workspace is created in a user selected directory when NetSim is run for the first time after installation. Choose the path where user wants the default workspace to be created and click on OK.
This default workspace contains the folders

1. `\src` - contains protocol source codes
2. `\bin\bin_x86` - contains NetSim binaries for 32-bit and `\bin\bin_x64` contains NetSim binaries for 64-bit
3. `\icons` - contains icons of the devices, links etc

3.2 How does a user create and save an experiment in workspace?
To create an experiment, select New Simulation -> <Any Network> in the NetSim Home Screen.
Create a network and save the experiment by clicking on File->Save button on the top left.

A save popup window appears which contains Experiment Name, Folder Name, Workspace path and Description.

Specify the Experiment Name and Description (Optional) and then click on Save. The workspace path is non-editable. Hence all the experiments will be saved in the default workspace path. After specifying the Experiment Name click on Save.

In our example we saved with the name MANET and this experiment can be found in the default workspace path as shown below:
Users can also see the saved experiments in Open Simulation menu shown below:

Note: “Save As” option is also available to save the current experiment with a different name.

Users can also have options to “rename the experiment” or to “open the folder where the experiment is saved” by right clicking on the experiment in the current workspace window as shown below:
3.3 Should each user have a workspace?

There is no strict association between users and workspaces. A single user can have multiple workspaces (and in turn experiments in each workspace), or multiple users can operate in one workspace.

3.4 How does a user export an experiment?

To save experiments in a different location, first save the experiment in the current workspace and use export option present under Open Simulation menu in the NetSim Home Screen.

If you click on Export, an Export Experiment pop-up window appears where you can input the experiment name and the Export path.
The exported experiments would be saved with *.netsim_exp extension.

3.5 How does a user delete an Experiment in a workspace?

Users can delete experiments by clicking on the delete icon as shown below:

It displays a popup window as shown below and click on OK.

3.6 How does a user create a new workspace?

To create a new workspace, click on Workspace options present in Open Simulation Menu shown below:
Then select More Options

And select New
A New Workspace pop-up window appears where you can input the Workspace Name, Description and Workspace Path (where you want to create new workspace).

3.7 How does a user switch between workspaces?

Users can also switch from one workspace to another workspace. For doing this, Select Open Simulation->Workspace Options->More Options and click on the workspace you want to switch to.
And then select “Set as Current” as shown below:
3.8 How does a user export a workspace?

Users can export workspaces by selecting Open Simulation->Workspace Options->More Options. Then select Export as shown below:

The following window is displayed
Binaries, Source Code (available only for Standard and Pro) and Icons are added by default as shown above. Users can add all experiments present in the current workspace by clicking on the All Experiments check box and then click on Export as shown below.

It displays a window shown below where users need to give the path to which the workspace has to be exported and then click on OK.

Users can also have options to export individual experiments by right clicking on the experiment and select Add to add the experiment to the export list as shown below.
The added experiments will be available in the export list shown below

After adding the experiments click on Export and follow the same procedure as explained above

**Note:** Users can import only the exported workspaces.

### 3.9 How does a user import a workspace?

Users can import workspaces by selecting Open Simulation->Workspace Options->More Options. Then select Import as shown below:
It displays a window where users need to give the path of the workspace folder and click on OK as shown below.

The Imported workspace will be set as the current workspace. To see the imported workspace, click on Open Simulation->Workspace Options->More Options as shown below.
3.10 How does a user import an experiment?

Users can also have option to import experiments. For this click on Open Simulation and then select Import Experiment as shown below:

The following window is displayed where users need to give the path from which the experiment has to be imported and then click on OK.
User can import the configuration file also through giving the path from which the configuration file has to be imported, then describe the experiment name and click on OK

![Import Experiment dialog box](image)

The imported experiment will be available in the current workspace. To see the imported experiment, click on Open Simulation as shown below:

![Workspace configuration](image)

**Note**: Users can import only the exported experiments

### 3.11 How does a user delete a workspace?

Users can also delete a workspace by clicking on the delete icon shown below:
**Note:** Deleting current workspace is not allowed. Deleting a workspace will delete all saved experiments and code modifications done in that workspace.

### 3.12 How does a user open and modify source codes?

User can also modify the source codes within a workspace. For doing this, select open Simulation->Workspace Options->Open Code as shown below.
This opens the source codes in MS Visual Studio.

Users can then modify the protocol codes and build the solution. Then users can create a network in NetSim or open the saved experiment which involves the protocol that has been modified and click on run simulation. This simulation will run per the modified code.

**Note:** The changes in the source codes applies to the current workspace only

**3.13 Can I use NetSim's default code for my experiments?**

Yes, each workspace will have a Reset option which would set

1. Binaries (compiled files) to default
2. Code (source C codes) to default
4 Simulating different networks in NetSim

When you install NetSim, you get access to inbuilt examples to help you understand how the different types of networks work. For information on how to use the NetSim UI to simulate the Examples and create your own simulations, see NetSim User Interface.

The following table lists what versions of NetSim you must use to simulate the networks.

<table>
<thead>
<tr>
<th>Type of Network</th>
<th>NetSim Versions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internetwork</td>
<td>All versions</td>
</tr>
<tr>
<td>Legacy Network</td>
<td>All versions</td>
</tr>
<tr>
<td>Cellular Network</td>
<td>All versions</td>
</tr>
<tr>
<td>MANET</td>
<td>All versions</td>
</tr>
<tr>
<td>Wireless Sensor Network</td>
<td>All versions</td>
</tr>
<tr>
<td>Software Defined Network</td>
<td>All versions</td>
</tr>
<tr>
<td>Internet of Things</td>
<td>All versions</td>
</tr>
<tr>
<td>Cognitive Radio</td>
<td>All versions</td>
</tr>
<tr>
<td>LTE</td>
<td>All versions</td>
</tr>
<tr>
<td>5G NR mmWave</td>
<td>Available only with NetSim Standard and NetSim Pro versions</td>
</tr>
<tr>
<td>VANET</td>
<td>Available only with NetSim Standard and NetSim Pro versions</td>
</tr>
<tr>
<td>Military Radio</td>
<td>Available only with NetSim Pro version</td>
</tr>
</tbody>
</table>
4.1 Internetworks

An Internetwork is a collection of two or more computer networks (typically Local Area Networks or LANs) which are interconnected to form a bigger network.

Internetworks library in NetSim covers Ethernet, Address Resolution Protocol (ARP), Wireless LAN – 802.11 a / b / g / n / ac, Internet Protocol (IP), Transmission Control Protocol (TCP), Virtual LAN (VLAN), User Datagram Protocol (UDP), and routing protocols such as Routing Information Protocol (RIP), Open Shortest Path First (OSPF), Internet Group Management Protocol (IGMP), and Protocol Independent Multicast (PIM).

To simulate Internetworks, click on New Simulation and then click on Internetworks.

4.1.1 Internetworks Examples

To simulate the Examples for different types of Internetworks:

1. Go to the NetSim UI and click **Examples**.
   The Example Simulation pane appears at the right.
2. Click the **Internetwork** example you wish to simulate. NetSim UI loads the example.

4.1.2 Internetwork Documentation

To view help documentation users can either click on “Technology Libraries” under documentation in the home screen or click the ‘Book’ link located next to Internetworks in examples. The help documentation explains the following:

- Simulation GUI
- Model Features
- Featured Examples
- Reference Documents
- Latest FAQ available online
4.2 Legacy Networks

Legacy networks cover older generation protocols which are rarely used today and not part of the TCP/IP protocol suite. With the advent of TCP/IP as a common networking platform in the mid-1970s, most legacy networks are no longer used.

NetSim Legacy Network library cover Pure Aloha and Slotted Aloha.

ALOHA is a protocol that was developed at the University of Hawaii and used for satellite communication systems in the Pacific. ALOHA protocol was designed to send and receive messages between multiple stations, on a shared medium. Slotted ALOHA is an improvised version of pure ALOHA designed to reduce the chances of collisions when sending data between the sender and the receiver.

To simulate Legacy Networks, click on New Simulation and then under Legacy networks click on either Pure Aloha or Slotted Aloha

4.2.1 Legacy Networks Examples

To simulate Pure ALOHA and Slotted ALOHA Examples:

1. Go to the NetSim UI and click Examples. The Example Simulation pane appears at the right.
2. Click the Legacy Network example you want to simulate. NetSim UI loads the example.

4.2.2 Legacy Network Documentation

To view help documentation either click on “Technology Libraries” under documentation in the home screen or click the ‘Book’ link located next Legacy Networks in examples. The help documentation explains the following:

- Simulation GUI
- Model Features
- Featured Examples
- Reference Documents
- Latest FAQ available online
4.3 Cellular Networks

A cellular network (also known as a mobile network) is a communication network where the last link is wireless. The network is distributed over land areas called cells. Every cell is served by at least one fixed-location transceiver known as a base station. These cells together provide radio coverage over larger geographical areas. User equipments such as mobile phones, can communicate even if the user is moving across different cells.

NetSim cellular networks library covers Global System for Mobile communication (GSM) and Code-Division Multiple Access (CDMA).

To simulate Cellular Networks, click on New Simulation and then under Cellular networks click on either GSM or CDMA.

4.3.1 Cellular Networks Examples

To simulate GSM and CDMA Examples:

1. Go to the NetSim UI and click Examples. The Example Simulation pane appears at the right.
2. Click the Cellular Network example you want to simulate. NetSim UI loads the example.

4.3.2 Cellular Networks Documentation

To view help documentation either click on “Technology Libraries” under documentation in the home screen or click the ‘Book’ link located next Cellular Networks in examples. The help documentation explains the following:

- Simulation GUI
- Model Features
- Featured Examples
- Reference Documents
- Latest FAQ available online
4.4 Advanced Routing

NetSim supports the following advanced routing protocols

- Multicast Routing –
  - Internet Group Management Protocol (IGMP)
  - Protocol Independent Multicast (PIM)
- Access Control Lists (ACLs)
- Virtual LAN (VLAN)
- Public IP and Network Address Translation (NAT)

To simulate the above-mentioned routing protocols, click on New Simulation and then Internetworks.

4.4.1 Advanced Routing Examples

To simulate the Examples for different types of Advanced Routing protocols

1. Go to the NetSim UI and click **Examples**.
   The Example Simulation pane appears at the right.
2. Click the **Advanced-Routing** example you wish to simulate. NetSim UI loads the example.

4.4.2 Advanced Routing Documentation

To view help documentation users can either click on “Technology Libraries” under documentation in the home screen or they can click the ‘Book’ link located next to Advanced Routing in examples. The help documentation explains the following:

- Simulation GUI
- Model Features
- Featured Examples
- Reference Documents
- Latest FAQ available online
4.5 MANETs

Mobile Ad-hoc Network (MANET) is an ad hoc network that can change locations and configure itself on the fly. Because MANETS are mobile, they use wireless connections to connect to various networks.

NetSim MANET library covers:
- L3 Routing Protocols – DSR, AODV, OLSR and ZRP
- MAC Layer – IEEE 802.11
- MANET using Bridge_Node(Wired) and Bridge_Node(Wireless)

To simulate MANET, click on New Simulation and then select Mobile Adhoc networks.

4.5.1 MANET Examples

To simulate MANET Examples:

1. Go to the NetSim UI and click Examples.
   The Example Simulation pane appears at the right.
2. Click the Mobile-Adhoc-Networks example you want to simulate. NetSim UI loads the example.

4.5.2 MANET Documentation

To view help documentation either click on “Technology Libraries” under documentation in the home screen or click the ‘Book’ link located next MANET Networks in examples. The help documentation explains the following:
- Simulation GUI
- Model Features
- Featured Examples
- Reference Documents
- Latest FAQ available online
4.6 Wireless Sensor Networks (WSN)

Wireless Sensor Network (WSN) is a group of spatially dispersed sensors that monitor and collect the physical conditions of the environment and transmit the data they collect to a central location. WSNs measure environmental conditions such as temperature, sound, pollution levels, humidity, wind, and so on.

WSN in NetSim is part of NetSim’s IOT library and covers 802.15.4 MAC, PHY with MANET routing protocols.

To simulate WSN, click on New Simulation and then Wireless Sensor Networks.

4.6.1 Wireless Sensor Networks (WSN) Examples

To simulate Wireless Sensor Networks Examples:

1. Go to the NetSim UI and click Examples.
   The Example Simulation pane appears at the right.
2. Click the IOT-WSN > Internet-of-Things example you want to simulate. NetSim UI loads the example.

4.6.2 WSN Library Documentation

To view help documentation either click on “Technology Libraries” under documentation in the home screen or click the ‘Book’ link located next to IOT-WSN examples. The help documentation explains the following:

- Simulation GUI
- Model Features
- Featured Examples
- Reference Documents
- Latest FAQ available online
4.7 Internet of Things

Internet of things (IoT) is a network of objects such as vehicles, people, home appliances that contain electronics, software, actuators that are accessible from the public Internet. The objects are embedded with suitable technology and use IP addresses to interact and exchange data without manual assistance or intervention. The objects can also be remotely monitored and controlled.

In NetSim, IoT is modeled as a WSN that connects to the internet via a 6LowPAN Gateway. WSN for IoT uses the following protocols: AODV with IPv6 addressing at the L3 layer and 802.15.4 at the MAC & PHY layers. WSN sends data to the LowPAN Gateway which uses a Zigbee (802.15.4) interface and a WAN Interface. The Zigbee interface connects wirelessly to the WSN and the WAN interface connects to the Internet. Additionally users can also simulate and analyze energy model for IoT.

To simulate IoT, click on New Simulation and then Internet of Things

4.7.1 Internet of Things (IOT) Examples

To simulate IOT Examples:

1. Go to the NetSim UI and click Examples. The Example Simulation pane appears at the right.
2. Click the IOT-WSN > Wireless-Sensor-Networks example you want to simulate. NetSim UI loads the example.

4.7.2 IOT Library Documentation

To view help documentation either click on “Technology Libraries” under documentation in the home screen or click the ‘Book’ link located next to IOT-WSN examples. The help documentation explains the following:

- Simulation GUI
- Model Features
- Featured Examples
- Reference Documents
- Latest FAQ available online
4.8 Software Defined Networks (SDN)

Software-defined networking (SDN) is an architecture that makes networks agile and flexible. SDN decouples the network control and forwarding functions. SDN allows you to program your network control and abstracts the physical infrastructure for applications and network services. This approach enables enterprises and service providers to respond quickly to the changing business requirements.

Unlike other technologies, and due to the way SDN works it is not available as a menu item under New Simulation. SDN can be configured when running Internworks, MANET, IOT, WSN, Cognitive Radio, LTE or VANETs.

4.8.1 Software Defined Networks (SDN) Examples

To simulate Software Defined Networks Examples:

1. Go to the NetSim UI and click **Examples**. The Example Simulation pane appears at the right.
2. Click the **Software-Defined-Networks** example you want to simulate. NetSim UI loads the example.

4.8.2 SDN Library Documentation

To view help documentation either click on “Technology Libraries” under documentation in the home screen or click the ‘Book’ link located next to Software Degined Network examples. The help documentation explains the following:

- Simulation GUI
- Model Features
- Featured Examples
- Reference Documents
- Latest FAQ available online
4.9 Cognitive Radio

Cognitive Radio (CR) is an adaptive, intelligent radio and network technology that automatically detects available channels in a wireless spectrum and changes transmission parameters to enable higher levels of communication. Cognitive Radio can be programmed and configured dynamically to use the best wireless channels in its vicinity to avoid user interference and congestion.

NetSim Cognitive Radio module is based on the IEEE 802.22 standard. Additionally, you can connect a Cognitive Radio with Internetwork devices and run all the protocols supported in Internetworks.

To simulate Cognitive Radio, click on New Simulation and then Cognitive Radio Networks

4.9.1 Cognitive Radio Examples

To simulate Cognitive Radio Examples:

1. Go to the NetSim UI and click Examples. The Example Simulation pane appears at the right.
2. Click the Cognitive-Radio example you want to simulate. NetSim UI loads the example.

4.9.2 Cognitive Radio Library Documentation

To view help documentation either click on “Technology Libraries” under documentation in the home screen or click the ‘Book’ link located next to Cognitive Radio examples. The help documentation explains the following:

- Simulation GUI
- Model Features
- Featured Examples
- Reference Documents
- Latest FAQ available online
4.10 LTE

Long Term Evolution (LTE) is a standard for 4G wireless broadband technology that offers increased network capacity and speed to mobile device users. LTE offers higher peak data transfer rates -- up to 100 Mbps downstream and 30 Mbps upstream.

NetSim LTE Library support LTE/LTE-Advanced Networks along with LTE FemtoCell, LTE D2D and LTE VANETs (which requires VANET library)

Additionally, you can connect an LTE Network with Internetwork devices and run all the protocols supported in Internetworks.

To simulate LTE/LTE-A networks, click on New Simulation and then a suitable option under Long Term Evolution Networks.

4.10.1 LTE Examples

To simulate LTE Examples:

1. Go to the NetSim UI and click Examples. The Example Simulation pane appears at the right.
2. Click the LTE and LTE-A example you want to simulate. NetSim UI loads the example.

4.10.2 LTE Library Documentation

To view help documentation either click on “Technology Libraries” under documentation in the home screen or click the ‘Book’ link located next to LTE and LTE-A examples. The help documentation explains the following:

- Simulation GUI
- Model Features
- Featured Examples
- Reference Documents
- Latest FAQ available online
4.11 5G LTE NR mmWave

NetSim 5G library features full stack, end-to-end, packet level simulation of 5G mmWave networks. The 5G library is based on Rel 15 / 3GPP 38.xxx series.

NetSim 5G library models all layers of the protocol stack as well as applications running over the network. This 5G library is architected to connect to the base component of NetSim (and in turn to other components) which provides functionalities such as TCP/IP stack protocols, Wireless protocols, Routing algorithms, Mobility, Output Metrics, Animation, Traces etc.

To simulate 5G NR mmWave networks, click on New Simulation and then 5G NR mmWave.

4.11.1 5G LTE NR mmWave Examples

To simulate LTE Examples:

3. Go to the NetSim UI and click Examples. The Example Simulation pane appears at the right.
4. Click the 5G NR mmWave example you want to simulate. NetSim UI loads the example.

4.11.2 5G LTE NR mmWave Library Documentation

To view help documentation either click on “Technology Libraries” under documentation in the home screen or click the ‘Book’ link located next to LTE and LTE-A examples. The help documentation explains the following:

- Simulation GUI
- Model Features
- Featured Examples
- Specifications scheduled for next release
- Reference Documents
4.12 VANETs

Vehicular Ad-Hoc Network (VANET) is a sub set of a Mobile Ad-Hoc Network or MANET that allows vehicle-to-vehicle and vehicle-to-roadside communications to ensure safe transportation.

To simulate VANET click on New Simulation and then click on VANET

4.12.1 VANET Examples

To simulate VANET Examples:

1. Go to the NetSim UI and click Examples.
   The Example Simulation pane appears at the right.
2. Click the VANETs example you want to simulate. NetSim UI loads the example.

4.12.2 VANET Library Documentation

To view help documentation either click on “Technology Libraries” under documentation in the home screen or click the ‘Book’ link located next to VANET examples. The help documentation explains the following:

- Simulation GUI
- Model Features
- Featured Examples
- Reference Documents
- Latest FAQ available online
4.13 Military Radio (TDMA/DTDMA)

Military communications or military signals involve all aspects of communications to convey information in armed forces. Military Communications include text, audio, facsimile, tactical ground-based communications, terrestrial microwave, tropospheric scatter, naval, satellite communications systems and equipment, surveillance and signal analysis, encryption and security and direction-finding and jamming.

NetSim Military Radio module uses TDMA/DTDMA in MAC/PHY along with MANET Routing protocols in Layer 3.

To simulate Military Radios, click on New Simulation → Military Radios and select TDMA/DTDMA in MAC/PHY layer of the devices.

*Note: Military Radio component is available only in NetSim pro version.*

4.13.1 Military Radio Examples

To simulate Military Radio Examples:

1. Go to the NetSim UI and click Examples.
   The Example Simulation pane appears at the right.

2. Click the TDMA-and-DTDMA example you want to simulate. NetSim UI loads the example.

4.13.2 Military Radio (TDMA/DTDMA) Library Documentation

To view help documentation either click on “Technology Libraries” under documentation in the home screen or click the ‘Book’ link located next to TDMA/DTDMA examples. The help documentation explains the following:

- Simulation GUI
- Model Features
- Featured Examples
- Reference Documents
- Latest FAQ available online
5 Traffic generator (Application models)

NetSim allows users to model and simulate different types of applications:

1. CBR
2. Custom
3. COAP
4. Database
5. FTP
6. Email
7. HTTP
8. PEER_TO_PIEER
9. Video
10. Voice
11. Sensor App
12. Erlang Call
13. BSM
14. Emulation (Only if Emulator Add-on is present)

To set up the application click on the application icon from the tool bar as shown below:
This properties window allows you to model the application traffic. You can add (or) delete one or more applications by clicking on the “+” or “-” symbols present on top left-hand side next to the Application.

5.1 Common properties for all the traffic types

**Application Method:** It specifies the type of Application method either Unicast/Multicast/Broadcast.

**Application Type:** It specifies the type of application such as CBR, Custom, Peer to Peer, COAP, Email, HTTP, FTP, Voice, Video, Database, Erlang Call, Sensor App, BSM, and Emulation.

**Application ID:** This property represents the unique identification number of the application.

**Application Name:** It specifies the name of the application.

**Source Count:** This property represents number of sources for the application. Voice, Video, FTP, Database and Custom applications have only one source.

**Source ID:** This property represents the unique identification number of the source.

**Destination Count:** This property represents number of destinations for the application. Voice, Video, FTP, Database and Custom applications have only one destination.

**Destination ID:** This property represents the unique identification numbers of the destination.
For **Unicast** Applications, users can select the ID of a device in the network as the Destination ID.

For **Broadcast** Applications, the Destination ID is set to ‘0’.

For **Multicast** Applications, users can enter the number of multicast destinations in the Destination Count field and specify the Device ID’s of the destination devices separated by comma (",") in the Destination ID field. Eg 6, 7, 8

**Start time:** This property represents the start time of the application in seconds.

**End time:** This property represents the end time of the application in seconds.

*Note: Suppose Start time is 1 and end time is 10 then application starts generating traffic at 1st second and ends at 10th second.*

**Encryption:** Encrypts Application packet payload using algorithms such as AES, DES, XOR and TEA. The effect of encryption can be analyzed by enabling Wireshark option in either the source or the destination devices. Refer Section 7.7 on “Packet Capture and Analysis Using Wireshark” for further details.

In NetSim the packet size remains constant when encrypting using these algorithms. Therefore, using different encryption models will not have any impact on the network performance metrics that NetSim outputs.

NetSim does not perform decryption of the packet at the receiver end since it does not have any impact on the performance metrics generated.

**Random Startup:** If random start up is set true, application will start at +1s. Having a random start-up time provides more realism to the model since all applications need not necessarily start at time = 0 in the real world.

**QoS:** NetSim provides QoS differentiation for the different types of applications through four defined scheduling service types, also called QoS classes.
### QoS Class

<table>
<thead>
<tr>
<th>QoS Class</th>
<th>Description</th>
<th>Priority</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>UGS - Unsolicited Grant Service</strong></td>
<td>The UGS scheduling service type is designed to support real-time data streams consisting of fixed-size data packets issued at periodic intervals</td>
<td>High</td>
</tr>
<tr>
<td><strong>rtPS - Real-time Polling Service</strong></td>
<td>The rtPS scheduling service type is designed to support real-time data streams consisting of variable-sized data packets that are issued at periodic intervals. This would be the case, for example, for MPEG (Moving Pictures Experts Group) video transmission</td>
<td>Medium</td>
</tr>
<tr>
<td><strong>ertPS - Extended real-time Polling Service</strong></td>
<td>The ertPS is a scheduling mechanism that builds on the efficiency of both UGS and rtPS. UGS allocations are fixed in size, ertPS allocations are dynamic. The ertPS is suitable for variable rate real-time applications that have data rate and delay requirements.</td>
<td>Normal</td>
</tr>
<tr>
<td><strong>nrtPS - Non-real-time Polling Service</strong></td>
<td>The nrtPS is designed to support delay-tolerant data streams consisting of variable-size data packets for which a minimum data rate is required. The standard considers that this would be the case, for example, for an FTP transmission.</td>
<td>Low</td>
</tr>
<tr>
<td><strong>BE - Best Effort</strong></td>
<td>The BE service is designed to support data streams for which no minimum service guarantees are required and therefore may be handled on a best basis.</td>
<td>Low</td>
</tr>
</tbody>
</table>

**Priority:** In a complex network, packets may reach a router from many directions. Priority scheduling algorithm will allow the router to fix priority level for different sources from different directions. Higher priority packets are processed first and sent out.

### 5.2 Application Types

Brief explanation of application types

<table>
<thead>
<tr>
<th>Application Type</th>
<th>Properties</th>
<th>Units</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CBR – Constant bit Rate</strong></td>
<td><strong>Packet size</strong> (Constant distribution) – It is the size of the packet</td>
<td>bytes</td>
<td>Packets of constant size are generated at constant inter arrival times.</td>
</tr>
<tr>
<td></td>
<td><strong>Inter Arrival Time</strong> (Constant distribution) – It is the gap between two successive packets</td>
<td>µs</td>
<td></td>
</tr>
<tr>
<td><strong>Custom</strong></td>
<td><strong>Packet size</strong> (Constant, Exponential distribution) – It is the size of the packet</td>
<td>bytes</td>
<td>It is User defined application that can be configured based on user requirements</td>
</tr>
<tr>
<td><strong>Peer to Peer</strong></td>
<td><strong>Inter Arrival Time</strong></td>
<td>(\mu s)</td>
<td></td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------------</td>
<td>-----------</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(Constant, Exponential</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>distribution) – It is the</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>time gap between two</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>successive packets</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>File size distribution</strong></td>
<td>(Constant, Exponential</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>distribution)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Value</strong> – Size of the file</td>
<td>bytes</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Piece size</strong> - Each file is divided into equal sized pieces. This property represents the size of each piece</td>
<td>bytes</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Email</strong></td>
<td><strong>Email send/receive</strong> – Represents the rate at which emails are sent/receive</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td><strong>Duration</strong> (Constant, Exponential distribution) - Time between two successive emails</td>
<td>Seconds</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Email size</strong> (Constant, Exponential distribution) – Size of an email</td>
<td>Bytes</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>HTTP – Hyper Text Transfer Protocol</strong></td>
<td><strong>Inter Arrival Time</strong></td>
<td>seconds</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(Constant, Exponential</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>distribution) – It is the</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>time gap between two</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>successive HTTP requests</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Page size</strong> (Constant, Exponential distribution) – It is the size of each page</td>
<td>bytes</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Page count</strong> – Represents the number of pages</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>COAP – Constrained Application Protocol</strong></td>
<td><strong>Inter Arrival Time</strong></td>
<td>seconds</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(Constant, Exponential</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>distribution) – It is the</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>b/w two successive</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>COAP requests</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Page size</strong> (Constant, Exponential distribution) – It is the size of each page</td>
<td>bytes</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Response time</strong> – It is the time taken by a device to generate response</td>
<td>ms</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Multicast response</strong> – Represents the server responds to multicast response or not</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>FTP – File Transfer Protocol</strong></td>
<td>File size (Constant, Exponential distribution) – It is the size of the file</td>
<td>bytes</td>
<td>It is a standard network protocol used for the transfer of files between a client and server. <strong>Note:</strong> Devices must have TCP enabled in Transport layer for implementing FTP application successfully. <strong>Ex</strong> – Filezilla</td>
</tr>
<tr>
<td><strong>Database</strong></td>
<td>Transaction size (Constant, Exponential distribution) – It represents the size of each transaction</td>
<td>bytes</td>
<td>A database application is a computer program whose primary purpose is entering and retrieving information from a computerized database. <strong>Ex</strong> – MS Excel, MySQL etc.</td>
</tr>
<tr>
<td><strong>Voice</strong></td>
<td>Packet size (Constant, Exponential) – It is the size of the packet</td>
<td>bytes</td>
<td>It allows users to configure voice application between client and server. <strong>Note</strong> – Distribution is constant only for all codec types except custom. <strong>Ex</strong> – Skype, Team Viewer, Google Voice etc.</td>
</tr>
<tr>
<td><strong>NSTART</strong> – Limit the number of simultaneous outstanding interactions that a client maintains to a given server</td>
<td></td>
<td>-</td>
<td></td>
</tr>
<tr>
<td><strong>DEFAULT_LEISURE</strong> – This setting is only relevant in multicast scenarios, outside the scope of the EST-coaps draft</td>
<td></td>
<td>-</td>
<td></td>
</tr>
<tr>
<td><strong>PROBING_RATE</strong>: A parameter which specifies the rate of re-sending Non-confirnable messages.</td>
<td></td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Ack required – It represents whether the ack for the request/response to be sent or not</td>
<td></td>
<td>-</td>
<td></td>
</tr>
<tr>
<td><strong>File Inter Arrival Time</strong> – It is the gap between two successful files</td>
<td></td>
<td>-</td>
<td></td>
</tr>
<tr>
<td><strong>Transaction Inter Arrival Time</strong> (Constant, Exponential distribution) – It is the time gap between two successful transactions</td>
<td></td>
<td>-</td>
<td></td>
</tr>
<tr>
<td><strong>Packet Inter Arrival Time</strong> (Constant, Exponential distribution) - It is the gap between two successful packets</td>
<td></td>
<td>-</td>
<td></td>
</tr>
<tr>
<td><strong>Service type</strong> – CBR, VBR</td>
<td></td>
<td>-</td>
<td></td>
</tr>
<tr>
<td><strong>Suppression models available for VBR</strong> – Deterministic, Markov chain</td>
<td></td>
<td>-</td>
<td></td>
</tr>
<tr>
<td><strong>Video</strong></td>
<td><strong>Success ratio</strong> - Sets the ratio of the packets that are not silenced during VBR calls</td>
<td>%</td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>----------------------------------------------------------------------------------</td>
<td>---</td>
<td></td>
</tr>
<tr>
<td><strong>Model Type</strong> - Continuous Normal VB, Continuous State Autoregressive Markov, Quantized State Continuous Time Markov, Simple IPB Composite Model</td>
<td></td>
<td>-</td>
<td></td>
</tr>
<tr>
<td></td>
<td>It allows users to configure video application between client and server</td>
<td>Ex – Skype</td>
<td></td>
</tr>
<tr>
<td><strong>Packet size</strong> (Constant, Exponential distribution) – It is the size of the packet</td>
<td>bytes</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Packet Inter Arrival Time</strong> (Constant, Exponential distribution) - It is the gap between two successful packets</td>
<td>µs</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Erlang Call</strong></td>
<td><strong>Call duration</strong> (Constant, Exponential distribution) – It is the duration of each call</td>
<td>seconds</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Call Inter Arrival Time</strong> (Constant, Exponential distribution) - It is the gap between two successful calls</td>
<td>seconds</td>
<td></td>
</tr>
<tr>
<td><strong>Service type</strong> – VBR, CBR</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Suppression model available for VBR</strong> – Deterministic, Markov chain</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Success ratio</strong> - Sets the ratio of the packets that are not silenced during VBR calls</td>
<td>%</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Sensor App</strong></td>
<td><strong>Packet size</strong> (Constant distribution) – It is the size of the packet</td>
<td>bytes</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Packet Inter Arrival Time</strong> (Constant distribution) - It is the gap between two successful packets</td>
<td>µs</td>
<td></td>
</tr>
<tr>
<td><strong>BSM – Basic safety message</strong></td>
<td><strong>Packet size</strong> (Constant, Exponential distribution) – It is the size of the packet</td>
<td>bytes</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Packet Inter Arrival Time</strong> (Constant, Exponential distribution) - It is the gap</td>
<td>µs</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The erlang is a unit of traffic density in a telecommunications system. One erlang is the equivalent of one call</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> – Distribution is constant only for all codec types except custom</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Used to create application between two sensors</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Ex – Smart home, Smart water etc.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>The BSM Application class sends and receives the IEEE 1609 WAVE (Wireless Access in Vehicular Environments) Basic Safety Messages (BSMs). The BSM is a 20-byte packet that is generally broadcast from every vehicle at a nominal rate of 10 Hz.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> - Available only with VANET component</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
between two successful packets | Ex – Traffic management

**Source Real IP** - Specifies the real IP Address of source device in Emulation

**Source Port** - Specifies the Port no used for transmission by Application running in source device

**Destination Real IP** - Specifies the real IP Address of destination device in Emulation

**Destination Port** - Specifies the Port no used for reception by Application running in destination device

NetSim Emulation application enables users to connect NetSim simulator to real hardware and interact with live applications.

**Note**
1. Will be present only when Emulator Add-on is installed.
2. If user wants to modify application.dll and run emulation then application.dll must be built in release mode only. If built in debug mode then emulation won't work.

**Voice, Erlang call**

For Voice and Erlang call applications, Codec option is available as follows

**Codec**

Codec stands for Coder-decoder. Codecs are devices which encode / decode digital data streams. Codec is the component of any voice system that translates between analog speech and the bits used to transmit them. Every codec transmits a burst of data in a packet that can be reconstructed into voice.

Five different standards of voice codec’s available in NetSim are G.711, G.729, G.723, GSM-FR, GSM-EFR which can be selected depending on the variations required. Packet size and Inter-arrival time value will vary depending on the codec value chosen.

**G.711**: G.711 is a Pulse code modulation (PCM) of voice frequencies on a 64 kbps channel. G.711 uses a sampling rate of 8,000 samples per second. Non-uniform quantization with 8 bits is used to represent each sample, resulting in a 64 kbps bit rate. There are two types of standard compression algorithms are used.

- μ-law algorithm
- A-law algorithm.
**G.729:** The G.729 speech codec uses audio data compression algorithm and compress the data at bit rates that vary between 6.4 and 12.4 kbps. Coding of speech at 8 kbps using conjugate-structure algebraic-code-excited linear prediction (CS-ACELP).

**G.723:** G.723 is an ITU standard for speech codecs that uses the ADPCM method and provides good quality audio at 24 and 40 Kbps.

**GSM-FR:** GSM–Full Rate (GSM-FR) speech codec was developed in early 1990s and was adopted by the 3GPP for mobile telephony. The codec operates on each 20ms frame of speech signals sampled at 8 KHz and generates compressed bit-streams with an average bit-rate of 13 kbps. The codec uses Regular Pulse Excited – Long Term Prediction – Linear Predictive Coder (RPE-LTP) technique to compress speech. The codec provides voice activity detection (VAD) and comfort noise generation (CNG) algorithms and an inherent packet loss concealment (PLC) algorithm for handling frame erasures. The codec was primarily developed for mobile telephony over GSM networks.

**GSM-EFR:** GSM enhanced full rate speech codec is a speech coding standard that was developed in order to improve the quite poor quality of GSM-Full Rate (FR) codec. Working at 12.2 kbps the EFR provides wire like quality in any noise free and background noise conditions. The EFR 12.2 kbps speech coding standard is compatible with the highest AMR mode (both are ACELP).

**CUSTOM:** It is similar to CUSTOM application type as explained above

**Video Models**

**Model Type**

- **Continuous Normal VBR** – This model is the simplest of all models. It uses Normal Distribution for the generation of bits per pixel. In this model, consecutive packet sizes are independent of each other.
  - **Frames per second** – Number of frames arriving per second. This is in the range of 10 – 100.
  - **Pixels per frame** – Number of pixels in each frame. This is in the range of 10000 – 100000.
  - **Bits per pixel (μ)** – Mean value of the normal distribution used to generate the value of bits per pixel.
  - **Bits per pixel (Σ)** – Standard Deviation of the normal distribution used to generate the value of bits per pixel.
The generation rate for video application can be calculated by using the formula:

\[ \text{Generation Rate (bits per second)} = \text{fps} \times \text{ppf} \times \text{bpp} \]

where, fps = frames per second, ppf = pixel per frame, bpp (µ) = bits per pixel (mean)

Users can set the above-mentioned parameters in the Application Properties.

- **Continuous State Autoregressive Markov** – This model incorporates the autocorrelation between the frames. Also, current packet size depends on the previous packet size via the first order autoregressive Markov process.
  - **Frames per second** – Number of frames arriving per second. This is in the range of 10 – 50.
  - **Pixels per frame** - Number of pixels in each frame. This is in the range of 10000 – 100000.
  - **Constants A, B** – First order autoregressive Markov process \( \lambda(n) \) can be generated by the recursive relation
    \[
    \lambda(n) = a\lambda(n-1) + bw(n).
    \]
  - **Eta** – The steady-state average \( E(\lambda) \) and discreet auto covariance \( C(n) \) are given by
    \[
    E(\lambda) = \frac{b}{1-a} \eta \quad \text{and} \quad C(n) = \frac{b^2}{1-a^2} \eta n.
    \]

- **Quantized State Continuous Time Markov** – In this model the bit rate is quantized into finite discrete levels. This model takes uniform quantization step as \( A \) bits/pixel. There are \( M + 1 \) possible levels (0, A… MA). Transitions between levels are assumed to occur with exponential rates that may depend on the current level. This model is approximating the bit rate by a continuous time process \( \lambda(t) \) with discrete jumps at random Poisson time.
  - **Frames per second** – Number of frames arriving per second. This is in the range of 10 – 100.
  - **Pixels per frame** - Number of pixels in each frame. This is in the range of 10000 – 100000.
  - **No of Multiplexed Sources** – This model considers the aggregate instantaneous input rate \( \lambda N(t) \) instead of the single source bit rate \( \lambda(t) \). The total rate is the sum of \( N \) independent random processes each with mean \( E(\lambda) \) and variance \( C(0) \) at steady state. Therefore, the steady state- mean of \( \lambda N(t) \) will be \( E(\lambda N) = N \times E(\lambda) \) bits/pixel.
  - **Quantization Level** – This model takes uniform quantization step as \( A \) bits/pixel. There are \( M + 1 \) possible levels (0, A, MA). Transitions between
levels are assumed to occur with exponential rates that may depend on the current level.

- **Simple IPB Composite Model**—In this model, the frames are organized as IBBPBBPBBPBBPIPBB... i.e., 12 frames in a Group of Pictures (GOP). Generate X₀ from a Gaussian distribution $N(0, \sigma_0)$. Set initial value $N_0 = 0$, $D_0 = 1$.

For $k = 1, 2, \ldots, N-1$, calculate $\Phi_{kj}$, $j = 1, 2, \ldots, k$ iteratively using the following formulae

$$N_k = r(k) - \sum_{j=1}^{k-1} \Phi_{k-j} r(k-j)$$

$$D_k = D_{k-1} - (N_{2k-1}/D_{k-1})$$

$$\Phi_{kk} = N_k / D_k$$

$$\Phi_{kj} = \Phi_{k-1,j} - \Phi_{k,k} \Phi_{k-1,k} - \sum_{j=1}^{k-1}$$

$$m_k = \sum_{j=1}^{k} \Phi_{kj} X_k$$

$$y_k = (1 - \Phi_{2kk}) y_{k-1}$$

Finally, each $X_k$ is chosen from $N(m_k, y_k)$. Thus we get a process $X$ with ACF approximating to $r(k)$.

The auto correlation function can be calculated in a recursive way as follows:

$$r(0) = 1, \quad r(k+1) = \left(\frac{k+d}{k+1}\right) r(k)$$

Where $d = H - 0.5$.

$H$ is called the Hurst parameter $k$-$\beta$ is used as the ACF of a self-similar process. We get the value of $H$ parameter for a self-similar process using the relationship,

$$B = 2 - 2H$$

Distribution of these data is Gaussian. For data to be Beta distributed, the following mapping is being used.

$$Y_k = F^{-1}\beta(F_N(X_k)), \quad k > 0$$

$X_k$: Self-similar Gaussian process,

$F_N$: The cumulative probability of normal distribution,

$F^{-1}\beta$: The inverse cumulative probability functions of the Beta model.
- **Frames per second** – Number of frames arriving per second. This is in the range of 10 – 50.

### 5.3 Generation Rate for Different Applications

This section explains how the generation rate can be calculated for different types of applications:

**CBR and Custom application**

\[
\text{Generation Rate (Mbps)} = \frac{\text{Packet size (bytes)} \times 8}{\text{Inter arrival time (\(\mu s\))}}
\]

Example: Packet size = 1460Bytes and Inter arrival time = 20000\(\mu s\).

Generation rate (Mbps) = 1460*8/20000 = 0.584Mbps

**Video**

The traffic generation rate for Video applications are based on the CONTINUOUS_NORMAL_VBR model. This CONTINUOUS_NORMAL_VBR model is the simplest of all video models in NetSim. It uses Normal Distribution for the generation of bits per pixel. In this model, consecutive packet sizes are independent of each other. The generation rate for video application can be calculated by using the formula shown below:

\[
\text{Generation Rate (bits per second)} = \text{fps} \times \text{ppf} \times \text{bpp}
\]

where, fps = frames per second

ppf = pixel per frame

bpp (\(\mu\)) = bits per pixel (mean)

Users can set the above-mentioned parameters in the Application Properties.

Example: Frames per second = 20, pixels per frame = 10000, bits per pixel = 0.52 then the generation rate would be

Generation rate (bps) \(=\) fps*ppf*bpp

\(=\) 20*10000*0.52 = 104000 bits per second = 0.1040 Mbps
Voice

\[ \text{Generation Rate (Mbps)} = \frac{(\text{Packet size (bytes)} \times 8)}{\text{Inter arrival time (\mu s))} \]

Note – Distribution is constant for all codec types except custom

Email

\[ \text{Generation Rate (Mbps)} = \frac{(\text{Email size (bytes)} \times 8)}{\text{Duration (s))} \]

Example: Email size = 20000bytes, Duration = 1s.

Generation rate (Mbps) = \(20000*8/1000000 = 0.16\)Mbps

HTTP

\[ \text{Generation Rate (Mbps)} = \frac{(\text{Page size (bytes)} \times 8 \times \text{Page count})}{\text{Inter arrival time (s))} \]

Example: Page size = 20000 Bytes, Page Count = 2, Inter arrival time = 3s

Generation rate (Mbps) = \(20000*8*2/3000000 = 0.106\)Mbps

FTP

\[ \text{Generation Rate (Mbps)} = \frac{(\text{File size (bytes)} \times 8)}{\text{Inter arrival time (s))} \]

Example: File size = 100000 Bytes, Inter arrival time = 5s

Generation rate (Mbps) = \(100000*8/5 = 0.16\)Mbps

Database

\[ \text{Generation Rate (Mbps)} = \frac{(\text{Packet size (bytes)} \times 8)}{\text{Inter arrival time (\mu s))} \]

Example: Packet size = 10000 Bytes, Inter arrival time = 1000000\mu s

Generation rate (Mbps) = \(10000*8/1000000 = 0.08\)Mbps

BSM

\[ \text{Generation Rate (Mbps)} = \frac{(\text{Packet size (bytes)} \times 8)}{\text{Inter arrival time (\mu s))} \]

Example: Packet size = 20Bytes and Inter arrival time = 1000000\mu s.

Generation rate (Mbps) = \(20*8/1000000 = 0.00016\)Mbps
5.4 Priority and QoS of Applications

The various application traffic generated in NetSim have the following priority and QoS values:

<table>
<thead>
<tr>
<th>Application Type</th>
<th>Priority Value</th>
<th>Priority</th>
<th>QoS Class</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voice – One way</td>
<td>8</td>
<td>High</td>
<td>RTPS</td>
</tr>
<tr>
<td>Voice – Two way</td>
<td>8</td>
<td>High</td>
<td>UGS</td>
</tr>
<tr>
<td>Video</td>
<td>6</td>
<td>Medium</td>
<td>nRTPS</td>
</tr>
<tr>
<td>FTP</td>
<td>2</td>
<td>Low</td>
<td>BE</td>
</tr>
<tr>
<td>Database</td>
<td>2</td>
<td>Low</td>
<td>BE</td>
</tr>
<tr>
<td>Custom</td>
<td>2</td>
<td>Low</td>
<td>BE</td>
</tr>
<tr>
<td>Voice – One way</td>
<td>8</td>
<td>High</td>
<td>RTPS</td>
</tr>
<tr>
<td>Voice – Two way</td>
<td>8</td>
<td>High</td>
<td>UGS</td>
</tr>
<tr>
<td>Video</td>
<td>6</td>
<td>Medium</td>
<td>nRTPS</td>
</tr>
<tr>
<td>FTP</td>
<td>2</td>
<td>Low</td>
<td>BE</td>
</tr>
<tr>
<td>Database</td>
<td>2</td>
<td>Low</td>
<td>BE</td>
</tr>
<tr>
<td>Custom</td>
<td>2</td>
<td>Low</td>
<td>BE</td>
</tr>
</tbody>
</table>

Note: Priority of “Normal” has a Priority Value of 4 and “nRTPS” QoS Class. Ex: Video over TCP.

5.5 Modelling Poisson arrivals in NetSim

What’s a Poisson process, and how is it useful?

Any time you have events which occur individually at random moments, but which tend to occur at an average rate when viewed as a group, you have a Poisson process.

For example, we can estimate that a certain node generates 1200 packets per minute. These packets are randomly generated within a minute, but there are on average 1200 packets per minute. If 1200 packets generated per minute that, on average, one packet is generated every $60 / 1200 = 0.05$ seconds. So, let’s define a variable $\lambda = 1/ 0.05 = 20$ and call it the rate parameter. The rate parameter $\lambda$ is a measure of frequency: the average rate of events (packets) per unit of time (in this case, seconds).

Knowing this, we can ask questions like, what is the probability that a packet will be generated within the next second? What’s the probability within the next 10 seconds? There’s a well-known function to answer such questions. It’s called the cumulative distribution function for the exponential distribution, and it looks like this:

$$F(x) = 1 - e^{-\lambda x}$$
Basically, the more time passes, the more likely it is that a packet is generated. The word “exponential”, in this context, actually refers to exponential decay. As time passes, the probability of having no packets generated decays towards zero – and correspondingly, the probability of having at least one packet generated increases towards one.

Plugging in a few values, we find that:

- The probability of generating a packet within the next 0.05 seconds is \( F(0.05) \approx 0.63 \)
- The probability of generating a packet within 1 second is \( F(1) \approx 0.999999998 \)

In particular, note that after 0.05 seconds – the prescribed average time between packets – the probability is \( F(0.05) \approx 0.63 \).

**Generating Poisson arrivals in NetSim**

We simply write a function to determine the exact amount of time until the next packet. This function should return random numbers, but not the uniform kind of random number produced by most generators. We want to generate random numbers in a way that follows our exponential distribution.

Given that the inverse of the exponential function is \( \ln \), it’s pretty easy to write this analytically, where \( U \) is the random value between 0 and 1:

\[
\text{Next Time when a packet is generated} = -\ln(1 - \text{RandNo}) / \lambda
\]

This is exactly the code used in NetSim, and this is available in the source C file in `../NetSim_Standard/Simulation/Application/Distribution.c`. In the case exponential distribution, you would see

```c
case Distribution_Exponential: /*Exponential Distribution Function*/
    fFirstArg = args[0];
```

![Graph showing the exponential distribution with F(x) on the y-axis and x on the x-axis.](image)
nRandOut = fnRandomNo(10000000, &fRand, uSeed, uSeed1);

fRandomNumber = (double) (fRand);

fFirstArg = 1 / fFirstArg;

*DistOut = (double) -(1 / fFirstArg)* (double) logl(1 - fRandomNumber);

The simple way of selecting this via the UI is to selecting exponential distribution for inter-arrival time when modelling application properties.
6 Running Simulation via CLI

6.1 Running NetSim via CLI

Advanced users can model their simulation via a configuration file (which can be created without the NetSim GUI) and run the simulation from command line. This is typically done in cases where very large networks are to be simulated (it takes too long to create it in the GUI), or to run a series of simulations automatically. The configuration file contains all required information to run the simulation including the network topology, devices, links, traffic, statistics, traces etc. To run Simulation in NetSim through command line interface (CLI), the following steps have to be followed.

**Step 1: Note the Application Path**

Application path is the current workspace location of the NetSim that you want to run. The default application path will be something like “C:\Users\PC\Documents\NetSim_12.0.18_64_std_default\bin\bin_x64” for 64-bit and “C:\Users\PC\Documents\NetSim_12.0.18_32_std_default\bin\bin_x86” for 32-bit. For more information on NetSim workspace, Refer Section 3 “Workspaces and Experiments”.

**Step 2: Note the IO Path**

IO path (Input/output Path) is the path where the input and output files of an application is written. This is similar to the temp path of windows OS. For NetSim, the IO path can be got by Start → Run → %temp%\NetSim. Once you reach this folder, the user can notice that the path would be something like “C:\Users\PC\AppData\Local\Temp\NetSim”

The IO path is the path where the Configuration.netsim (NetSim Configuration file) of the scenario, that will be simulated, should be present.

App path and IO path can also be same, i.e., Configuration.netsim can be placed inside the app path (if the app path has the write permission). Otherwise, users can create a folder for IO path and Configuration.netsim can be placed inside that folder.

**Note:** Sample configuration.netsim files are available in the <NetSim installation Directory>/Docs/Sample_Configurations folder of the NetSim install directory inside the respective protocol folder names.
Step 3: Running NetSim through command line for Simulation

To run NetSim through command line, copy the app path where NetSimCore.exe is present and paste it in the command prompt.

>`cd <app path>`

*Note: File path should be always added in the command prompt within double quotes. For example,*

>`cd “C:\Users\PC\Documents\NetSim_12.0.18_64_std_default\bin\bin_x64”`

For floating/roaming licenses, type the following in the command prompt. The type of license can be seen by clicking on Help → About NetSim in GUI of NetSim.

>`NetSimCore.exe <space> -apppath <app path> -iopath <iopath> -license 5053@<Server IP Address>`

Where,

- `<app path>` contains all files of NetSim including NetSimCore.exe. Specifying the app path is optional. NetSim will take the current path as app path if not specified.
- `<iopath>` contains Configuration.netsim. (Configuration.xsd is available in the bin folder of NetSim’s current workspace path `<C:\Users\PC\Documents\NetSim_12.0.18_64_std_default\bin\bin_x64>` for 64-bit and `<C:\Users\PC\Documents\NetSim_12.0.18_64_std_default\bin\bin_x86>` for 32-bit). Refer section 6.2.4 to know about configuration.xsd file.
- `5053` is the port number through which the system communicates with the license server i.e the system in which the dongle is running (for floating license users)
- `<Server IP Address>` is the ip address of the system where NetSim license server (dongle) is running.

*Note: Please contact your network administrator / lab in-charge to know the IP address of the PC where the NetSim license server is running.*

The following screenshot is the example of running NetSim through CLI where the ip address of the NetSim license server is 192.168.0.9

For node-locked licenses, type the following in the command prompt
>NetSimCore.exe -apppath <app path> -iopath <iopath>

Where,

- `<app path>` contains all files of NetSim including NetSimCore.exe
- `<iopath>` contains Configuration.netsim and Configuration.xsd

The following screenshot is the example of running NetSim through CLI for the node locked license.

Simulation will be completed successfully and the text files that are requested by the end user in Configuration.netsim will be written in the `<iopath>`.

To know more about the options that are available to run NetSim via CLI, type the following in the command prompt.

> cd <app path>

> NetSimCore.exe –h

Running CLI via Quick edit mode:
With Quick Edit mode, you can copy text between a command window and Windows-based programs, and you can also paste text into a command window by using a right-click operation. To use Quick edit mode in command prompt users can run the command prompt → **Right Click** the icon in the upper-left corner of the Command Prompt window, and then Click **Properties** → In the options, enable **Quick Edit mode** → and click on **OK**.
6.2 Understanding the Configuration.netsim file

When a scenario is created in the GUI, NetSim’s UI code write all the details about the devices used and its properties, the links used and their properties, the properties of the environment being used, etc. in the file **Configuration.netsim**

The simulation engine that contains DLLs and NetSimCore.exe reads this Configuration.netsim, executes the simulation and writes output metrics files. The GUI then displays the metrics based on the text files written by the backend.

In order to run NetSim through command line (CLI), the user must create the Configuration.netsim file furnishing all the details about the devices, links and the environment of the desired scenario.

### 6.2.1 How to use Visual Studio to edit the Configuration file?

In Visual Studio, XML view provides an editor for editing raw XML and provides *IntelliSense* and *color coding*. After you type the element name and press the CTRL+ SPACE, you will be presented with a list of attributes that the element supports. This is known as “IntelliSense”. Using this feature, you can select the options that are required to create the desired scenario.

Color coding is followed to indicate the elements and the attributes in a unique fashion.

The following screenshot displays the Configuration.netsim which is opened through the Visual Studio.

To reformat click on edit→Advanced→Format Document
6.2.2 Sections of Configuration file

These are the different sections in Configuration.netsim:

- EXPERIMENT_INFORMATION
- GUI_INFORMATION
- NETWORK_CONFIGURATION
- SIMULATION_PARAMETER
- PROTOCOL_CONFIGURATION
- STATISTICS_COLLECTION

EXPERIMENT_INFORMATION:

This section contains the details about the user credentials, such as the user mode (Admin or Exam or Practice), experiment name, date on which the experiment is created and the comments about the experiment. This section plays a significant role while running NetSim through GUI.

GUI_INFORMATION:
This section contains the GUI information like the environment length, view type etc. and the network name which is desired to be run.

**NETWORK_CONFIGURATION:**

This section is used to configure the devices and the links of the desired network at the each layer of the TCP/IP stack. It consists of DEVICE_CONFIGURATION, CONNECTION and APPLICATION_CONFIGURATION. DEVICE_CONFIGURATION configures the devices in the desired network while the CONNECTION configures the links in the desired network and APPLICATION configures the Applications.

**SIMULATION_PARAMETER:**

Simulation time and seed values are described in this section.

**PROTOCOL_CONFIGURATION:**

IPV4 and static ARP are enabled or disabled in this section. The text files illustrating the static routing and static ARP can be obtained by enabling the corresponding tags in the Configuration.netsim.

**STATISTICS_COLLECTION:**

The packet trace and the event trace can be observed in the text files which are created by enabling the tags in this section. The required fields of the packet trace can be enabled in the PACKET_TRACE while the event trace can be enabled in the EVENT_TRACE of this section.

### 6.2.3 Sample Configuration file

Sample “Configuration.netsim” file will be installed in user system along with the software at `<NetSim installed Path>\Docs\Sample_Configuration\<Network Technology>`. User can open and edit these files using Visual Studio 2015/2017/2019 or any XML editor. The purpose of providing the sample “Configuration.netsim” file is to assist the user in writing a network scenario manually by analyzing the format for that specific network technology.

### 6.2.4 Configuration.xsd file

Configuration.xsd is an XML schema Definition file which is present in the bin folder of NetSim’s current workspace path `<C:\Users\PC\Documents\NetSim_12.0.18_64_std_default\bin\bin_x64>` for 64-bit and `<C:\Users\PC\Documents\NetSim_12.0.18_64_std_default\bin\bin_x86>` for 32-bit.
Configuration.xsd file can be placed inside the <iopath> along with the configuration.netsim file to verify the contents in the configuration.netsim file. This file checks and validates the structure and vocabulary of a configuration.netsim document against the grammatical rules of the appropriate XML language.

It is not mandatory to place the configuration.xsd file along with the Configuration.netsim file in the iopath. But if it is done, then it will be easier to check & validate changes that are done to the Configuration.netsim file.
7 Results and Analysis

7.1 Result Window

NetSim provides performance metrics at various abstraction levels such as Link Metrics, Queue metrics, TCP Metrics, Application Metrics, etc., at the end of simulation. With the help of metrics, users can analyze the behavior of the modeled network and can compare the impact of different algorithms on end-to-end behavior.

After simulation of a scenario is performed, NetSim Performance Metrics are shown on the screen as shown below:

![Performance Metrics Screen]

The Performance metrics is divided into sections

7.1.1 Link metrics

Here users can view the values of the metrics obtained based on the overall network and also displays the values of the metrics pertaining to each link

- **Link_Id** - It is the unique Id for the link.
- **Link_throughput_graph** – Plots throughput vs. Simulation time

**Calculation:**

\[
\text{Link Throughput (in Mbps)} = \frac{\text{Total bytes transmitted over the link} \times 8}{\text{Simulation Time (Micro sec)}}
\]

Total Bytes transmitted is counted for successful data packets and control packets.
The calculation is based on the packet size (bytes) at the PHY layer, which would include app layer payload plus the overheads of all layers. Error and collision packets are not included in this calculation and only successful packets are counted for calculation of this metric.

Moving Average: This is the average of the metric up until the current time and is defined as

\[
\bar{\theta}(t) = \frac{1}{t} \int_0^t r(u)\,du
\]

This is the time average of the metric up to end of simulation current time
• **Packets Transmitted** - It is the total number of packets transmitted in the link. Along with data packets, it includes protocol control packets like ARP Request, ARP Reply, TCP_ACK, TCP_SYN, RTS, CTS, WLAN_ACK, OSPF_HELLO, RIP packets etc.

• **Packets errored** - Total number of packets error in the link inclusive of data and control packets.

• **Packets collided** - Total number of packets collided in the link including data and control packets.

• **Bytes Transmitted** - It is the total number of bytes transmitted in the link. It is equal to the sum of the ‘Payload Transmitted’ and ‘Overhead Transmitted’ transmitted in the link.

• **Payload Transmitted** - It is the total payload transmitted in the link.

• **Overhead Transmitted** - It is the total overhead transmitted in the link. It includes the layer wise overheads and all control packets in the link.

7.1.2 **Queue Metrics**
Displays the values of the queue metrics for the devices containing buffer queue like routers, access points etc.

• **Device Id** - Unique id number of the device.

• **Port Id** - Unique id number of the port of the device. This is also called as interface id.

• **Queued Packet** - Number of packets queued at a particular port of a device.

• **Dequeued Packet** - Number of packets removed from the queue at a particular port of device.

• **Dropped Packet** - Number of packets dropped at a particular port of a device.

7.1.3 **Protocol Metrics**
The Performance metrics tables of protocols such as TCP, UDP, IP, IEEE802.11, LTE, AODV and DSR are provided in the respective technology library documentation.

7.1.4 **Device Metrics**
Displays device related metrics like ARP table, IP forwarding tables. This is also dependent upon the type of network/technology simulated

**IP Forwarding Table:**

• **Network Destination** - It represents the Network address of the destination

• **Netmask/Prefix length** - A 32-bit combination used to describe which portion of an address refers to the subnet and which part refers to the host.

• **Gateway** - It is the IP address of the next-hop router

• **Interface** - It represents a network connection
• **Metrics** - It is the value used to choose between two routes
• **Type** - It represents the type of the network i.e. local/Multicast/Broadcast

**Switch MAC Address Table:** These metrics will be displayed when we run networks having Switches

• **MAC Address** - It represents the MAC address of the switch interfaces
• **Type** - It is the type of the switch
• **OutPort** - It is the output port of the switch

7.1.5 **Cellular Metrics**
Displayed if GSM or CDMA is running in the network

**GSM/CDMA Metrics. MS Metrics**

• **MS Id** - It is the id of the Mobile station
• **Call Generated** - It is the number of calls generated by a Mobile Station
• **Call Blocked** - It is the number of calls blocked by a Base station when no channel available
• **Call Blocking probability** - It is the probability of calls blocked by a base station
• **channel request sent** - It is the number of channel requests sent by a mobile station
• **Call request sent** - It is the number of call requests sent by a mobile station (at source)
• **Call request received** - It is the number of call requests received by a mobile station (at destination)
• **Call accepted** - It represents the number of calls accepted by a mobile station
• **Call rejected** - It represents the number of calls rejected by a mobile station
• **Handover request** - It is the number of handover requests sent by a mobile station. Handover refers to the process of transferring an ongoing call or data session from one channel connected to the core network to another channel.
• **Call dropped** - It represents the number of calls dropped by a BS
• **Call dropping probability** - It represents the probability of number of calls dropped by a BS

**Channel metrics**

• **BS Id** - It is the Id of a Base Station
• **Channel Id** - It represents the channel number
• **Uplink frequency** - It is the uplink frequency of the GSM network to send data from mobile station to base station

• **Downlink frequency** - It is the downlink frequency of the GSM network to send data from base station to mobile station

• **Time slot** - It represents the time slot. In GSM network, Frequency band is divided into 200kHz carriers and then each carrier is divided into 8 time slots (0-7)

### 7.1.6 Sensor metrics:
Displayed if WSN/IOT is running in the network

• **Device Id** - It represents the Id’s of the sensor and LoWPAN Gateway

• **Packet Transmitted** - It is the number of packets (either data/routing/zigbee) transmitted by Sensor and LoWPAN gateway

• **Packet Received** - It is the number of packets (either data/routing/zigbee) received by Sensor and LoWPAN gateway

• **Ack Transmitted** - It is the number of acknowledgements transmitted by particular device

• **Ack Received** - It is the number of acknowledgements received by a particular device

• **CCA Attempt** - It represents the number of Clear channel Assessment attempts at sensors and LoWPAN Gateway used to determine whether the medium is idle or not

• **Successful CCA Attempt** - It represents the number of successful CCA attempts at sensors and LoWPAN Gateway

• **Failed CCA** - It represents the number of failed CCA attempts at sensors

• **Total Backoff Time** - It is the total backoff time obtained. It is the time that sensors have to wait before attempting to access the channel

• **Average Backoff time** - It is the average backoff time

• **Beacon Transmitted** - It the total number of beacons transmitted by a LoWPAN Gateway. It transmits network beacons in a beacon enabled mode. If beacon mode is enabled, it follows slotted CSMA/CA algorithm

• **Beacon Received** - It is the total number of beacons received by the sensors

• **Beacon Forwarded** - It is the total number of beacons forwarded by the sensors

• **Beacon Time** - It is the total time calculated for beacon transmission at LoWPAN Gateway

• **CAP Time** - It is the total Contention Access Period obtained during simulation. During this time, sensors competes for channel
• **CFP Time** - It is the total Contention free period obtained. In CFP, nodes request for Guarantee time slots. If GTS is allocated, nodes can transmit without contention

7.1.6.1 **Battery Model**
- **Device Name** - It represents the Name and Id of the Sensor
- **Initial Energy** - It represents the initial energy of the sensors
- **Consumed Energy** - This is the total energy consumed by the respective sensor.
- **Remaining Energy** - This is the remaining energy of the sensor at the end of the simulation
- **Transmission Energy** - It is the energy consumed by the respective sensor for transmitting data
- **Receiving Energy** - It is the energy consumed by the respective sensor while receiving data
- **Idle Energy** - When the sensor is active and ready but not currently receiving or transmitting data packets, it is said to be in an idle state. This metrics calculates the energy consumed by the sensor in idle state
- **Sleep Energy** - This is the energy consumed when the respective sensor is in an inactive mode

7.1.7 **CR metrics:**
Displayed if 802.22 cognitive radio is running in the network

**Base station Metrics**
- **BS Id** - It is the id of a Base Station
- **Interface Id** - It is the Interface Id of a BS
- **SCH sent** - SCH. It is the number of Superframe Control Headers sent by a BS. SCH carries Base Station’s MAC address along with the schedule of quiet periods for sensing, as well as other information about the cell
- **FCH sent** - It represents the number of Frame Control Headers sent by a BS. It is transmitted as a part of Down Stream (DS) Protocol Data Unit in DS subframe specifies length of either DS-Map if transmitted or US-Map. It is sent in the first two subchannels of the symbol immediately following the preamble symbol
- **DSA req received** - It is the number of Dynamic Service Addition requests received by a BS used to create a new service flow
- **DSA rep sent** - It is the number of DSA replies sent by a BS
- **DSC req received** - It is the number of Dynamic Service Change requests received by a BS to dynamically change the parameters of an existing service flow
- **DSC rep sent** - It is the number of DSC replies sent by a BS
- **DSD req received** - It is the number of Dynamic Service Deletion requests received by a BS to delete an existing service flow
- **DSD rep sent** - It is the number of DSD replies sent by a BS
- **CHS req sent** - It is the number of Channel Switch Requests sent by a BS

**CPE metrics**

- **CPE Id** - It represents the Id of Customer Premise Equipment
- **Interface Id** - It represents the Interface Id of the CPE
- **SCH received** - It is the number of Superframe Control Headers received by a CPE.
- **FCH received** - It represents the number of Frame Control Headers received by a CPE
- **DSA req sent** - It is the number of Dynamic Service Addition requests sent by a CPE
- **DSA rep received** - It is the number of DSA replies received by a CPE
- **DSC req sent** - It is the number of Dynamic Service Change requests sent by a CPE
- **DSC rep received** - It is the number of DSC replies received by a CPE
- **DSD req sent** - It is the number of Dynamic Service Deletion requests sent by a CPE
- **DSD rep received** - It is the number of DSD replies received by a CPE
- **CHS req received** - It is the number of Channel Switch Requests received by a CPE
- **UCS Sent** - It is the number of Urgent Coexistence Situations sent by a CPE

**Incumbent Metrics**

- **BS Id** - It represents the Id of the Base Station
- **Incumbent Id** - It represents the Id of the Incumbent
- **Frequency** - It is the frequency at which the incumbent operates
- **Operational Time** - It is the active period of the incumbent
- **Idle Time** - It is the inactive period of the incumbent
- **Interference Time** - It is the time when interference occurs due to CPE

**Channel Metrics**

- **BS Id** - It is the Id of the BS
- **Channel Number** - It represents the channel number at which the BS is operating
- **Frequency** - It is the frequency of the channel at which the BS is operating
- **Spectral efficiency** - It refers to the information rate that can be transmitted over a given bandwidth in a specific communication system. It is a measure of how
efficiently a limited frequency spectrum is utilized by the physical layer protocol, and sometimes by the media access control protocol.

7.1.8 Application Metrics:
Displays Application performance metrics

- **Application Id** - It is the unique Id of the application running at the source.
- **Application Name** - It is unique name of the application running.
- **Source Id** - It is the unique Id of the device running that particular application.
- **Destination Id** - It is the unique Id of the destination device.
- **Packet generated** - It is the total number of packets generated from the source.
- **Packets Transmitted** - It is the total number of packets generated and transmitted from the source.
- **Packet received** - It is the total number of packets received at the destination.
- **Payload Transmitted** - It is the total payload transmitted in bytes. It is equal to the product of ‘Packets Transmitted’ and ‘Packet Size’. This calculation will apply only in case of a constant packet size (CBR, CUSTOM (constant) etc. In other cases this should be considered as the sum of the payload of the packets transmitted.
- **Payload Received** - It is the total payload received at the destination in bytes.
- **Throughput** - Total user data (or) payload delivered to their respective destination every second.

If Simulation Time > Application End Time, then

\[
\text{Application Throughput (Mbps)} = \frac{\text{Total payload delivered to destination (bytes)} \times 8}{\text{Time last received packet at App layer (µs)} - \text{App Start Time (µs)}}
\]

If Simulation Time < Application End Time, then

\[
\text{Application Throughput (in Mbps)} = \frac{\text{Total payload delivered to destination (bytes)} \times 8}{\text{Simulation Time (µs)} - \text{App Start Time(µs)}}
\]

- **Jitter**

\[
\text{Jitter (µs)} = \frac{\text{TotalPacket Jitter of all successful packets}}{\text{Total Number of successfully recieved packets}} - 1
\]

\[
\text{Packet Jitter (µs)} = |\text{EndtoEnd Delay of Current packet} - \text{EndtoEnd Delay of Previous Packet}|
\]

- **Delay** - It is the average amount of time taken calculated for all the packets to reach the destination application layer from when the packet is sent from source's application later. It would APP_IN time at destination – APP_OUT time at source.
7.1.9 Note about metrics:

1. NetSim uses the Douglas–Peucker algorithm for plotting the throughput (link/application) over time. This is an iterative end-point fit algorithm, which takes a curve composed of line segments and finds a similar curve with fewer points.

2. The metrics are calculated at each layer and might not be equivalent to the same metric calculated at a different layer. For exactness and precision, we recommend users also verify the results with the event trace & packet trace generated by NetSim.

3. Broadcast / Multicast application will have no entries under Application Metrics in Results window if there are zero packets received. In other words, it will not show ‘0’ throughput. Users may notice that ‘0’ throughput is shown for unicast applications, and this is because of the way Broadcast/Multicast application metrics is architected in NetSim.

7.1.10 Note about packet transmission:

The Network Stack forms the core of NetSim’s architecture. The Stack consists of five IN and OUT events: PHYSICAL_IN, MAC_IN, NETWORK_IN, TRANSPORT_IN, APPLICATION_IN and APPLICATION_OUT, TRANSPORT_OUT, NETWORK_OUT, MAC_OUT, PHYSICAL_OUT. All the packets when transferred between devices go through the above events in order. IN events occur when the packet is entering a device and all the OUT events occur when packet leaves a device.

The following table lists the various files that will be written in the NetSim install directory/ IO path on completion of simulation.

<table>
<thead>
<tr>
<th>S. No</th>
<th>File</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Metrics.xml</td>
<td>Contains the metrics of the network that is simulated recently.</td>
</tr>
<tr>
<td>2</td>
<td>Node.pcap</td>
<td>Contains the information of captured packets that is recently simulated.</td>
</tr>
<tr>
<td>3</td>
<td>LicenseErrorLog.txt</td>
<td>Contains the status of the communication between the NetSim dongle and the client.</td>
</tr>
<tr>
<td>4</td>
<td>ConfigLog.txt</td>
<td>This file will be written while reading the Configuration file. Provides errors if there are errors in the configuration file.</td>
</tr>
<tr>
<td>5</td>
<td>LogFile.txt</td>
<td>Contains the logs as the control flows across various layers in the Network Stack</td>
</tr>
<tr>
<td>6</td>
<td>PacketTrace.csv</td>
<td>Contains the detailed packet information. This file will be written only when Packet Trace is enabled.</td>
</tr>
</tbody>
</table>
EventTrace.csv
Contains the information about each event. This file will be written only when Event Trace is enabled.

Animation.txt
Contains the information about the flow of the packet.

Static ARP.txt
Contains the information about the dropped devices like ip address and mac address.

---

If **NetSim runs via the UI**, then the metrics will be displayed automatically at the end of simulation with illustrative tables.

If **NetSim runs via CLI**, then the metrics will be written into Metrics.txt and MetricsGraph.txt.

**7.2 Export to .csv**

In NetSim Result Dashboard, users can use the option **Export Results (.xls/.csv)** to export all the metrics file to XL/CSV file for the further computation or analysis using it.

---

**XL/CSV file**
7.3 Print

A web formatted (html file) report can be generated for simulations performed in NetSim, using the Print button present in the results window.

The report that is generated contains:

- A screenshot of the network scenario created in NetSim GUI
- All the metrics tables that were part of the Simulation Results Window
- Dynamic Metrics Plots (if Dynamic Metrics is enabled prior to Simulation)

- The report that is generated makes it convenient for documentation, reference, study and further analysis.
- This html report can be printed as PDF or printed out by selecting printer options as per your need.
7.4 Packet Animation

NetSim provides the feature to play and record animations to the user. Packet animation enables users to watch traffic flow through the network for in-depth visualization and analysis.

Users have the following options before running simulation:

- Record the animation,
- Don't play/record animation and
- Play and record animation while running simulation.

The packet animation would then be recorded and the user can view the animation from the NetSim Packet Animation window as shown below:
While viewing packet animation, user can see the flow of packets as well as the type of packet. Blue color packet denotes control packet, green color is used for data packet and red color is error/collided packet.

### 7.4.1 Packet animation Table

Packet Animation table is also provided for users to see the flow of packets along with packet animation.

The "Table Filters" option available in the Packet Animator Window allows users to filter the parameters that will be displayed in the Packet Trace Window displayed alongside animation.

**Note**: Packet Animation table would be displayed only if Packet Trace is enabled in the network before running the simulation.

### 7.4.2 Packet animation – Display Settings

NetSim Packet Animation can be customized using the View More drop down list provided with the display settings as shown below:
The View More Animation options can be used to view (enable/disable)

- Device Name
- IP address of devices
- VLAN ID
- Application Flow
- Node Movement
- Packet Flow
- Plots
  - Application Throughput
  - Link Throughput
- Battery Level
- Route tables etc alongside animation

**Note:** The options displayed under **View more** drop down are dependent on the network that is simulated and features that are enabled.

### 7.4.3 Example on how to use NetSim packet animation feature:

**Case 1: ARP PROTOCOL - WORKING**

Create a scenario with 3 wired nodes, 2 switches and 1 router and connect it based on the following scenario.

- Disable TCP in all the wired nodes.
- Click on application and set Source_Id and Destination_Id as 1 and 2 respectively.
- Set Simulation time = 100s. After clicking on Run Simulation, edit **Static ARP Configuration** tab by setting Static ARP as Disable. Click on OK button to simulate.

Now click on packet animation and analyse the following:
• NODE-1 sends ARP_Request which is then broadcasted by SWITCH-4.
• During the process the devices that receive the ARP_Request packet (Switch, Router, and Node-2) will update their ARP table or the switch table.
• NODE-2 sends the ARP_REPLY to NODE-1 via SWITCH-4.
• Now NODE-1 updates its ARP table with the MAC address of NODE-2 on receiving the ARP_REPLY.
• After this step, NODE-1 starts sending data packets to NODE-2 since the source now has both IP and MAC addresses of destination.

Case 2: Across-Router-IP-forwarding

• Follow all the steps till Step 2 and perform the following sample.
• To run the simulation, click on the Application icon and set the Source_Id and Destination_Id as 1 and 3 respectively.
• Click on Run Simulation and set Simulation time as 100 sec.
• Then go to Static ARP Configuration tab and set Static ARP as Disable. Click on OK button to simulate.
Click on packet animation to analyse the following:

- NODE-1 transmits ARP_Request which is further broadcasted by SWITCH-4. ROUTER-6 sends ARP_Reply to NODE-1 which goes through SWITCH-4. Then NODE-1 starts to send data to NODE-3.
- If the router has the address of NODE-3 in its routing table, ARP protocol ends here and data transfer starts that is PACKET_ID 1 is being sent from NODE-1 to NODE-3.
- In other case, Router sends ARP_Request to appropriate subnet and after getting the MAC ADDRESS of the NODE-3, it forwards the packet which it has received from NODE-1.
- When a node has to send data to a node with known IP address but unknown MAC address, it sends an ARP request. If destination is in same subnet as the source (found through subnet mask) then it sends the ARP (broadcast ARP message) request, otherwise it forwards it to the default gateway.
- Former case happens in case of intra-LAN communication. The destination node sends an ARP response which is then forwarded by the switch to the initial node. Then data transmission starts.
- In latter case, a totally different approach is followed. Source sends the ARP request to the default gateway and gets back the MAC address of default gateway. (If it knows which router to send then it sends ARP request to the corresponding router and not to Default gateway).
- When source sends data to default gateway (a router in this case), the router broadcasts ARP request for the destined IP address in the appropriate subnet. On getting the ARP response from destination, router then sends the data packet to destination node.
7.4.4 How to record and save Packet animation as a Video file

**Note:** The following procedure applies to Windows 10 Operating system only. Users with other versions of Windows can use third-party video capture tools (Link to a list of common tools) to save NetSim packet animation as a video.

To quickly capture NetSim packet animation, launch the packet animation window. Before playing the animation, press **Windows logo key + G** on the keyboard to open Game bar. (or Select windows settings and then select Gaming option for Game bar related settings). Now start recording by pressing record option as shown below. (Shortcut to start recording: Windows logo key + Alt + R)

![Game capturing](image)

Then select the checkbox “Enable gaming features for this app to record gameplay” option

![Gaming features not available](image)
Once you select the checkbox, recording window will open as shown below.

Now start playing the animation in NetSim using play button in packet animation window.

Once the animation has been recorded stop recording (Shortcut to stop recording: Windows logo key + Alt + R). Recorded clips will be saved in windows default videos folder (Eg: C:\Users\PC\Videos\Captures).

### 7.5 Packet Trace

NetSim allows users to generate trace files which provide detailed packet information useful for performance validation, statistical analysis and custom code de-bugging. Packet Trace logs a set of chosen parameters for every packet as it flows through the network such as arrival times, queuing times, departure times, payload, overhead, errors, collisions etc.

By providing a host of information and parameters of every packet that flows through the network, packet trace provides necessary forensics for users to catch logical errors without setting a lot of breakpoints or restarting the program often. Window size variation in TCP, Route Table Formation in OSPF, Medium Access in Wi-fi, etc, are examples of protocol functionalities that can be easily understood from the trace.

*Note: By default, packet tracing option is turned off. Turning on Packet Trace will slow down the simulation significantly. After simulation, users would get the “open packet trace” link in the metrics window (will also get Packet_Trace.csv file in the saved folder).*
7.5.1 How to set filters to NetSim trace file

Step 1: Open the trace file. (In this example packet trace is opened)

<table>
<thead>
<tr>
<th>PACKET_ID</th>
<th>SEGMENT_ID</th>
<th>PACKET_TYPE</th>
<th>CONTROL_PKT</th>
<th>SOURCE_ID</th>
<th>DESTINATION_ID</th>
<th>TRANSMITTER_ID</th>
<th>RECEIVER_ID</th>
<th>APP_LAYER</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>N/A</td>
<td>Control_Packet</td>
<td>TCP_SYN</td>
<td>NODE-2</td>
<td>NODE-3</td>
<td>NODE-2</td>
<td>ROUTER-1</td>
<td>N/A</td>
</tr>
<tr>
<td>0</td>
<td>N/A</td>
<td>Control_Packet</td>
<td>TCP_SYN</td>
<td>NODE-2</td>
<td>NODE-3</td>
<td>ROUTER-1</td>
<td>NODE-3</td>
<td>N/A</td>
</tr>
<tr>
<td>0</td>
<td>N/A</td>
<td>Control_Packet</td>
<td>TCP_SYNACK</td>
<td>NODE-3</td>
<td>NODE-2</td>
<td>NODE-3</td>
<td>ROUTER-1</td>
<td>N/A</td>
</tr>
<tr>
<td>0</td>
<td>N/A</td>
<td>Control_Packet</td>
<td>TCP_ACK</td>
<td>NODE-2</td>
<td>NODE-3</td>
<td>NODE-2</td>
<td>ROUTER-1</td>
<td>N/A</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>CBR</td>
<td>App1_CBR</td>
<td>NODE-2</td>
<td>NODE-3</td>
<td>NODE-2</td>
<td>ROUTER-1</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>CBR</td>
<td>App1_CBR</td>
<td>NODE-2</td>
<td>NODE-3</td>
<td>ROUTER-1</td>
<td>NODE-3</td>
<td>0</td>
</tr>
<tr>
<td>0</td>
<td>N/A</td>
<td>Control_Packet</td>
<td>TCP_ACK</td>
<td>NODE-3</td>
<td>NODE-2</td>
<td>ROUTER-1</td>
<td>NODE-3</td>
<td>N/A</td>
</tr>
</tbody>
</table>

Step 2: Click the arrow in the header of the column you want to filter. In the list of text or numbers, uncheck the (Select All) box at the top of the list, and then check the boxes of the items you want to show.

For example, click on arrow of SOURCE_ID and uncheck the “Select all” check box and select NODE 2 then click on OK

All the rows which are having NODE 2 as source id will be shown.
Typically, filters can be set to observe “Errored/Collided/Successful “packets, packets of destination and packets of source.

### 7.5.2 Observing packet flow in the Network through packet trace file

Open the packet trace file, Click the arrow in the header of the column PACKET_ID and uncheck the “Select all” check box and select the packet id which you want to observe, for example 1, and then click on OK.

![Packet Trace Example](image)

Scenario is as shown below and traffic flow is from Wired Node 2 to Wired Node 3.

![Scenario Diagram](image)

Flow of packet 1 can be observed from the packet trace as shown below.

![Flow Diagram](image)
Note: In the trace file device IDs are shown not device names. Wired Node 1’s ID is 2 so it is shown as NODE-2, Wired Node 2’s ID is 3 so it is shown as NODE-3, Router-1’s ID is 1 so it is shown as ROUTER-1. Device IDs are shown on the top of the device icon in the above scenario.

In a scenario source and destinations are fixed but transmitter and receiver are changed. For example, in the above scenario NODE-2 is the source and NODE-3 is the destination, but when NODE-2 sending the packet to the ROUTER-1 then NODE-2 is the transmitter and ROUTER-1 is the receiver. When ROUTER-1 sending the packet to the NODE-3, ROUTER-1 is the transmitter and NODE-3 is the receiver.

### 7.5.3 Analysing Packet Trace using Pivot Tables

NetSim Packet trace is saved as a spread sheet. Packet Trace can be converted to an Excel table to make the management and analysis of data easier. A table typically contains related data in a series of worksheet rows and columns that have been formatted as a table. By using the table features, you can then manage the data in the table rows and columns independently from the data in other rows and columns on the worksheet.

PivotTables are a great way to summarize, analyse, explore, and present your data, and you can create them with just a few clicks. PivotTables are highly flexible and can be quickly adjusted depending on how you need to display your results. You can also create Pivot Charts based on PivotTables that will automatically update when your PivotTables do.

If you enable packet trace, Open Packet Trace link present in the Simulation Results Window can be used to load the packet Trace file in MS-Excel. Formats the spread sheet as a table for convenient analysis.
Sheet 2 of the packet trace file has a pivot table – Pivot Table (TX-RX) automatically populated to analyze the packets that were transmitted and received in the network that was simulated. Further users can modify the table by adding or deleting the column headers.

Sheet 3 of the packet trace has a black pivot table – Pivot Table (Custom) which can be used to create additional pivot tables from scratch.

Steps to analyse the packet trace using pivot tables

Step 1: Click on Packet Trace in the result dashboard, you can find 3 sheets will be created i.e Packet Trace, Pivot Table (TX-RX), Pivot Table (Custom)
Step 2: Click on Pivot Table (Custom) to create your own pivot table.

Once you open the sheet PivotTable (Custom), you'll need to decide which fields to add. Each field is simply a column header from the source data. In the PivotTable Field List, check the box for each field you want to add.

7.5.4 Packet Transmitted / Received Analysis
- If you want to analyse packets sent from all sources to all destinations, then check SOURCE_ID, DESTINATION_ID and CONTROL_PACKET_TYPE/APP_NAME.
• The selected fields will be added to one of the four areas below the Field List. Click SOURCE_ID, hold it and drag to the ROW field. Similarly, DESTINATION_ID to COLUMNS and CONTROL_PACKET_TYPE/APP_NAME to VALUES.

• The PivotTable will calculate and summarize the selected fields. In this example, the PivotTable shows the packets sent from all sources to all destinations.

<table>
<thead>
<tr>
<th>SOURCE_ID</th>
<th>DESTINATION_ID</th>
<th>NODE-1</th>
<th>NODE-2</th>
<th>Grand Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>NODE-1</td>
<td></td>
<td>349</td>
<td>356</td>
<td>705</td>
</tr>
<tr>
<td>NODE-2</td>
<td></td>
<td>349</td>
<td>356</td>
<td></td>
</tr>
<tr>
<td>Grand Total</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

• The above example shows all the packets which including data packets and control packets.
• If you wish to know how many Data and how many were control packets then, check the PACKET_TYPE and drag it to the ROWS field.
• This will look like

<table>
<thead>
<tr>
<th>Source ID</th>
<th>Packet Type</th>
<th>Node-1</th>
<th>Node-2</th>
<th>Grand Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>NODE-1</td>
<td>CBR</td>
<td>352</td>
<td>352</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Control_Packet</td>
<td>4</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>NODE-1 Total</td>
<td></td>
<td>356</td>
<td>356</td>
<td></td>
</tr>
<tr>
<td>NODE-2</td>
<td>Control_Packet</td>
<td>349</td>
<td>349</td>
<td></td>
</tr>
<tr>
<td>NODE-2 Total</td>
<td></td>
<td>349</td>
<td>349</td>
<td></td>
</tr>
<tr>
<td>Grand Total</td>
<td></td>
<td>349</td>
<td>356</td>
<td>705</td>
</tr>
</tbody>
</table>

• Further, if you wish to know how many packets got errored and how many were successful, check the PACKET_STATUS field and drag it to the ROWS field.

<table>
<thead>
<tr>
<th>Source ID</th>
<th>Packet Type</th>
<th>Packet Status</th>
<th>Node-1</th>
<th>Node-2</th>
<th>Grand Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>NODE-1</td>
<td>CBR</td>
<td>Error</td>
<td>2</td>
<td>2</td>
<td>352</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Successful</td>
<td>350</td>
<td>350</td>
<td></td>
</tr>
<tr>
<td>NODE-1 Total</td>
<td></td>
<td></td>
<td>352</td>
<td>352</td>
<td></td>
</tr>
<tr>
<td>NODE-2</td>
<td>Control_Packet</td>
<td>Error</td>
<td>1</td>
<td>1</td>
<td>348</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Successful</td>
<td>348</td>
<td>348</td>
<td></td>
</tr>
<tr>
<td>NODE-2 Total</td>
<td></td>
<td></td>
<td>349</td>
<td>349</td>
<td></td>
</tr>
<tr>
<td>Grand Total</td>
<td></td>
<td></td>
<td>349</td>
<td>356</td>
<td>705</td>
</tr>
</tbody>
</table>
7.5.5 Delay analysis:

We explain this using a packet trace generated per the following network scenario

Create a network scenario with 1 router and 6 wired nodes. Create 3 applications as per the following:

<table>
<thead>
<tr>
<th>Application Type</th>
<th>Source Id</th>
<th>Destination Id</th>
<th>Packet Size (Bytes)</th>
<th>Inter arrival time (μs)</th>
</tr>
</thead>
<tbody>
<tr>
<td>CBR</td>
<td>2</td>
<td>3</td>
<td>1460</td>
<td>20000</td>
</tr>
<tr>
<td>VOICE</td>
<td>4</td>
<td>5</td>
<td>1500</td>
<td>20000</td>
</tr>
<tr>
<td>CUSTOM</td>
<td>6</td>
<td>7</td>
<td>1200</td>
<td>20000</td>
</tr>
</tbody>
</table>

Note: Users need to select Codec as CUSTOM for voice application as shown in the below screenshot:
Enable Packet Trace and simulate the scenario for 10 seconds. Open packet trace and perform the following steps:

- Insert a column after PHY\_LAYER\_END\_TIME, then select the whole column and calculate delay for each and every packet by using the formula
  \[\text{PHY\_LAYER\_END\_TIME} - \text{APPLICATION\_LAYER\_ARRIVAL\_TIME}\]

- Then Press CTRL + ENTER. This will calculate delay for the whole column shown below

<p>| | | | | | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>I</td>
<td>J</td>
<td>K</td>
<td>L</td>
<td>M</td>
<td>N</td>
<td>O</td>
<td>P</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- Name the column as DELAY
- Go to Insert->PivotTable and click on OK to create a blank Pivot Table with the newly added column listed under the PivotTable Fields.
- Drag and drop DESTINATION\_ID, RECEIVER\_ID, PACKET\_STATUS and CONTROL\_PACKET\_TYPE/APP\_NAME to FILTERS field shown below
• Filter RECEIVER_ID to Node-3 by clicking on the drop down and select OK

• Similarly filter CONTROL_PACKET_TYPE/APP_NAME to APP1_CBR, DESTINATION_ID to NODE-3 and PACKET_STATUS to Successful

• Drag and drop DELAY value that we have calculated earlier to ROWS and VALUES field
• Click on Count of DELAY drop down and select Value Field settings, then Select SUM and click on OK.

• Again, Drag and drop DELAY to VALUES field.

• Select one cell and calculate the Application Delay, which is the average delay faced by a packet by using the formula

\[
\text{Application DELAY} = \frac{\text{Sum of DELAY of Successful Packets}}{\text{Number of Packets}}
\]
• Compare the obtained value with the DELAY in Application Metrics

<table>
<thead>
<tr>
<th>Application Id</th>
<th>Application Name</th>
<th>Throughput (Mbps)</th>
<th>Delay (microsec)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>APP1_CBR</td>
<td>0.082906</td>
<td>9253.737092</td>
</tr>
<tr>
<td>2</td>
<td>APP2_VOICE</td>
<td>0.597600</td>
<td>258.440482</td>
</tr>
<tr>
<td>3</td>
<td>APP3_CUSTOM</td>
<td>0.048960</td>
<td>215.530980</td>
</tr>
</tbody>
</table>

• To calculate DELAY for VOICE application, filter DESTINATION_ID to Node-5, RECEIVER_ID to Node-5, CONTROL_PACKET_TYPE/APP_NAME to APP2_VOICE and PACKET_STATUS to Successful
• Similarly calculate and compare DELAY for other applications by following the above procedure

7.5.6 Throughput analysis

To explain how users can perform Throughput Analysis, we have used the same network design example as was used for Delay analysis above.

After loading the packet trace switch to sheet Pivot Table (Custom), drag and drop SOURCE_ID, RECEIVER_ID, CONTROL_PACKET_TYPE/APP_NAME and PACKET_STATUS to FILTERS field.
• Similarly drag and drop APP_LAYER_PAYLOAD to ROWS field and VALUES field
• Filter SOURCE_ID to NODE-2, CONTROL_PACKET_TYPE APP_NAME to APP1_CBR, PACKET_STATUS to Successful and RECEIVER_ID to NODE-3
• Click on Count of APP_LAYER_PAYLOAD drop down and select Value Field settings, then Select Sum and click on OK.
• The pivot table would look like

• Select 1 cell and calculate the throughput by using the formula
Application throughput (Mbps) = \[\frac{\text{Sum of Successfully Received App Layer Payload (Bytes) \times 8}}{\text{Simulation Time (\mu s) }}\]

EmptyCell=GETPIVOTDATA("APP_LAYER_PAYLOAD(Bytes)",$A$6,"APP_LAYER_PAYLOAD(Bytes)",1460)*8/10000000

- Now compare the throughput calculated using pivot table with the Application Metrics throughput

- To calculate THROUGHPUT for VOICE application, filter SOURCE_ID to Node-4, RECEIVER_ID to Node-5, CONTROL_PACKET_TYPE/APP_NAME to APP2_VOICE and PACKET_STATUS to Successful

- Similarly calculate and compare THROUGHPUT for other applications by following the above procedure.

7.5.7 Plotting with Pivot Charts

In a pivot table, you can create a new field that performs a calculation on the sum of other pivot fields.

- Open Packet Trace, switch to sheet Pivot Table (Custom)
- Drag and drop SOURCE_ID, RECEIVER_ID and PACKET_STATUS to FILTERS field, then CONTROL_PACKET_TYPE/APP_NAME, APP_LAYER_PAYLOAD to ROWS field and APP_LAYER_PAYLOAD to VALUES field as shown below
• Filter SOURCE_ID to Node 2, Node 4 and Node 6, then RECEIVER_ID to Node 3, Node 5 and Node 7 and PACKET_STATUS to successful

• Filter CONTROL_PACKET_TYPE/APP_NAME to APP1_CBR, APP2_VOICE and APP3_CUSTOM

• Select a cell in the pivot table, and on the Excel Ribbon, under the PivotTable Tools tab, click the Options tab (Analyse tab in Excel 2013).

• In the Calculations group, click Fields, Items, & Sets, and then click Calculated Field.

• Type a name for the calculated field, Application Throughput

• Then click on ADD to save the calculated field.
Click on Formula text box and then select APP_LAYER_PAYLOAD in the Fields list and click on Insert Field

Calculate the throughput by using the following formula shown below and click on OK

\[
\text{Application throughput (Mbps)} = \frac{\text{Sum of Successfully Received App Layer Payload (Bytes)} \times 8}{\text{Simulation Time (\mu s)}}
\]

Select a cell in the pivot table, and on the Excel Ribbon, under the PivotTable Tools tab, click the Options tab (Analyze tab in Excel 2013).

In the Tools group, click Pivot chart and select OK.

This will display a pivot chart shown below
### Packet Trace Fields

#### GENERAL FIELDS | DESCRIPTION
--- | ---
**PACKET_ID** | Specifies the ID of the Data Packets. For control packets this value is set to 0.

**SEGMENT_ID** | Specifies the ID of the segment of the Data Packet. Segmentation is done in transport layer. If the packet size (generated in the APP layer) is greater than the maximum segment size in TRANSPORT layer, packet will get segmented. For control packets it is N/A.

**PACKET_TYPE** | Specifies the type of application that generates the packet. It can be Control Packet, Custom, CBR, Peer_to_peer, E-Mail, DataBase, FTP, Video, Voice, HTTP.

**CONTROL_PACKET_TYPE** | Specifies the type of Control Packet transmitted. Following are the Protocol specific control packets:
- WLAN: WLAN_ACK, WLAN_BlockACK
- OSPF: OSPF_HELLO, OSPF_D-D, OSPF_LSR, OSPF_LSU, OSPF_LSA
- RIP: RIP_Message
- GSM: GSM_Channel_Request, GSM_Channel_Granted, GSM_Call_Request, GSM_Channel_Request_For_Incoming, GSM_Call_Accepted
- CDMA: CDMA_Channel_Request, CDMA_Channel_Granted, CDMA_Call_Request, CDMA_Channel_Request_For_Incoming, CDMA_Call_Accepted
- DSR, AODV, ZRP, OLSR: RREQ, RREP, NDP_HELLO_MESSAGE, OLSR_TC_MESSAGE
- Zigbee: Zigbee_BEACON_FRAME, Zigbee_ACK
- LTE: LTE_Measurement_Report, LTE_RRC_CONNECTION_SETUP, LTE_RLC_SDU, LTE_RRC_CONNECTION_REQUEST, LTE_RRC_CONNECTION_SETUP_COMPLETE, LTE page, LTE Ack etc.

**SOURCE_ID** | Specifies the Node ID of the source set in the application.

**DESTINATION_ID** | Specifies the Node ID of the destination set in the application. If the application is a broadcast application the destination field will show 0.

**TRANSMITTER_ID** | Specifies the current node which is transmitting the packet. The difference between a Source node and a Transmitter, is that when the Source remains constant across the entire packet transmission whereas the transmitter ID changes with each hop of the packet.
<p>| <strong>RECEIVER_ID</strong> | Specifies the current node which is receiving the packet. The difference between a Destination node and a Receiver, is that when the Destination remains constant across the entire packet transmission whereas the receiver ID changes with each hop of the packet. |
| <strong>APP_LAYER.ARRIVAL.TIME (μs)</strong> | Specifies the time at which packet is at the Application_Layer of Source_ID (or Transmitter_ID). This is usually the time at which the packet is generated at Source_ID. |
| <strong>TRX_LAYER.ARRIVAL.TIME (μs)</strong> | Specifies the time at which packet reaches the Transport_layer from the application layer. This will usually be the same as Application_layer_Arrival_Time unless there are TCP re-transmissions. |
| <strong>NW_LAYER.ARRIVAL.TIME (μs)</strong> | Specifies the time at which packet reaches the Network_Layer of Transmitter_ID if this is a Router (or) Time at which packet reaches the Network_layer of previous Router / Source_ID (immediate previous Layer 3 or higher device) if current device is Switch / Access Point. |
| <strong>MAC_LAYER.ARRIVAL.TIME (μs)</strong> | Specifies the time at which packet reaches MAC_Layer of Transmitter_ID. |
| <strong>PHY_LAYER.ARRIVAL.TIME (μs)</strong> | Specifies the time at which packet reaches PHY_layer of Transmitter_ID. |
| <strong>PHY_LAYER.START_TIME (μs)</strong> | Specifies the time at which packet starts betting transmitted in the link between Transmitter_ID and Receiver_ID. |
| <strong>PHY_LAYER.END_TIME (μs)</strong> | Specifies the time at which packet reaches Phy_Layer of Receiver_ID. |
| <strong>APP_LAYER.PAYLOAD (Bytes)</strong> | Specifies the size of the Payload at Application Layer. |
| <strong>TRX_LAYER.PAYLOAD (Bytes)</strong> | Specifies the size of the Payload at Transport Layer. |
| <strong>NW_LAYER.PAYLOAD (Bytes)</strong> | Specifies the size of the Payload at Network Layer. |
| <strong>MAC_LAYER.PAYLOAD (Bytes)</strong> | Specifies the size of the Payload at Data Link Layer. |
| <strong>PHY_LAYER.PAYLOAD (Bytes)</strong> | Specifies the size of the Payload at Physical Layer. |
| <strong>PHY_LAYER.OVERHEAD (Bytes)</strong> | Specifies the size of the overhead in Physical layer. |
| <strong>PACKET_STATUS</strong> | Specifies whether the Packet is Successful, Collided or Errored. |
| <strong>LOCAL_ADDRESS</strong> | Specifies the Port Number at Source Node. Port Numbers are chosen randomly by NetSim. |
| <strong>FOREIGN_ADDRESS</strong> | Specifies the Port Number at Destination Node. Port Numbers are chosen randomly by NetSim. |
| <strong>CWND (bytes)</strong> | Specifies the current size of the TCP congestion window. |
| <strong>SEQ_NO</strong> | If TCP is enabled, it specifies the TCP Sequence number of the packet. |
| <strong>ACK_NO</strong> | If TCP is enabled, it specifies the TCP Acknowledgement number of the packet. |
| <strong>RTT (seconds)</strong> | Specifies the Round Trip Time for the packet. |
| <strong>RTO (seconds)</strong> | Specifies the Retransmission Timeouts. |
| <strong>CONNECTION_STATE</strong> | Specifies the state of TCP connection. |
| <strong>isSyn</strong> | If TCP is enabled, it specifies whether the packet is TCP_SYN or not. |
| <strong>isAck</strong> | If TCP is enabled, it specifies whether the packet is TCP_ACK/TCP_SYN_ACK or not. |
| <strong>isFin</strong> | If TCP is enabled, it specifies whether the packet is TCP_FIN or not. |
| <strong>SEGMENT_LENGTH</strong> | Specifies the segment length of the packet. |</p>
<table>
<thead>
<tr>
<th>SOURCE_IP</th>
<th>Specifies the IP address of the source</th>
</tr>
</thead>
<tbody>
<tr>
<td>DESTINATION_IP</td>
<td>Specifies the IP address of the destination</td>
</tr>
<tr>
<td>GATEWAY_IP</td>
<td>Specifies the IP address of the device which is transmitting a packet</td>
</tr>
<tr>
<td>NEXT_HOP_IP</td>
<td>Specifies the IP address of the next hop</td>
</tr>
</tbody>
</table>

**NOTE:**

Each line in the packet trace represents one hop of one packet.
The packet trace is logged in ascending order of time as measured in Phy_Layer_End_Time.

### 7.6 Event Trace (only in Standard/Pro Version)

#### 7.6.1 NetSim Network Stack and Discrete Event Simulation working

NetSim’s Network Stack forms the core of NetSim and its architectural aspects are diagrammatically explained below. It exactly mirrors the TCP/IP stack and has the following five layers

- Application Layer – CBR, Voice, Video, HTTP, COAP etc
- Transport Layer – TCP, UDP
- Network Layer – IP, OSPF, AODV, OLSR etc
- MAC Layer – 802.11, 802.15.4, LTE etc
- Physical Layer – Wired (P2P, P2MP, MP2MP), Wireless (RF Propagation)

Network Stack accepts inputs from the end-user in the form of Configuration file and the data flows as packets from one layer to another layer in the Network Stack.

All packets, when transferred between devices move up and down the stack, and all events in NetSim fall under one of these ten categories of events, namely, **Physical IN, Data Link IN, Network IN, Transport IN, Application IN, Application Out, Transport OUT, Network OUT, Data Link OUT** and **Physical OUT**. The IN events occur when the packets are entering a device while the OUT events occur while the packet is leaving a device. In addition to these events there can be **TIMER** events associated with each protocol.
Every device in NetSim has an instance of the Network Stack shown above. Switches & Access points have a 2 layer stack, while routers have a 3 layer stack. End-nodes have a 5 layer stack.

The protocol engines are called based on the layer at which the protocols operate. For example, TCP is called during execution of Transport IN or Transport OUT events, while 802.11b WLAN is called during execution of MAC IN, MAC OUT, PHY IN and PHY OUT events.

When these protocols are in operation they in turn generate events for NetSim’s discrete event engine to process. These are known as SUB EVENTS. All SUB EVENTS, fall into one of the above 10 types of EVENTS and TIMER events if applicable.

Each event gets added in the Simulation kernel by the protocol operating at the particular layer of the Network Stack. The required sub events are passed into the Simulation kernel. These sub events are then fetched by the Network Stack in order to execute the functionality of each protocol. At the end of Simulation, Network Stack writes trace files and the Metrics files that assist the user in analyzing the performance metrics and statistical analysis.

7.6.2 Event Trace:

The event trace records every single event along with associated information such as time stamp, event ID, event type etc in a text file or .csv file which can be stored at a user defined location. Apart from a host of information, the event trace has two special information fields for diagnostics

- A log of the file name and line number from where the event was generated (Please refer “Writing Custom Code in NetSim → Debugging your code → Via CLI”) and
- Previous event which triggered the current event.

*Note: Turning on Event Trace will slow down the simulation significantly*

NetSim provides users with the option of turning on "Event Traces".

**How to enable Event Trace via GUI?**

If NetSim runs via GUI, event trace can be turned on by clicking the Event Trace icon in the tool bar and selecting the required fields in the event trace.

**How to enable Event Trace via CLI?**

If NetSim runs via CLI, then the event trace can be turned on by enabling the event trace in the STATISTICS_COLLECTION tag of the configuration file. Following is a screenshot of a Configuration.netsim file with Event Trace disabled:

![Configuration.netsim file with Event Trace disabled](image1)

You can see that the STATUS is set to DISABLE, file name and file path are not set. To enable Event trace these parameters can be modified by editing the Configuration file. Open Configuration.netsim file and provide the file name, path and set status as Enable. Following is a screenshot of a Configuration.netsim file with Event Trace enabled:

![Configuration.netsim file with Event Trace enabled](image2)
Event Trace Metrics:

<table>
<thead>
<tr>
<th>Event_Id</th>
<th>Specifies the ID of the Event</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event_Type</td>
<td>Specifies the type of event being performed, for eg - APPLICATION_IN, APPLICATION_OUT, MAC_OUT, MAC_IN, PHYSICAL_OUT, PHYSICAL_IN, etc</td>
</tr>
<tr>
<td>Event_Time</td>
<td>Specifies the time(in microseconds) at which the event is being executed</td>
</tr>
<tr>
<td>Device_Type</td>
<td>Specifies the type of device in which the current event is being executed</td>
</tr>
<tr>
<td>Device_Id</td>
<td>Specifies the ID of device in which the current event is being executed</td>
</tr>
<tr>
<td>Interface_Id</td>
<td>Specifies the Interface_Id of device in which the present event is being executed.</td>
</tr>
<tr>
<td>Application_Id</td>
<td>Specifies the ID of the Application on which the specific event is executed</td>
</tr>
<tr>
<td>Packet_Id</td>
<td>Specifies the ID of the packet on which the current event is being executed</td>
</tr>
<tr>
<td>Segment_Id</td>
<td>Specifies the ID of the segment of packet on which the current event is being executed</td>
</tr>
<tr>
<td>Protocol_Name</td>
<td>Specifies the Protocol which is presently executed</td>
</tr>
<tr>
<td>Subevent_Type</td>
<td>Specifies the protocol sub event which is being executed. If the sub event value is 0, it indicates interlayer communication (Ex: MAC_OUT called by NETWORK_OUT) or a TIMER_EVENT which has no sub event.</td>
</tr>
<tr>
<td>Packet_Size</td>
<td>Specifies the size of packet during the current event</td>
</tr>
<tr>
<td>Prev_Event_Id</td>
<td>Specifies the ID of the event which generated the current event.</td>
</tr>
</tbody>
</table>

7.6.3 Calculation of Delay and Application throughput from event trace

1. Enable Event trace and run simulation
2. Click Event Trace option (Open Event Trace) in the Simulation results window.

Note: Event tracing is available only in NetSim standard and pro versions.
3. Click on **Pivot Table (Custom)** in excel sheet as shown below

4. A blank **PivotTable** and **Field List** will appear on a new worksheet.
5. Once PivotTable worksheet open, you’ll need to decide which **fields** to add. Each field is simply a **column header** from the source data. In the **PivotTable Field List**, check the box for each field you want to add.

7.6.3.1 **Application Delay Analysis:**
1. Drag and drop the Event_Type, Protocol_Name Fields into FILTERS, Packet_Id into ROWS and Device_Id into COLUMNS.
2. Drag and Drop Event_Time Field into VALUES twice, then both will show Sum of Event_Time. Recheck that you have dropped the Event_Time field twice.
3. Click on the second Event_Time field in the VALUES and select the Value Field Settings.
4. A window named **Value Field Settings** opens then select **Count** option and click **OK** button.

5. Then finally the **Pivot Table Fields** will be as shown below.
6. In the Event_Type select APPLICATION_IN and APPLICATION_OUT, Protocol_Name select APPLICATION and in Column Labels select the Source_Id and Destination_Id. In our example source node ID is 1 and destination node ID is 10.

And the Pivot Table created will be as shown (1 in the table is Source_Id and 10 is the Destination_Id)
7. Select the entire empty column H then and enter the formula `=IF(AND(LEN(A1), INT(A1)=A1),F1-G1*B1)` in function and press CTRL+ENTER

F column is Total Sum of Event_Time, G column is Total Count of Event_Time, B column is Sum of Event_time(µs) of the Source.

\[
\text{App Delay} = \frac{\text{Sum of the Delays of the successfully received application data packets by the destination}}{\text{Total number of successful application data packets received by the destination}}
\]

Note: If the packet size is > 1500 then fragmentation occurs and the packet is received as multiple segments. In NetSim the destination counts each segment as different packet.

Then in an empty cell enter

\[
=SUMIF(H:H,">0")/GETPIVOTDATA("Count of Event_Time(US)2",$A$4,"Device_Id",10)
\]

where
GETPIVOTDATA ("Count of Event_Time(US)2",$A$4,"Device_Id",10) gives the total number of packets received by the destination (in this case 10). This will give the exact Application Delay.

Compare with the Delay in Application Metrics Tables and it would exactly match. There might be slight difference in the decimals due to Excel’s round offs.

7.6.3.2 Application Throughput Analysis:

1. For Application Throughput drag and drop Event_type, Protocol_Name Fields in FILTERS, Device_Id in ROWS, Packet_Size(Bytes) into VALUES. Change the Value Field Settings of Packets_Size(Bytes) to SUM as mentioned in Delay Analysis.
Then Select the Event_Type as APPLICATION_IN, Protocol_Name as APPLICATION and Device_Id as the Destination (in this case 10).

2. App Throughput = \[
\frac{\text{Total Payload application successfully received by destination}}{\text{Simulation time}}
\]

Then in an empty cell type =GETPIVOTDATA ("Packet_Size(Bytes)"\$,A$4)*8/10000000

This gives the Application Throughput in Mbps (Multiplied by 8 to convert Bytes to bits, and divided by 100000 to convert into Mega)

Compare with the Application throughput in the Application_Metrics_Table

<table>
<thead>
<tr>
<th>Application Metrics Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Name</td>
</tr>
<tr>
<td>-------------------</td>
</tr>
<tr>
<td>input_plot</td>
</tr>
<tr>
<td>input_plot</td>
</tr>
<tr>
<td>input_plot</td>
</tr>
</tbody>
</table>
7.7 Packet Capture & analysis using Wireshark

7.7.1 Enabling Wireshark Capture in a node for packet capture

In NetSim, to enable packet capture in Wireshark, Right Click on the device where Wireshark should capture packets. In the properties, go to Global_Properties and set the Wireshark Capture parameter as Online.

<table>
<thead>
<tr>
<th>Wireshark Capture Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Online</td>
<td>Online will initiate a live interactive packet capture, displaying packets while running simulation.</td>
</tr>
<tr>
<td>Offline</td>
<td>Offline option will initiate silent packet capture and generate a pcap file which can be opened using Wireshark post-simulation</td>
</tr>
<tr>
<td>Disable</td>
<td>Packets are not captured during simulation.</td>
</tr>
</tbody>
</table>

7.7.2 Viewing captured packets

If enabled, Wireshark Capture automatically starts during simulation and displays all the captured packets. To view the details of the packet displayed, click-on the packet as shown below:
The detail of the contents of the selected packet can be seen in the below panes.

In the above figure, the details of the packet are displayed in both tree form and bytes form. In the tree form, user can expand the data by clicking on the part of the tree and view detailed information about each protocol in each packet.

7.7.3 Filtering captured packets

Display filters allow you to concentrate on the packets you are interested in while hiding the currently uninteresting ones. Packets can be filtered by protocol, presence of a field, values of field’s etc. To select packets based on protocol, type the protocol in which you are interested in the Filter: field of the Wireshark window and presenter to initiate the filter. In the figure below, tcp protocol is filtered.
You can also build display filters that compare values using a number of different comparison operators like ==, !=, >, <, <=, etc. Following is an example displaying filtered packets whose SYN Flag and ACK Flag are set to 1 in a TCP Stream.

### 7.7.4 Analyzing packets in Wireshark

#### Analyzing Conversation using graphs

A network conversation is the traffic between two specific end points. For example, an IP conversation is all the traffic between two IP addresses. In Wireshark, Go to Statistics Menu → Conversations.

Different types of protocols will be available. User can select the specific conversation by going to the desired protocol. For example, in the following diagram, we have selected TCP.
User can also analyze each of the conversation and can create graphs by selecting them and clicking on “Graph”.

The different types of graphs possible are

- Round Trip time
- Throughput
- Time/Sequence (Stevens)
- Time/Sequence (tcptrace)
- Window Scaling

### 7.7.5 Window Scaling

Click on data packet i.e. <None>.

Choose statistics→TCP Stream Graph→Window Scaling
Click on Switch Direction in the window scaling graph window

Fig: TCP congestion window Plot

Comparing the packet lengths

To analyze the packet sizes of all packets transmitted, go to **Statistics Menu→Packet lengths**. Users can also set filter to analyze a collection of specific packets only. For example, `tcp` filter is set to obtain the packet length below:
Creating IO graphs

To get the graph, go to **Statistics Menu \(\rightarrow\) IO Graph**.

Creating Flow graphs

The flow graph feature provides a quick and easy to use way of checking connections between a client and a server. It can show where there might be issues with a TCP connection, such as timeouts, re-transmitted frames, or dropped connections. To access flow graph, go to **Statistics Menu \(\rightarrow\) Flow Graph** and select the flow type. By default, you can see the flow graph of all the packets.

To get the TCP flow, select TCP flow in “Flow Type” dropdown box and you will obtain the flow as shown:
8 Writing Custom Code in NetSim

8.1 Writing your own code

NetSim allows the user to write the custom code for all the protocols by creating a DLL (Dynamic Link Library) for their custom code.

There are various important steps in this process, and each of these steps has various options as explained in the subsequent pages.

8.1.1 Microsoft Visual Studio 2019 Installation Settings

NetSim requires only a few components of Visual Studio Community 2019 edition to be installed. Upon starting the installer:

1. Under the Workloads tab users can select Desktop Development with C++ as shown below:

![Visual Studio Installer](image)

2. Under the Individual components tab select VC++2015.3 V140 toolset for desktop (x86,x64)
8.1.2 Modifying code

DLL is the shared library concept, implemented by Microsoft. All DLL files have a .dll file extension. DLLs provide a mechanism for sharing code and data to upgrade functionality without requiring applications to be re-linked or re-compiled. It is not possible to directly execute a DLL, since it requires an EXE for the operating system to load it through an entry point. NetSim requires Visual Studio Compiler for building DLL’s.

Note: Make sure that Visual Studio 2015 or above is installed in your system.

Refer section 3.12 section “How does a user open and modify source codes” to open NetSim Source Codes

1. After this you may modify the source codes of any project. You can also add new files to the project if required. As an example let us make a simple source code modification to TCP. Inside Solution Explorer pane in Visual Studio, double click on TCP project. Then open TCP.c file by double clicking on it. Using the drop down list of functions that are part of the current file, choose fn_Netsim_TCP_Init().
2. Add the line `fprintf(stderr, "InSource is Modified\n");` statement inside the `fn_Netsim_TCP_Init()` function as shown below to print “Source is modified”. 

   `_getch();` is added in the next line for the simulation to wait until it gets a user input.

3. Once this is done click to save the changes and overwrite the file (in case of write protection).
8.1.3 Building Dlls

1. Identify the build of NetSim that is installed in your system from NetSim Home Screen as shown below:

![NetSim Home Screen]

Based on the build of NetSim installed modify the solution platform in Visual studio from the drop down as shown below:

![Visual Studio Solution Screen]
3 Choose x64 for 64 bit version of NetSim and Win32 for 32 bit version of NetSim. After changing the solution platform, changes will be automatically applied to all projects that are displayed in the Solution Explorer.

4 Now rebuild the network by right clicking on the project header and selecting Rebuild creates a Dll file in the bin folder of NetSim's current workspace path <C:\Users\PC\Documents\NetSim_12.0.18_64_std_default\bin\bin_x64> for 64-bit and <C:\Users\PC\Documents\NetSim_12.0.18_64_std_default\bin\bin_x86> for 32-bit which contains your modifications. If build is successful a message similar to the following will be displayed in the output window:

![Output window with rebuild success message]

8.1.4 Running Simulation

1. After rebuilding the code, user can run the simulation via GUI (Please refer section 3). In this case, user can create a scenario in any network which involves TCP protocol. Running the simulation with the custom DLL will initially display a warning message as shown below:

![Warning message showing modified DLL files]

2. The warning message lists the DLL files which have been modified in the bin folder (bin\bin_x86 for 32-bit and bin\bin_x64 for 64-bit) of NetSim’s current workspace path.
After pressing any key the statement “Source is modified” will be printed to console as shown below:

3. Press any key to proceed with the simulation.
4. The warning message will not be displayed if no Dll’s are modified in the bin folder of current workspace path (bin\bin_x86 for 32-bit and bin\bin_x64 for 64-bit).

8.1.5 Source Code Dependencies

The following are the list of projects that are part of NetSim source codes present in <NetSim_Install_Directory>/src/Simulation directory and their dependencies:

<table>
<thead>
<tr>
<th>PROJECT</th>
<th>DEPENDENCY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>IP</td>
</tr>
<tr>
<td>Cellular</td>
<td>Application</td>
</tr>
<tr>
<td>CLIInterpertor</td>
<td>Firewall, IP</td>
</tr>
<tr>
<td>Cognitive Radio</td>
<td>Application</td>
</tr>
<tr>
<td>Ethernet</td>
<td>Firewall</td>
</tr>
<tr>
<td>IEEE802_11</td>
<td>Battery Model</td>
</tr>
<tr>
<td>OSPF</td>
<td>IP</td>
</tr>
<tr>
<td>Routing</td>
<td>IP</td>
</tr>
<tr>
<td>RPL</td>
<td>IP</td>
</tr>
<tr>
<td>ZigBee</td>
<td>Battery Model</td>
</tr>
<tr>
<td>ZRP</td>
<td>IP</td>
</tr>
<tr>
<td>Aloha</td>
<td>-</td>
</tr>
<tr>
<td>AODV</td>
<td>-</td>
</tr>
</tbody>
</table>
For Eg: To perform modifications to Application Project, IP folder will also be required in addition to lib folder, Include folder and NetSim.sln file.

### 8.2 Implementing your code - Examples

#### 8.2.1 Hello World Program

**Objective:** Print Hello World from TCP protocol.

**Implementation:** Add `fprintf(stderr, "<MESSAGE>")` statement inside the source code of TCP as shown below to print “Hello World” when custom built dll is executing.

```c
fprintf(stderr, "\nHello World\n")
_getch();
```
Build DLL as explained in Section 8.1 and run the simulation, you can see the following output on the console.

```
Press enter then simulation will continue.
```

### 8.2.2 Introducing Node Failure in MANET

**Objective:** Node failure using MANET-DSR using Device Id.

**Implementation:** Identify the Device ID of the particular node to be failed.

**Step 1:** Create a file with the name NodeFailure.txt inside the bin folder of NetSim's current workspace path `<C:\Users\PC\Documents\NetSim_12.0.18_64_std_default\bin\bin_x64>` for 64-bit and `<C:\Users\PC\Documents\NetSim_12.0.18_32_std_default\bin\bin_x86>` for 32-bit. The file will contain two columns: one being the Node ID of the device to be failed and other being the failure time (in microseconds).
For example, to fail Node Id 2 from 10th sec onwards and fail Node Id 1 from 90th sec onwards, the NodeFailure.txt file will be as follows:

<table>
<thead>
<tr>
<th>Node Id</th>
<th>Failure Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>9000000</td>
</tr>
<tr>
<td>2</td>
<td>1000000</td>
</tr>
</tbody>
</table>

**Step 2:** Go to DSR.c in DSR protocol.

**Step 3:** The function fn_NetSim_DSR_Init() will execute before the protocol execution starts. So in this function, we will read the NodeFailure.txt and save information regarding which nodes will fail at which time. Add the following code inside the specified function.

```c
int i;
FILE *fp1;
char *pszFilepath;
char pszConfigInput[1000];
pszFilepath = fnpAllocateMemory(36,sizeof(char)*50);
strcpy(pszFilepath,pszAppPath);
strcat(pszFilepath,"/NodeFailure.txt");
fp1 = fopen(pszFilepath,"r");
i=0;
if(fp1)
{
    while(fgets(pszConfigInput,500,fp1)!= NULL)
    {
        sscanf(pszConfigInput,"%d %d",&NodeArray[i],&TimeArray[i]);
        i+=1;
    }
    fclose(fp1);
}
```

**Step 4:** The fn_NetSim_DSR_Run() is the main function to handle all the protocol functionalities. So add the following code to the function at the start.

```c
int i,nFlag=1;
if(nFlag)
{
    for(i=0;i<100;i++)
        if((pstruEventDetails->nDeviceId== NodeArray[i]) &&
           (pstruEventDetails->dEventTime >= TimeArray[i]))
        {pstruEventDetails->nInterfaceId = 0;
         pstruEventDetails->pPacket=NULL;
         return 0;
```
Step 5: Add the following code inside DSR.h header file

```c
//Node failure model
int NodeArray[200];
int TimeArray[200];
```

Step 6: Build DLL as explained in Section 8.1.

Step 7: Create a scenario in MANET where data packets should be travelling from source to destination through the mentioned node in NodeFailure.txt file. For that user can increase the pathloss exponent value and the distance among the nodes. User can utilize Packet Animation to check the node failure (i.e. no packets are forwarded by failed nodes) after the mentioned time.

8.3 Debugging your code

This section is helpful to debug the code which user has written. To write your own code please refer Section 8.1.

8.3.1 Via GUI

Debugging your code via GUI there are two methods available

- Using _getch()
- Using Environment Variables (NETSIM_BREAK)

8.3.1.1 Using _getch()

Step 1: Perform the required modification of the protocol source code and add _getch() (used to hold the program execution until the user enters a character) statement inside init function of the modified protocol. For example, take DSR protocol and add the following lines of code in the init function as shown in the below screenshot

```c
fprintf(stderr, "\nAttach to Process now\n\n");
_getch();
```
Step 2: Build the DSR protocol as explained in Section 8.1. Do not close Visual Studio.

Step 3: In NetSim, create a network scenario where the protocol is being used and start the simulation. In the console window user would get a warning message shown in the below screenshot and the simulation will pause for user input (because of _getch() added in the init function)

Step 4: In Visual Studio, put break point inside the source code where you want to debug.

Step 5: Go to “Debug→Attach to Process” in Visual studio as shown and attach to NetSimCore.exe.
Click on Attach. Press enter in the command window. Then control goes to the project and stops at the break point in the source code as shown below. All debugging options like step over (F10), step into (F11), step out (Shift + F11), continue (F5) are available.
After execution of the function, the control goes back to NetSim and then comes back to the custom code the next time the function is called in the simulation.

To stop debugging and continue execution, press Shift+F5 (key). This then gives the control back to NetSim, for normal execution to continue.

8.3.1.2 Using Environment Variable

This section is helpful to Debug Using Environment Variable (NETSIM_BREAK). To set Environment variable follow the steps as shown

*Note: Setting NETSIM_BREAK Environment Variable will cause the simulation to slow down and it is recommended to remove this Environment Variables after debugging the simulation*

**Step 1:** Right click on My Computer\This PC and select Properties

**Step 2:** Go to Advanced System setting → Advanced Tab → Environment Variables option

**Step 3:** Click New in System variables. Type “NETSIM_BREAK” as Variable name and any positive integer as variable value (e.g. 2). Click OK. The value of the variable is the event ID at which you want NetSim Simulation to break. In this example we have set the value to 2, which means that the simulation will break at the previous event.
Step 4: Open NetSim and then open the source codes. Please refer section 3.12 "How does a user open and modify source codes" for more information.

Step 5: Create a network scenario in NetSim (Internetworks or any other networks)

Step 6: In this example we are placing a break point in TCP source code and thus TCP should be enabled in Transport Layer of the devices.

Step 7: Enable Event trace option and run the simulation
Simulation will break at event ID 1 as we have set the environment variable to 2 as shown below:

Here NetSim breakpoint has been triggered.
Step 8: Inside Solution Explorer pane in Visual Studio, double click on TCP project. Then open TCP.c file by double clicking on it. Using the drop down list of functions that are part of the current file, choose `fn_NetSim_TCP_Run()`.

Step 9: In Visual Studio, Set the breakpoint in the code by clicking on the grey area on the left of the line or by right clicking on the line and selecting Breakpoint->Insert Breakpoint.

Step 10: Go to “Debug->Attach to Process” in Visual studio as shown and select NetSimCore.exe from the list of processes displayed.
Click on Attach. Press any key in the command window to continue the process.

**Step 11:** Now we need to enter next event ID to break

Then control goes to the project and stops at the break point in the source code (NetSim will break where ever user has set the breakpoint) as shown below. All debugging options like **step over (F10), step into (F11), step out (Shift + F11), continue (F5)** are available.
After execution of the function, the control goes back to NetSim and then comes back to the custom code the next time the function is called in the simulation. To stop debugging and continue execution, press \textbf{Shift+F5} (key). This then gives the control back to NetSim, for normal execution to continue.

If \textsc{NETSIM\_BREAK} environment variable is set, NetSim event trace file additionally logs the file name and line number of the source code where the event was added as shown below:
8.3.2 Via CLI

Modify the DSR protocol and build the code. Create a scenario on MANET then follow the below steps.

**Step 1:** Open the Command prompt. Press “windows+R” and type “cmd”.

**Step 2:** To run the NetSim via CLI copy the path where “NetSimCore.exe” is present.

```bash
>cd <apppath>

>NetSimCore.exe -apppath <apppath> -apppath <apppath> -iopath <iopath> -iopath <iopath> -license <license> 5053@<ServerIP Address> -d
```

**Step 3:** Type the following command.

Press enter, now you can see the following screen.

**Step 4:** Open the Project in Visual Studio and put break point inside the source code.

**Step 5:** Go to “Debug→Attach to Process”
Attach to NetSimCore.exe.

Click on Attach.

**Step 6:** Go to command prompt which is already opened in Step 3. Enter the Event Id.

*Note: If you don’t want to stop at any event you can specify 0 as event id.*

Execution will stop at the specified event.

Press enter then control goes to the project and stops at the break point in the source code as shown below.
All debugging options like step over (F10), step into (F11), step out (Shift + F11), continue (F5) are available.

After execution of the function, the control goes back to NetSim and then comes back to the custom code the next time the function is called in the simulation.

To stop debugging press Shift+F5. This then gives the control back to NetSim, for normal execution to continue.

8.3.3 Co-relating with Event Trace

To debug your own (custom) code, it is often helpful to know which section of the code (file name & line number) generated the event under study. There are 2 ways to enable this feature.

Procedure 1

Step 1: Open configuration.netsim file and provide the file name, path and set status as Enable.

Step 2: Run the NetSim via CLI in debug mode (Refer NetSim Help in chapter 6→Running Simulation via CLI) with –d as the fourth parameters

Press enter
Step 3: Enter -1 as the event ID

Upon running, NetSim will write the file name and line number of the source code that generated each event.

Note: In the above trace file Event Id 56 is triggered inside the IEEE802_11_Phy.c file which is present in IEEE802_11 project. Since all the lib files are opaque to the end user, you cannot see the source code of the lib file. However, Event Id 56 is triggered at line number 396 of IEEE802_11_Phy.c file and you can find the location of the event by opening the IEEE802_11_Phy.c file as shown below.
Procedure 2:

Step 1: Right click on my computer and select Properties.

Step 2: Go to Advanced System setting → Advanced Tab → Environment Variables

Step 3: Click New. Type “NETSIM_BREAK” as Variable name and any negative integer as Variable value. Click OK.
Step 4: Restart the system.

Step 5: Now perform simulation in NetSim (Enable event trace in GUI). Upon running, NetSim will write the file name and line number of the source code that generated each event.

8.3.4 Viewing & Accessing variables

Viewing variables while debugging code:

To see the value of a variable, when debugging hover the mouse over the variable name in the code. A text box with variable contents appears. If the variable is a structure and contains other variables, then click on the plus sign which is there to the left of the text box. Users can pin the variable to watch by clicking on the pin icon to the right of that variable in the text box.

Adding the variable to watch –
Watch the change in the variable as the code progress by right clicking on the variable & clicking on "add watch" tab. This is useful if to continuously monitor the change in the variable as the code progresses.

**Viewing external variables**

During the process of debug users would come across variables that are defined outside the source file being built as a .dll. Such variables cannot be viewed directly when added in the watch tab, as this would throw the error

CX0017: Error:symbol 'Variable_Name' not found.

In the call stack window one can find the file in which that variable is situated. Right click on the dll file name in the call stack window, in this case NetworkStack.dll. Then in the pull down menu which appears, select "load symbols from" and give the path of the pdb(program database) file.

A program database (.pdb) file, also called a symbol file, maps the identifiers that a user creates in source files for classes, methods, and other code to the identifiers that are used in the compiled executables of the project. The .pdb file also maps the statements in the source code to the execution instructions in the executables. The debugger uses this information to determine: the source file and the line number displayed in the Visual Studio IDE and the location in the executable to stop at when a user sets a breakpoint. A symbol file also contains
the original location of the source files, and optionally, the location of a source server where the source files can be retrieved from.

When a user debugs a project in the Visual Studio IDE, the debugger knows exactly where to find the .pdb and source files for the code. If the user wants to debug code outside their project source code, such as the Windows or third-party code the project calls, the user has to specify the location of the .pdb (and optionally, the source files of the external code) and those files need to exactly match the build of the executables.

The pdb files are usually available in NetSim’s install directory, else write to support@tetcos.com for the latest copy of these debug files. Go to Tools > options>debugging>load all symbols.

![Options dialog box with load all symbols selected](image)

*Note: If the load symbols menu option is greyed, then it means symbols are already loaded*

In the watch window, the variable which the user has to watch should be edited by double clicking on it and prefixing {, NetworkStack.dll} to the variable name and pressing enter. (The name of the respective file in which the variable is defined should be mentioned - in this case NetworkStack.dll).
Accessing External Variables:

Each protocol in NetSim has a separate Dll file which contains the variables and functions which can be shared. In case of cross layer protocol implementations variables of one protocol may have to be accessed from another Dll.

An example is given below showing how Physical layer parameters of devices running IEEE802.11 can be accessed in the Network Layer with DSR protocol configured.

The variable battery is defined in a structure stru_802_11_Phy_Var which is part of IEEE802_11_Phy.h file. So the user will have to access a pointer of type stru_802_11_Phy_Var. In the header file where the structure definition is given, the following line of code must be written –

```c
#ifndef SHARE_VARIABLE
    _declspec(dllexport) IEEE802_PHY_VAR *var1;
#else
    _declspec(dllimport) IEEE802_PHY_VAR *var1;
#endif
```

In the example, the code line must be written in IEEE802_11_Phy.h file present inside IEEE802_11 folder.
In the main function where a user wishes to find the \( d_{\text{ReceivedPower}_{\text{mw}}} \), the variable must be assigned the respective value. In the above case, the following line of code must be written inside `fn_NetSim_IEEE802_11_PhyIn()` function in `IEEE802_11_Phy.c` file present inside `IEEE802_11` folder.

\[
\text{var1} = \text{DEVICE PHYVAR}(\text{pstruEventDetails->nDeviceId}, \text{pstruEventDetails->nInterfaceId});
\]

Note that the parameters given in the macro or any function which assigns a value to the variable must be defined beforehand in the code. Here `nDeviceId` and `nInterfaceId` are defined beforehand.
The IEEE802_11 project must be built and the resulting **libIEEE802.11.dll** file which gets created in the `bin` folder of NetSim's current workspace

\(<C:\Users\PC\Documents\NetSim_1.2.7.18_64_std_default\bin\bin_x64>\) for 64-bit and
\(<C:\Users\PC\Documents\NetSim_1.2.7.18_32_std_default\bin\bin_x86>\) for 32-bit NetSim.

The Object file **IEEE802_11.lib** which is also got created in the `lib` folder located in the current workspace

\(<C:\Users\PC\Documents\NetSim_1.2.7.18_64_std_default\src\Simulation\lib_x64>\) for 64-bit and
\(<C:\Users\PC\Documents\NetSim_1.2.7.18_32_std_default\src\Simulation\lib>\) for 32-bit.

Now expand the DSR project in solution explorer. For accessing the IEEE802_11 variable, the following lines must be added in DSR.h file

```c
#define SHARE_VARIABLE
#pragma comment(lib,"IEEE802_11.lib")
```

Add the following lines of code to the DSR.c file as shown below:

```c
#include "../IEEE802_11/IEEE802_11_Phy.h"
#include "../BatteryModel/BatteryModel.h"
```
In the fn_NetSim_DSR_Run() function add the following lines of code to print the value of dReceivedPower_mw variable from DSR project.

if (var1)
    fprintf(stderr, "n Remaining Energy(mJ): %lf
    ,battery_get_remaining_energy((ptrBATTERY)var1->battery));

The DSR project must be built and the resulting libDSR.dll file gets created in the bin folder of NetSim's current workspace path <C:\Users\PC\Documents\NetSim_12.0.18_64_std_default\bin\bin_x64> for 64-bit and <C:\Users\PC\Documents\NetSim_12.0.18_32_std_default\bin\bin_x86> for 32-bit. When a
scenario is run, the remaining energy of the node will be printed to the simulation console as shown below:

![Print to console window in NetSim](image)

### 8.3.5 Print to console window in NetSim

Users can try printing the Device ID, Application ID, Duplicate Ack Count etc.

**To print to console:** Print node positions in MANET

Open Mobility Project, and in Mobility.c file go to fn_NetSim_Mobility_Run() function. Inside the default case add following codes:

```c
fprintf(stderr,"\n The position of %s at time %.2lf ms is X=%.2lf and Y = %.2lf
\n",DEVICE_NAME(pstruEventDetails->nDeviceId),

pstruEventDetails->dEventTime,

DEVICE_POSITION(pstruEventDetails->nDeviceId)->X,

DEVICE_POSITION(pstruEventDetails->nDeviceId)->Y);

_getch();
```
Building Mobility project creates libMobility.dll inside the binary folder of NetSim’s current workspace path `<C:\Users\PC\Documents\NetSim_12.0.18_64_std_default\bin\bin_x64>` for 64-bit and `<C:\Users\PC\Documents\NetSim_12.0.18_32_std_default\bin\bin_x86>` for 32-bit. Create a scenario in MANET and configure the mobility model of the nodes. During simulation users can notice that the positions of the nodes are displayed in the console w.r.t. the simulation time.

8.4 Creating a new packet and adding a new event in NetSim

In this example we show how users can create their own packet & event in 802.15.4 Zigbee. The same methodology can be applied to any network / protocol.

1. Open the Source codes in Visual studio using the NetSim.sln file.
2. Go to ZigBee project and Open 802_15_4.h file and add a subevent called “MY_EVENT” inside `enum_IEEE802_15_4_Subevent_Type` as shown below:

```c
/** Defining sub event type of IEEE 802.15.4*/
enum enum_IEEE802_15_4_Subevent_Type
{
    SUPERFRAME_EVENT = MAC_PROTOCOL_IEEE802_15_4*100+1,
    CARRIERSENSE_START,
    CARRIERSENSE_END,
    ACK_TIMEOUT,
    BEACON_TRANSMISSION,
    GOFORSLEEP,
    BEACON_TRANSMISSION_END,
    CAP_END,
    CFP_END,
    ACK_EVENT,
    CSMA_DATATRANSFER,
    CHANGE_RX,
    CHANGE_RXANDSENDMDATA,
    UPDATE_MEDIUM,
    MY_EVENT,
};
```
3. To add a new packet in NetSim first user has to initialize their new packet name inside 802_15_4.h file. Let us assume the new packet be “MY_PACKET” and it is a control packet. So user has to define it inside the following enum as shown below:

```c
enum enum_IEEE_802_15_4_ControlPacket_Type
{
    BEACON_FRAME = MAC_PROTOCOL_IEEE802_15_4*100+1,
    SLEEP_FRAME,
    ACK_FRAME,
    MY_PACKET,
};
```

4. We assume that MY_PACKET has the same fields as a Zigbee Ack and hence we are adding the following ack frame to 802_15_4.h file (Add this code just above the enum enum_IEEE_802_15_4_ControlPacket_Type{} definition):

```c
struct stru_My_Frame
{
    int nBeaconId;
    int nSuperFrameId;
    int nBeaconTime;
    double dPayload;
    double dOverhead;
    double dFrameSize;
};
typedef struct stru_My_Frame MY_FRAME;
enum enum_IEEE_802_15_4_ControlPacket_Type
{
```

5. Open 802_15_4.c file, go to the case TIMER_EVENT and add the following code to the subevent type :-

```c
case SUBEVENT_GETLINKQUALITY:
{
--------------------------
} break;
case MY_EVENT:
{
//my event//
    fprintf(stderr, "My_event");
    pstruEventDetails->dEventTime = pstruEventDetails->dEventTime + 1 * SECOND;
    pstruEventDetails->nDeviceId = nGlobalPANCoordinatorId;
    pstruEventDetails->nInterfaceId = 1;
    pstruEventDetails->nEventType = TIMER_EVENT;
    pstruEventDetails->nSubEventType = MY_EVENT;
    pstruEventDetails->nProtocolId = MAC_PROTOCOL_IEEE802_15_4;
    fnpAddEvent(pstruEventDetails);
```
Here we are adding a new event inside the timer event, and this event will occur every 1 second in the GlobalPANCoordinator, i.e. sink node. In this event, fn_NetSim_WSN_MY_PACKET() is called as explained in step 5.

6. Inside 802_15_4.c file, add the following code at the end of the file for sending ack (broadcast):

```c
int fn_NetSim_WSN_MY_PACKET()
{
    double dTime;
    NETSIM_ID nDeviceId = pstruEventDetails->nDeviceId;
    NETSIM_ID nInterfaceId = pstruEventDetails->nInterfaceId;
    IEEE802_15_4_MAC_VAR *pstruMacVar = DEVICE_MACVAR(nDeviceId, nInterfaceId);
    IEEE802_15_4_PHY_VAR *pstruPhyVar = DEVICE_PHYVAR(nDeviceId, nInterfaceId);
    NetSim_PACKET *pstruPacket = pstruEventDetails->pPacket;
    MY_FRAME *pstruAckPkt;
    dTime = pstruEventDetails->dEventTime;

    // Create MY_Frame
    pstruAckPkt = fn_NetSim_Packet_CreatePacket(MAC_LAYER);
    pstruAckPkt->nPacketType = PacketType_Control;
    pstruAckPkt->nPacketPriority = Priority_High;
    pstruAckPkt->nControlDataType = MY_PACKET;
    pstruAck = fnpAllocateMemory(1, sizeof(MY_FRAME));

    // Update packet fields
    pstruAckPkt->nSourceId = nDeviceId;
    pstruAckPkt->nTransmitterId = nDeviceId;
    pstruAckPkt->nReceiverId = 0;
    add_dest_to_packet(pstruAckPkt, pstruAckPkt->nReceiverId);
    pstruAckPkt->pstruMacData->Packet_MACProtocol = pstruAck;
    pstruAckPkt->pstruMacData->dArrivalTime = dTime;
    pstruAckPkt->pstruMacData->dStartTime = dTime;
    pstruAckPkt->pstruMacData->dEndTime = dTime;
    pstruAckPkt->pstruMacData->dPacketSize = pstruAckPkt->pstruMacData->dOverhead;
    pstruAckPkt->pstruMacData->nMACProtocol = MAC_PROTOCOL_IEEE802_15_4;
    strcpy(pstruAckPkt->szPacketType, "MY_PACKET");
    //to see the packet in animation
```
// Add SEND ACK subevent
pstruEventDetails->dEventTime = dTime;
pstruEventDetails->dPacketSize = pstruAckPkt->pstruMacData->dPacketSize;
pstruEventDetails->nSubEventType = 0;
pstruEventDetails->nEventType = PHYSICAL_OUT_EVENT;
pstruEventDetails->pPacket = pstruAckPkt;
fnpAddEvent(pstruEventDetails);

//Free the packet
fn_NetSim_Packet_FreePacket(pstruPacket);
pstruPacket = NULL;
return 0;
}

7. Inside the above function NetSim API fn_NetSim_Packet_CreatePacket(MAC_LAYER); is used. This is the API which creates a new packet in NetSim. Since in this example, new packet is created in MAC layer, it is passed as an argument. Users can give the respective Layer name for creating packets in any other layers. In the above code users can see the following line:

strcpy(pstruAckPkt->szPacketType, "MY_PACKET");

This is used visualize the packet transmission in the packet animation.

8. In 802_15_4.c file, goto fn_NetSim_Zigbee_Init() function and add the following code in red color to call the timer_event. i.e MY_EVENT

```c
declspec (dllexport) int fn_NetSim_Zigbee_Init(struct stru_NetSim_Network NETWORK_Formal, NetSim_EVENTDETAILS pstruEventDetails_Formal, char *pszAppPath_Formal, char *pszWritePath_Formal, int nVersion_Type, void **fnPointer)
{
pstruEventDetails=pstruEventDetails_Formal;
NETWORK=NETWORK_Formal;
pszAppPath =pszAppPath_Formal;
pszIOPath = pszWritePath_Formal;
//MY_EVENT
pstruEventDetails->nDeviceId = nGlobalPANCoordinatorId;
pstruEventDetails->nInterfaceId = 1;
pstruEventDetails->dEventTime = pstruEventDetails->dEventTime;
pstruEventDetails->nEventType = TIMER_EVENT;
pstruEventDetails->nSubEventType = MY_EVENT;
pstruEventDetails->nProtocolId = MAC_PROTOCOL_IEEE802_15_4;
fnpAddEvent(pstruEventDetails);
//MY_EVENT
fn_NetSim_Zigbee_Init_F(NETWORK_Formal,pstruEventDetails_Formal,pszAppPath_Formal,pszWritePath_Formal,nVersion_Type,fnPointer);
return 0;
}
```
In the above function, subevent type, “MY_EVENT” is called. So this function calls the
MY_EVENT, timer event to execute.

9. fn_NetSim_Zigbee_Trace() is an API to print the trace details to the event trace. So inside 802_15_4.c file add the following lines of code in red color inside fn_NetSim_Zigbee_Trace(int nSubEvent) as shown below:-

```c
_declspec (dllexport) char *fn_NetSim_Zigbee_Trace(int nSubEvent)
{
    if (nSubEvent == MY_EVENT)
        return "MY_EVENT";
    return (fn_NetSim_Zigbee_Trace_F(nSubEvent));
}
```

10. Save the code and build Zigbee project, libZigBee.dll will get created in the bin
folder of NetSim’s current workspace path <C:\Users\PC\Documents\NetSim_12.0.18_64_std_default\bin\bin_x64> for 64-bit
and <C:\Users\PC\Documents\NetSim_12.0.18_32_std_default\bin\bin_x86> for 32-bit. Create a basic scenario in WSN with 2 sensors and 1 sink node.

11. While creating the application between two sensors, set

   Application Type - Sensor App
   Interarrival Time - 5000

12. Run simulation for 10 seconds.

13. Play packet animation. Here users can see that Sink node broadcasts “MY_PACKET”
to the sensor.

14. Also open packet trace and users can filter the control packet and see all the
packet details of “MY_PACKET” written in the packet trace.
15. To analyse the “MY_EVENT” users can open event trace and filter the subevent type as “MY_EVENT”. Here users can analyse that the event occurs for every 1 seconds.
NetSim provides a wide variety of APIs for protocol developers. These are available in

1 **packet.h** – Packet related APIs
   - Create a new packet
     - `fn_NetSim_Packet_CreatePacket_dbg(int nLayer,int line,const char* file);`
   - Copy a packet into a new packet
     - `fn_NetSim_Packet_CopyPacket_dbg(const NetSim_PACKET* pstruPacket,int line,const char* file);`
   - Create error in packet
     - `fn_NetSim_Packet_DecideError(double dBER, long double dPacketSize);`
   - Free a packet
     - `fn_NetSim_Packet_FreePacket_dbg(NetSim_PACKET** pstruPacket,int line,char* file);`

2 **stack.h** – Network / device / link and event related APIs
   - Calculate distance between nodes.
     - `fn_NetSim_Utilities_CalculateDistance(NetSim_COORDINATES* coordinate1,NetSim_COORDINATES* coordinates2);`
   - Stores the event details. Only one time memory is allocated. Most used variable
     - `struct stru_NetSim_EventDetails* pstruEventDetails;`
   - Retrieve values from xml file
     - `GetXmlVal(void* var,char* name,void* xmlNode,int flag, XMLDATATYPE type);`

3 **list.h** – Optimized list operation calls since NetSim uses lists extensively
   - Add elements in list
     - `list_add(void** list,void* mem,size_t offset,int (*check)(void* current,void* mem));`
• Sorting the list
  
  o list_sort(void** list, size_t offset, int (*check)(void* current, void* mem));

4 IP_Addressing.h – For setting & getting IP address per the appropriate format

• Set Ip address of any node
  
  o NETSIM_IPAddress

• Checking ip address is broadcast or multicast
  
  o isBroadcastIP(NETSIM_IPAddress ip);
  o isMulticastIP(NETSIM_IPAddress ip);

For detailed help please refer the appropriate header (.h) files inside:/NetSim_Standard/src/simulation/include or read through the doxygen source code documentation available inside NetSim → Help → NetSim source code Help

• Include all the header (.h) files from the include folder
• NetworkStack.lib is a “import library” file and has the definitions for the functions present in the NetworkStack.dll
• When developing new protocols users should create their own protocol.h and declare all the protocol specific variables here. Stack & packet related variables should be used from stack.h and packet.h

NetSim Network Stack calling individual Protocol

Every protocol should provide the following APIs as hooks to the network stack:

• int (*fn_NetSim_protocol_init)(const struct stru_NetSim_Network*, const struct stru_NetSim_EventDetails*, const char*, const char*, int, const void**);
  
  Using this API the stack passes all the relevant pointers to variables, paths etc needed for the protocol. Inside this function a) local variables should be initialized, b) Initial events if any should be written, eg: Hello packet in RIP, STP in Ethernet c) File pointers for reading & writing protocol_specific_IO files.

• int (*fn_NetSim_protocol_Configure)(const struct stru_NetSim_Network*, int nDeviceId, int nInterfaceID, int nlayertype, fnpAllocateMemory, fnpFreeMemory, fpConfigLog);
• The stack calls this API when reading the config file. Upon reaching the appropriate protocol definition in the XML file, the stack calls this and passes all these pointers to the protocol

• `int (*fn_NetSim_protocol_run)()`: This is called by the stack to run the protocol

• `char* (*fn_NetSim_protocol_trace)(int)`: This called by the stack to write the event trace

• `int (*fn_NetSim_protocol_CopyPacket)(const NetSim_PACKET* pstruDestPacket, const NetSim_PACKET* pstruSrcPacket)`: This is for copying protocol specific parameters / data into the packed

• `int (*fn_NetSim_protocol_FreePacket)(const NetSim_PACKET* pstruPacket)`: This is to free the protocol specific parameters / data in the packet

• `(*fn_NetSim_protocol_Metrics)(const FILE* fpMetrics)`: This is to write the metrics file upon completion of the simulation

• `int (*fn_NetSim_protocol_Finish)()`: To release all memory after completion

• `char* (*fn_NetSim_protocol_ConfigPacketTrace)(const void* xmlNetSimNode)`: To configure the packet packet trace in terms of the parameters to be logged

• `char* (*fn_NetSim_protocol_WritePacketTrace)(const NetSim_PACKET*)`: To configure the event trace in terms of the parameters to be logged.
9 Advanced Features

9.1 Random number Generator and Seed Values

All network simulations involve an element of randomness. Some examples are -

It is possible to configure the traffic sources in the simulation to generate traffic in a perfectly regular pattern. However, this is typically not the case in the real world. For example, Node back-off’s after collisions are random to resolve contention issues. The exact bit which is errored, based on Bit error probability of a wireless channel, is decided randomly.

NetSim uses an in-built Linear Congruential Random Number Generator (RNG) to generate the randomness. The RNG uses two seeds values to initialize the RNG.

Having the same set of seed values ensures that for a particular network configuration the same output results will be got, irrespective of the PC or the time at which the simulation is run. This ensures repeatability of experimentation.

Modifying the seed value will lead to the generation of a different set of random numbers and thereby lead to a different sequence of events in NetSim. When simulations are run for a network configuration with different seed values, the results will likely be slightly different.

More advanced users get “Confidence” by analyzing a set of results with different seed values for the same network scenario.

9.2 Interfacing MATLAB with NetSim (Std/Pro versions)

NetSim provides run-time interfacing with MATLAB so that users don’t have to rewrite code in C for features that are already available in MATLAB. They can simply reuse MATLAB code. Lot of work related to machine learning, artificial intelligence and specialized mathematical algorithms which can be used for networking research, can be carried out using existing MATLAB code.
This interfacing feature can be used to either replace an existing functionality in NetSim or to incorporate additional functionalities supported by MATLAB. Any existing command/function/algorithm in MATLAB or a MATLAB M-script can be used.

In general the following are done when a users interfaces NetSim to MATLAB:

- Initialize a MATLAB engine process in parallel with NetSim,
- Execute MATLAB workspace commands,
- Pass parameters to MATLAB workspace,
- Read parameters from MATLAB workspace,
- Generate dynamic three-dimensional plots,
- Make calls to functions that are part of MATLAB M-scripts or .M files, and
- Terminate the MATLAB engine process at NetSim simulation end.

Pre-requisites for Interfacing NetSim with MATLAB

- MATLAB Interfacing requires an installed version of MATLAB. Engine API functions cannot be run on a machine that only has the MATLAB Runtime.
- Both NetSim and MATLAB should use the same build; either 32 bit or 64 bit.

MATLAB functions can be called from NetSim's underlying protocol C source codes using MATLAB APIs. Following are some of the MATLAB Engine API functions that can be used from NetSim C source codes:

<table>
<thead>
<tr>
<th>Engine</th>
<th>Type for MATLAB engine</th>
</tr>
</thead>
<tbody>
<tr>
<td>engOpen</td>
<td>Start MATLAB engine session</td>
</tr>
<tr>
<td>engOpenSingleUse</td>
<td>Start MATLAB engine session for single, nonshared use</td>
</tr>
<tr>
<td>engClose</td>
<td>Quit MATLAB engine session</td>
</tr>
<tr>
<td>engEvalString</td>
<td>Evaluate expression in string</td>
</tr>
<tr>
<td>engGetVariable</td>
<td>Copy variable from MATLAB engine workspace</td>
</tr>
<tr>
<td>engPutVariable</td>
<td>Put variable into MATLAB engine workspace</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------------------------------------------------</td>
</tr>
<tr>
<td>engGetVisible</td>
<td>Determine visibility of MATLAB engine session</td>
</tr>
<tr>
<td>engSetVisible</td>
<td>Show or hide MATLAB engine session</td>
</tr>
<tr>
<td>engOutputBuffer</td>
<td>Specify buffer for MATLAB output</td>
</tr>
</tbody>
</table>

Guidelines to interface NetSim with MATLAB

- Analyze what parameters the function or code in MATLAB expects as input
- Identify the relevant variables in NetSim to be passed as input to MATLAB
- Make calls from relevant places of NetSim source code to
  - Pass parameters from NetSim to MATLAB
  - To read computed parameters from MATLAB workspace
- Identify and update the appropriate simulation variables in NetSim

9.2.1 Implement Rician Distribution of MATLAB without using .m file

In this example we will replace the default Rayleigh Fading (part of the path loss calculation) used in NetSim, with a Fading Power calculated using the Rician Distribution from MATLAB.

Note: This example uses 32-bit versions of NetSim and MATLAB. Settings will slightly vary in case of 64-bit versions of the software.

Procedure:

1. Create a MATLAB_Interface.c file inside the IEEE802_11 folder which can be found in the current workspace location of NetSim that you are running and it would be something like 
   “C:\Users\PC\Documents\NetSim_12.0.18_64_std_default\src\Simulation\IEEE802_11”

   For more information on NetSim workspace refer Section 3 “Workspaces and Experiments”. Write the following code inside the MATLAB_Interface.c file:

```c
/*
 * This is a simple program that illustrates how to call the MATLAB
 * Engine functions from NetSim C Code.
 */
#include <windows.h>
#include <stdlib.h>
#include <stdio.h>
#include <string.h>
#include "engine.h"
#include "mat.h"
#include "mex.h"
```
double fn_netsim_matlab_init()
{
    /*
    * Start the MATLAB engine
    */
    fprintf(stderr, "nPress any key to Initialize MATLAB
n");
    _getch();
    if(!((ep = engOpen(NULL))) ) {
        MessageBox((HWND)NULL, (LPCWSTR)"Can't start MATLAB engine",
                    (LPCWSTR)"MATLAB_Interface.c", MB_OK);
        exit(-1);
    }
    engEvalString(ep, "desktop");
    return 0;
}

double fn_netsim_matlab_run()
{
    //write your own implementation here
    int rician_noncentrality = 1, rician_scale = 2;
    engPutVariable(ep, "h", h);
    //use ProbDistUnivParam() function for matlab 2016
    sprintf_s(buf, BUFSIZ, "h=ProbDistUnivParam('rician',[%d %d])",
              rician_noncentrality, rician_scale);
    //use makedist() function for matlab 2017
    //sprintf_s(buf, BUFSIZ, "h=makedist('rician','%d,%d')", rician_noncentrality,
    //rician_scale);
    status = engEvalString(ep, buf);
    engPutVariable(ep, "i", i);
    sprintf_s(buf, BUFSIZ, "i=random(h,1)");
    status = engEvalString(ep, buf);
    out = engGetVariable(ep, "i");
    result = mxGetPr(out);
    return *result;
}

double fn_netsim_matlab_finish()
fprintf(stderr, "nPress any key to close MATLAB\n");
_getch();
status = engEvalString(ep, "exit");
return 0;

2 Now open the code
3 Right click on “IEEE802_11 Project” present in “Solution Explorer” window and select Add Existing Item and select the MATLAB_Interface.c file.
4 MATLAB_Interface.c file contains the following functions
   i.  fn_netsim_matlab_init() - Opens the MATLAB Engine
   ii. fn_netsim_matlab_run() - Communicates with MATLAB Command Window
   iii. fn_netsim_matlab_finish() - Closes the MATLAB Engine
5 In the Solution Explorer double click on the IEEE802_11.c file.
6   Add a call to fn_netsim_matlab_init(); inside the fn_NetSim_IEEE802_11_Init() function.

7   Similarly add a call to fn_netsim_matlab_finish(); inside the fn_NetSim_IEEE802_11_Finish() function.
In the Solution Explorer double click on the IEEE802_11.h file. Add definitions of the following functions

```c
double fn_netsim_matlab_init();
double fn_netsim_matlab_run();
double fn_netsim_matlab_finish();
```

In the Solution Explorer double click on the IEE802_11_PHY.c file.

Inside fn_Netsim_IEEE802_11_PHYIn() function comment the lines,

```c
dFadingPower = propagation_calculate_fadingloss(propagationHandle, packet->nTransmitterId, ifid, pstruEventDetails->nDeviceId, pstruEventDetails->nInterfaceId);
```

Make a call to the fn_netsim_matlab_run() function by adding the following line,

```c
dFadingPower = fn_netsim_matlab_run();
```
To compile a MATLAB engine application in the Microsoft Visual Studio (2017) environment, Right click on the IEEE802_11 project and select PROPERTIES in the solution explorer. Once this window has opened, make the following changes:

- Under C/C++ → General, add the following directory to the field ADDITIONAL INCLUDE DIRECTORIES:
  `<Path where MATLAB is installed>\extern\include`

**NOTE: To determine path where MATLAB is installed, entering the following command in the MATLAB command prompt:**

```
matlabroot
```
• Under C/C++ → Precompiled Headers, set PRECOMPILED HEADERS as "Not Using Precompiled Headers".

• Under Linker → General, add the directory to the field ADDITIONAL LIBRARY DIRECTORIES:

  <Path where MATLAB is installed>\extern\lib\win32\microsoft
• Under Configuration Properties → Debugging, Add the following Target path in the ENVIRONMENT: \<Path where MATLAB is installed>\bin\win32

• Under Linker → Input, add the following names to the field marked ADDITIONAL DEPENDENCIES: libeng.lib;libmx.lib;libmat.lib;

• Make sure that the following directory is in the environment variable PATH: \<Path where MATLAB is installed>\bin\win32
Notes:

1. To do step 14, check the Windows system path by clicking on Start → Right click on Computer → Properties → Advanced System Settings → Environment variables → System Variables → Open "Path" for editing.

2. If the machine has more than one MATLAB installed, the directory for the target platform must be ahead of any other MATLAB directory (for instance, when compiling a 32-bit application, the directory in the MATLAB 32-bit installation must be the first one on the PATH). To run 64-bit NetSim, users has to change the above mentioned matlab paths to 64-bit matlab paths

- Now Right Click on IEEE802_11 project and select Rebuild

- A new libIEEE802.11.dll gets created in the bin folder of NetSim’s current workspace path <C:\Users\PC\Documents\NetSim_12.0.18_64_std_default\bin\bin_x64> for 64-bit and <C:\Users\PC\Documents\NetSim_12.0.18_32_std_default\bin\bin_x86> for 32-bit. [For more information, follow steps provided in Section8.1 “Writing your own code”.

- Run NetSim in Administrative mode. Create a Network scenario involving IEEE802_11 say MANET, right click on the environment and select properties. Make sure that the Channel Characteristics is set to PathLoss and Fading and Shadowing.
- Perform Simulation. You will find that once the Simulation starts MATLAB command window starts and gets closed once the simulation is over.

**Note:** On Windows systems, engOpen opens a COM channel to MATLAB. The MATLAB software you registered during installation starts. If you did not register during installation, enter the following command at the MATLAB prompt:

```
!matlab -regserver
```

### 9.2.2 Debug and understand communication between NetSim and MATLAB

1. In the Solution Explorer double click on MATLAB_Interface.c file and place a breakpoint inside the fn_netsim_matlab_run() function before the return statement.
2. Rebuild the code.
3. Now run the NetSim Scenario. The simulation window stops for user interrupt.
4. In Visual studio, go to Debug → Attach to Process.
5. From the list of Processes select NetSimCore.exe and click on Attach.

6. Now go to the Simulation window and press Enter.
7. MATLAB Command Window and MATLAB Desktop Window will start and breakpoint in Visual Studio gets triggered.
8. Now when debugging (say, by pressing F5 each time) you will find the computation taking place in the MATLAB Workspace.

9. This value of $i$ obtained from MATLAB is used to calculate fading power instead of the already available models in NetSim.

10. Now place another breakpoint after the line $dFadingPower = fn_netsim_matlab_run()$
11. Add the variable dFadingPower in IEEE802_11.Phy.c file, to watch. For this, right-click on the variable dFadingPower and select “Add Watch” option. You will find a watch window containing the variable name and its value in the bottom left corner.

12. Now when debugging (say by pressing F5 each time) you will find that the watch window displays the value of dFadingPower whenever the control reaches the recently set breakpoint. You will also find that the value of dFadingPower in the Visual Studio Watch window and the value of i in the MATLAB workspace window are similar.
9.2.3 Implement Rician Distribution of MATLAB in NetSim using .m file:

Procedure:

1. Create a file named rician_distribution.m file inside <Path where MATLAB is installed>. The rician_distribution.m file contains the following code:

   ```matlab
   function WLAN = rician_distribution(noncentrality, scale)
   % use ProbDistUnivParam() function for matlab 2016
   h = ProbDistUnivParam('rician', [noncentrality, scale]);
   % use makedist() function for matlab 2017
   % h = makedist('rician', noncentrality, scale);
   i = random(h, 1);
   WLAN = i;
   ```

2. Place this file in the MATLAB’s default working directory. This will usually be MATLAB’s root directory or the bin folder in MATLAB’s installation path.

   **NOTE:** To determine path where MATLAB is installed, entering the following command in the MATLAB command prompt:

   ```matlab
   matlabroot
   ```

3. You will have to create a MATLAB_Interface.c file in the IEEE802_11 folder similar to the previous example. The functions fn_netsim_matlab_init() and fn_netsim_matlab_finish() will remain the same. Modify the function fn_netsim_matlab_run() that is part of MATLAB_Interface.c which was used in the previous example as shown below:

   ```c
   double fn_netsim_matlab_run()
   {
   // write your own implementation here
   int rician_noncentrality = 1, rician_scale = 2;
   engPutVariable(ep, "h", h);
   sprintf_s(buf, BUFSIZ, "k=rician_distribution(\%d,\%d)", rician_noncentrality, rician_scale);
   status = engEvalString(ep, buf);
   out = engGetVariable(ep, "k");
   result = mxGetPr(out);
   return *result;
   }
   ```

4. Follow steps 2 to 14 as explained in the section “Implement Rician Distribution of MATLAB in NetSim without using .m file” above.

5. A call to the rician_distribution() function inside the rician_distribution.m file is made, and rician_noncentrality and rician_scale parameters are passed from NetSim.

6. Right Click on IEEE802_11 project and select Rebuild.
7. A new libIEEE802.11.dll will get created in the bin folder of NetSim’s current workspace path <C:\Users\PC\Documents\NetSim_11.1.7_64_std_default\bin\bin_x64> for 64-bit and <C:\Users\PC\Documents\NetSim_11.1.7_32_std_default\bin\bin_x86> for 32-bit. Open NetSim in Administrative mode. Create a Network scenario involving IEEE802_11 say MANET, right click on the environment and select properties. Make sure that the Channel Characteristics is set to PathLoss and Fading and Shadowing.

8. You will find that once the Simulation is run MATLAB Command Window starts and gets closed once the Simulation is over. You can also debug the code to understand the communication between NetSim and MATLAB as explained in the DEBUGGING section above.

9.2.4 Plot a histogram in MATLAB per a Rician distribution (using .m file)

Procedure:

1. Create a file NETSIM_MATLAB.m file containing the following code:

```matlab
function WLAN=NETSIM_MATLAB(choice,varargin)

switch(choice)
    case 'rician'
    %use ProbDistUnivParam function for matlab 2016
    h=ProbDistUnivParam('rician',[varargin{1},varargin{2}]);
    %use makedist function for matlab 2017
    %h=makedist('rician',varargin{1}, varargin{2});
    i=random(h,1);
    fid = fopen('plotvalues.txt','a+');
    fprintf(fid,'%f',i);
    fprintf(fid,'\n');
    fclose('all');
    WLAN=i;
    case 'plothistogram'
    fid=fopen('plotvalues.txt');
    mx=fscanf(fid,'%f');
    hist(mx);
    fclose('all');
end
```

2. Modify the function fn_netsim_matlab_run() that is part of MATLAB_Interfacing.c which was used in the previous example.

```c
double fn_netsim_matlab_run(char *arr)
{
    //write your own implementation here
    int rician_noncentrality = 1, rician_scale = 2;
}```
if (strcmp(arr, "rician") == 0) {
    engPutVariable(ep, "h", h);
    sprintf_s(buf, BUFSIZE, "h=NETSIM_MATLAB('rician',%d,%d)",
        rician_noncentrality, rician_scale);
    status = engEvalString(ep, buf);
    out = engGetVariable(ep, "h");
    result = mxGetPr(out);
    return *result;
} else if (strcmp(arr, "plothistogram") == 0) {
    status = engEvalString(ep, "NETSIM_MATLAB('plothistogram')");
    return 0;
} else
    return 0;
}

Follow steps 2 to 11 as explained in the section on “Implement rician Distribution of MATLAB in NetSim without using .m file” above.

- A call to the NetSim_MATLAB() function inside the NetSim_MATLAB.m file is made, for fading power calculation with parameters distribution('rician'), rician_noncentrality and rician_scale parameters are passed from NetSim.
- A call to the NetSim_MATLAB() function inside the NetSim_MATLAB.m file is made, for plotting histogram for the values generated by MATLAB.
- Also add the following call to fn_netsim_matlab_run() function along with a _getch() to plot the histogram before closing the MATLAB Engine.

- Similarly in the call made to fn_netsim_matlab_run() function in IEEE802_11_PHY.c file add the parameter "rician" as shown below:
Also modify the function definition of fn_netsim_matlab_run() function in IEEE802_11.h file as shown below:

Right Click on IEEE802_11 project and select Rebuild will create a new libIEEE802.11. in the bin folder of NetSim’s current workspace path <C:\Users\PC\Documents\NetSim_12.0.18_64_std_default\bin\bin_x64> for 64-bit and <C:\Users\PC\Documents\NetSim_12.0.18_32_std_default\bin\bin_x86> for 32-bit.

Open NetSim in Administrative mode. Create a Network scenario involving IEEE802_11 say MANET, right click on the environment and select properties. Make sure that the Channel Characteristics is set to PathLoss and Fading and Shadowing.

You will find that once the Simulation is run MATLAB Command Window starts and once the Simulation is over a histogram is displayed in MATLAB for the values that were generated using rician distribution.
• The graph and the MATLAB windows gets closed once you press any key.

You can also debug the code to understand the communication between NetSim and MATLAB as explained in the DEBUGGING section above.
9.3 Interfacing tail with NetSim

What is a tail command?
The tail command is a command-line utility for outputting the last part of files given to it via standard input. It writes results to standard output. By default tail returns the last ten lines of each file that it is given. It may also be used to follow a file in real-time and watch as new lines are written to it.

PART 1:

Tail options

- The following command is used to log the file
  tail " path_to_file " -f
  where -f option is used to watch a file for changes with the tail command pass the -f option. This will show the last ten lines of a file and will update when new lines are added. This is commonly used to watch log files in real-time. As new lines are written to the log the console will update will new lines.

- If users don’t want the last ten lines of the file, then use the following command
tail -n 0 " path_to_file " -f
  where –n option is used to show the last n number of lines

- If you want to open more than 1 file then use the following command
tail –n 0 " path_to_file " " path_to_file " -f

PART 2:

Steps to log NetSim files using tail console

- Open bin folder of NetSim’s current workspace path
  (<C:\Users\PC\Documents\NetSim_12.0.18_64_std_default\bin\bin_x64> for 64-bit and <C:\Users\PC\Documents\NetSim_12.0.18_32_std_default\bin\bin_x86> for 32-bit) which contains tail.exe

- Open command window and change the directory to bin path of NetSim’s current workspace path (bin\bin_x86 for 32-bit and bin\bin_x64 for 64-bit)

- Type the following command to open ospf_log.txt file and press enter
tail -n 0 "C:\Users\PC\AppData\Local\Temp\NetSim\ospf_SPF_log.txt" -f

*Note: Users need to change the path of the file. In this example we are using ospf_log.txt file*
- Open solution file and add the following line in fn_NetSim_OSPF_Init() function in ospf.c file present inside OSPF project

```c
_block(int)* NetSim_OSPF_Init(struct netSim_Network* NETWORK_formal,
NetSim_EVENTDetails* pNetSimEventDetails_formal,
char* pAppNameFormal,
char* pAppPathFormal,
int mVersion_Type,
void** pNetSim_Win)
{
return 0;
}
```

- Rebuild the project
- Upon rebuilding, **libOSPF.dll** will get created in the bin folder of NetSim's current workspace
  - `<C:\Users\PC\Documents\NetSim_12.0.18_64_std_default\bin\bin_x64>` for 64-bit
  - `<C:\Users\PC\Documents\NetSim_12.0.18_32_std_default\bin\bin_x86>` for 32-bit.
- Create a scenario in NetSim as per the screenshot below and run simulation

  ![Scenario Screenshot](image)

  ![Code Screenshot](image)

- In the console window user would get a warning message shown in the below screenshot (because of changed DLL) and then the simulation will pause for user input (because of._getch() added in the init function)
• In Visual Studio, put break point inside all the functions in OSPF_SPF.c file present inside OSPF project

• Go to “Debug->Attach to Process” in Visual studio and attach to NetSimCore.exe.

• Press enter in the command window. Then control goes to the project and stops at the break point in the source code as shown below

![Source Code Screenshot](image)

• Press F5 and check the tail console to watch the ospf_SPF log would look like the following screenshot which calculates the shortest path for Router2

![Tail Console Screenshot](image)

• Keep pressing F5 will add the ospf_SPF log to the tail console. The below screenshot examines the WAN links connected to Router2 i.e. 11.2.1.2 and 11.5.1.2
In the above screenshot, the shortest path for Router2 is 11.2.1.2 with Metrics 0 since it is one of the Router2’s interface.

The below screenshot calculates the shortest path for Router5 and examines the WAN links connected to Router5 i.e. 11.4.1.1 and 11.5.1.1.

In the above screenshot, the shortest path for Router5 is 11.4.1.1 with Metrics 0 since it is one of the Router5’s interface.

The below screenshot calculates the shortest path for Router1 and examines the WAN links connected to Router1 i.e. 11.2.1.1 and 11.4.1.2.
In the above screenshot, the shortest path for Router1 is 11.4.1.2 with Metrics 0 since it is one of the Router5's interface.

As shown in the below screenshot, the router1 calculates another new entry i.e. 11.4.1.1 with metrics 100 since it is the next hop (Router5's 1st interface) connected to Router1.

Similarly, users can debug the code and observe how the OSPF tables get filled.

Users can also open multiple files by using the command given in section1.
9.4 Adding Custom Performance Metrics

NetSim allows users to add additional metrics tables to the Simulation Results window in addition to the default set of tables that are available at the end of any simulation. This has to be done via code by editing the source codes of the respective protocol.

General format to add custom metrics in Result window:

Every protocol has a main C file which contains a Metrics() function. For Eg: TCP project will have a TCP.c file, UDP will have an UDP.c file etc. In the following example we have added a new table as part of TCP protocol. TCP.c file contains fn_NetSim_TCP_Metrics() function where code related to custom metrics is added as shown below:

```c
#include <iostream>

int fn_NetSim_TCP_Metrics(PMETRICSWRITER metricsWriter)
{
    //CUSTOM METRICS
    PMETRICSNODE table = init_metrics_node(MetricsNode_Table, "CUSTOM METRICS", NULL);
    //Set table name
    add_table_heading(table, "COLUMN_HEADER_1", true, 0);
    add_table_heading(table, "COLUMN_HEADER_2", false, 0);
    //Add table data
    add_table_row_formatted(false, table, "%s,%s", "ROW_DATA1","ROW_DATA2");
    PMETRICSNODE menu = init_metrics_node(MetricsNode_Menu, "CUSTOM METRICS", NULL);
    //Add table to menu
    add_node_to_menu(menu, table);
    //Write to Metrics file
    write_metrics_node(metricsWriter, WriterPosition_Current, NULL, menu);
    delete_metrics_node(menu);
    //CUSTOM METRICS
    return fn_NetSim_TCP_Metrics_F(metricsWriter);
}
```

![Simulation Results Window with Custom Metrics](image)
For illustration, an example regarding Wireless Sensor Network is provided. In this example, parameters such as Sensor Node Name, Residual Energy, State (On/Off) and turn–off time are tracked and added to a new table in the Simulation Results window.

Refer Section 8.1 on writing your own code, for more information.

After loading the source codes in Visual Studio, perform the following modifications:

**Step 1:** Copy the provided code at the top in 802_15_4.h file

```c
string NetSim_Node_name[100];
double NetSim_Off_Time[100];
string NetSim_Node_state[100];
```

**Step 2:**

Add the header file in 802_15_4.c file

```c
#include "../BatteryModel/BatteryModel.h"
```

**Step 3:**

Copy the below code (in red colour) in 802_15_4.c file (inside fn_NetSim_Zigbee_Metrics() function)

```c
/** This function write the metrics in metrics.txt */
__declspec(dllexport) int fn_NetSim_Zigbee_Metrics(PMETRICSWRITER metricsWriter)
{
  //CUSTOM METRICS
  ptrIEEE802_15_4_PHY_VAR phy;
  ptrBATTERY battery;
  int i;
  char radiostate[BUFSIZ];
  NETSIM_ID nDeviceCount = NETWORK->nDeviceCount;
  //Set table name
  PMETRICSNODE table = init_metrics_node(MetricsNode_Table, "NODE_FAILURE_METRICS", NULL);
  //set table headers
  add_table_heading(table, "Node Name", true, 0);
  add_table_heading(table, "Status(ON/OFF)", true, 0);
  add_table_heading(table, "Residual_Energy (mJ)", true, 0);
  add_table_heading(table, "Time - Turned OFF (microseconds)", false, 0);
```
for (i = 1; i <= nDeviceCount; i++)
{
    sprintf(radiostate, "ON");
    phy = WSN_PHY(i);
    if (strcmp(DEVICE(i)->type, "SENSOR"))
        continue;
    if (WSN_MAC(i)->nNodeStatus == 5)
        sprintf(radiostate, "OFF");

    // Add table data
    add_table_row_formatted(false, table, "%s,%s,%.2lf,%.2lf,",
                              DEVICE_NAME(i),
                              radiostate,
                              battery_get_remaining_energy((ptrBATTERY)phy->battery),
                              NetSim_Off_Time[i - 1]);
}

PMETRICSNODE menu = init_metrics_node(MetricsNode_Menu,
                                         "CUSTOM_METRICS", NULL);
add_node_to_menu(menu, table);
write_metrics_node(metricsWriter, WriterPosition_Current, NULL, menu);
delete_metrics_node(menu);

// CUSTOM METRICS
return fn_NetSim_Zigbee_Metrics_F(metricsWriter);

Step 4:

Copy the below code (in red colour) at the end of ChangeRadioState.c file

if(isChange)
{
    phy->nOldState = nOldState;
    phy->nRadioState = nNewState;
    NetSim_Node_state[nDeviceId - 1] = "ON";
    NetSim_Node_name[nDeviceId - 1] = NETWORK->ppstruDeviceList[nDeviceId - 1] -> szDeviceName;
}
else
{
    phy->nRadioState = RX_OFF;
    WSN_MAC(nDeviceId)->nNodeStatus = OFF;
    NetSim_Off_Time[nDeviceId - 1] = ldEventTime;
NetSim_Node_state[nDeviceId - 1] = "OFF";
NetSim_Node_name[nDeviceId - 1] = NETWORK->ppstruDeviceList[nDeviceId - 1] -> szDeviceName;
}

return isChange;
}

Step 5:

Build DLL with the modified code and run a Wireless Sensor Network scenario. After Simulation, user will notice a new Performance metrics named “Custom Metrics” is added. The newly added NODE_FAILURE_METRICS table is shown below:

![Node Failure Metrics Table]

9.5 Adding Custom Plots

SNR measured by UE can be logged into a text file in a format expected by NetSim metrics window. Upon adding a reference to the SNR plot text files in the Metrics.xml file users can conveniently obtain SNR plots in NetSim Metrics window without having to use other tools like MS Excel, GNU Plot etc. Following is one such example where we log the SNR for each UE in a separate text file and obtain plots in NetSim Metrics window at the end of the simulation.

Step 1: Open NetSim source code in NetSim current workspace. For more information, please refer section “3.12 How does a user open and modify source codes”.

Step 2: Go to LTE project through the solution explorer and open the LTE.c file. In the function fn_NetSim_LTE_Init(), modify the function definition as shown below:

```c
_declspec(dllexport) int fn_NetSim_LTE_Init()
{
    int i = 0, j = 0;
    FILE* fp;
    char filename[BUFSIZ], nodename[BUFSIZ];
    j = fn_NetSim_LTE_Init_F();
```
for (i = 0; i < NETWORK->nDeviceCount; i++)
{
    if (DEVICE_TYPE(i + 1) == UE &&
        DEVICE_MACLAYER(i + 1)->nMacProtocolId == MAC_PROTOCOL_LTE)
    {
        sprintf(nodename, "LTE_SNR_UE_%d", i + 1);
        sprintf(filename, "%s\%s.txt", pszIOPath, nodename);
        fp = fopen(filename, "w+");
        if (fp)
        {
            fprintf(fp, "#Type=Line
#Heading=SNR Vs Time
#XLabel=Time(micro\sec)
#Num_Y=1
#YLabel=SNR(dBm)\n"");
            fclose(fp);
        }
    }
}
return j;
return fn_NetSim_LTE_Init_F();

Step 3: In the function fn_NetSim_LTE_Metrics(), add the lines of code highlighted in red as shown below:

\_declspec(dllexport) int fn_NetSim_LTE_Metrics(PMETRICSWRITER file)
{
    PMETRICSNODE menu = NULL;
    PMETRICSNODE rmenu = NULL;
    PMETRICSNODE submenu = NULL;
    PMETRICSNODE submenu1 = NULL;
    char filename[BUFSIZ], nodename[BUFSIZ];
    int i = 0;
    if (!rmenu)
        rmenu = init_metrics_node(MetricsNode_Menu, "Plots", NULL);
    if (!menu)
        menu = init_metrics_node(MetricsNode_Menu, "LTE_PLOTS", NULL);
    add_node_to_menu(rmenu, menu);
    for (i = 0; i < NETWORK->nDeviceCount; i++)
    {
        if (DEVICE_TYPE(i + 1) == UE &&
            DEVICE_MACLAYER(i + 1)->nMacProtocolId == MAC_PROTOCOL_LTE)
        {
            sprintf(nodename, "LTE_SNR_UE_%d", i + 1);
            sprintf(filename, "%s\%s.txt", pszIOPath, nodename);
            submenu1 = init_metrics_node(MetricsNode_Menu, nodename, NULL);
            add_node_to_menu(menu, submenu1);
            submenu = init_metrics_node(MetricsNode_Plot, nodename, filename);
            add_node_to_menu(submenu1, submenu);
        }
    }
    if (menu)
        write_metrics_node(file, WriterPosition_Current, NULL, rmenu);
    return fn_NetSim_LTE_Metrics_F(file);
}
**Step 4:** Open LTE_Phy.c file and add the lines of code highlighted in red in the function fn_NetSim_LTE_Mobility() as shown below:

```c
int fn_NetSim_LTE_Mobility(NETSIM_ID nDeviceId)
{
    FILE* fp = NULL;
    char filename[BUFSIZ], nodename[BUFSIZ];
    double dETime = 0;
    unsigned int j;
    if (DEVICE_MACLAYER(nDeviceId, 1) - nMacProtocolId == MAC_PROTOCOL_LTE) {
        .
        .
        .
    } else {
        info->DLInfo[j].nCQIIndex--;
        info->ULInfo[j].nCQIIndex--;
    }
    sprintf(nodename, "LTE_SNR_UE_%d.txt", fn_NetSim_GetDeviceIdByConfigId(info->nUEId));
    sprintf(filename, "%s\%s", pszIOPath, nodename);
    fp = fopen(filename, "a+");
    dETime = pstruEventDetails->dEventType;
    if (fp) {
        fprintf(fp, "\n%f,%f", dETime, info->ULInfo[0].dSNR);
        fclose(fp);
    } else {
        // Do nothing other mac protocol
    }
    return 1;
}
```

**Step 5:** Save the changes and right click on LTE module in the solution explorer and select Rebuild.

**Step 6:** Upon successful build, you will get a new libLTE.dll file in the bin folder of NetSim's current workspace path:
- `<C: \Users\PC\Documents\NetSim_12.0.18_64_std_default\bin\bin_x64>` for 64-bit
- `<C: \Users\PC\Documents\NetSim_12.0.18_32_std_default\bin\bin_x86>` for 32-bit

**Step 7:** Now on running any simulation in LTE, you will get individual SNR plots for each UE, in the NetSim Metrics window under **Plots->LTE_PLOTS** as shown below:
9.6 Environment Variables in NetSim

**NETSIM_PACKET_FILTER = <filter_string>** //used by NetSim developers to debug. Emulator code to passes filter string to windivert. See windivert doc for more information.

1. **NETSIM_EMULATOR_LOG = <log_file_path>** // Used by Real time sync function to log get event and add event. Used by NetSim developers to debug

2. **NETSIM_EMULATOR = 1** // Set by application dll or user to notify NetSim internal modules to run in emulation mode

3. **NETSIM_CUSTOM_EMULATOR = 1** // To notify NetworkStack to not load emulation dll and to only do time sync.

4. **NETSIM_SIM_AREA_X = <int>** // Area used by Mobility functions for movement of device. Set by config file parser or user.

5. **NETSIM_SIM_AREA_Y = <int>** // Same as above

6. **NETSIM_ERROR_MODE = 1** // if set then windows won't popup gui screen for error reporting on exception.

7. **NETSIM_BREAK = <int>** // Event id at which simulation will break and wait for user input. Equivalent to -d command in CLI mode.

8. **NETSIM_AUTO = <int>** // If set NetSim won't ask forkeypress after simulation. Useful to run batch simulations.

9. **NETSIM_IO_PATH = <path>** // IO path of NetSim from where it will read Config file and write output file. Equivalent to -IOPATH command in CLI mode.

10. **NETSIM_MAP = 1** // Set by NetworkStack to inform other modules that simulation is running per map view.

11. **NETSIM_ADVANCE_METRIC** // If set, NetSim provides a set of extra metrics.
In application metrics, you can see duplicate packets received.

12 NETSIM_CONFIG_NAME = <FILE NAME> // Config file name. This file must present in IOPath. If not set default value is Configuration.netsim

13 NETSIM_NEG_ID = 1 // If set, then control packets will have negative id.

14 NETSIM_PACKET_DBG = 1 // If set, then Simulation engine will log the packet creation and freeing

15 NETSIM_MEMCHECK = 1 // If set, then simulation will enable memory check.

16 NETSIM_MEMCHECK_1 = x // Lower event id

17 NETSIM_MEMCHECK_2 = x // Upper event id

9.7 Best practices for running large scale simulations

As we scale simulations, the number of events processed and the memory consumed increase. Simulation scale can be defined in terms of:

1 Number of Nodes
   • End nodes
   • Intermediate devices

2 Total traffic in the network
   • Number of traffic sources
   • Average generation rate per source

3 Simulation time

The simulators performance is additionally affected by:

• Protocols running
• Network Parameters such as Topology, Mobility, Wireless Channel etc
• Enabling/Disabling - Animation, Plots, Traces and Logs
• External Interfacing – MATLAB, Wireshark, SUMO

NetSim GUI limitation on total number of Nodes is as follows:

• NetSim Academic – 100
• NetSim Standard – 500
• NetSim Professional – No software limit

Recommended best practices for running large scale simulations are:

• Run 64-bit Build of NetSim
• Use the latest Windows 10 Build
• Use a system running a high-end processor with minimum 32 GB RAM
• Disable Animation – NetSim writes one file per node and windows limits the number of simultaneously opened files to 512.
• Disable plots, traces and logs to speed up the simulation
• If plots are enabled NetSim writes one file for each link and for each application. Therefore, it is recommended users only select those links/applications for which they wish to plot output performance. Plots for all other applications/links should be disabled.
• NetSim writes one packet trace and one event trace file per simulation. If users wish to open this file in MS-Excel, please note Excel’s limit of 1 Million rows.
• Packet trace and Event trace can be disabled to speed up the simulation.
• Running simulations via CLI mode will save memory
10 NetSim Emulator

NOTE: Emulator will be featured in NetSim only if license for Emulator Add-on is available

10.1 Introduction

A network simulator mimics the behavior of networks but cannot connect to real networks. NetSim Emulator enables users to connect NetSim simulator to real hardware and interact with live applications.

10.1.1 Simulating and Analyzing Emulation Examples

To simulate the different types of Emulations Examples such as PING (both one way and two way communications), Video (one way communication), File trasfer using Filezilla, Skype etc

1. Go to the NetSim UI and click Examples.
   The Example Simulation pane appears at the right.
2. Click the type of Emulation example you want to simulate.
   NetSim UI loads the example and displays the stage and the UI options to simulate.
3. To view help documentation for Emulation, click the ‘Book’ link located next the Emulation node.
11 Troubleshooting in NetSim

This section discusses some common issues and solutions:

11.1 CLI mode

While running NetSim via CLI for the scenarios described in the Configuration file, you may bump into a few problems.

Note: While running NetSim via CLI, try to ensure that there are no errors in the Configuration.netsim file. The file, ConfigLog.txt, written to the windows temp path would show errors, if any, found by NetSim’s config parser.

11.2 I/O warning displayed in CLI mode

Reason: While typing the CLI command if you enter a wrong I/O Path, or if there is no Configuration.netsim file then the following error is thrown

![CLI Command Example]

Solution: Please check the I/O path.

11.2.1 Connection refused at server<-111> error displayed:

Reason: Unable to communicate with the license server
Solution: In this example, license server IP address is 192.168.0.185 but it is given as 192.168.0.180. Here server IP address is wrong. Same error message is shown for wrong port number, wrong tag name like –apppath, -iopath, -license. For example, if –apppath is typed instead of –apppath then this message will be shown. So, check those details.

11.2.2 Unable to load license config dll(126):

Apppath and I/O path have white spaces

Solution: If the folder name contains white space, then mention the folder path within double quotes while specifying the folder name in the command prompt. For example, if app path contains white space, then the app path must be mentioned within double quotes in the command prompt.

11.2.3 “Error in getting License” error in CLI mode:

Simulation does not commence. “No license for product (-1)” is displayed in the command prompt.

Example:
Solution: NetSim is based on the client-server architecture. When NetSim runs in the client machine, it will check for the license in the same machine, first. If license is not available in the same machine, then “No license for product (-1)” will be displayed in the command prompt and the server machine will be checked for the availability of license. If no license is available in the server machine also, then again “No license for product (-1)” will be displayed in the command prompt.

If “No license for product(-1)” is displayed in the command prompt two times, then check in the NetSim license server to know about the availability of license and adjust the number of current users of NetSim, in order to get the license.

11.2.4 Unable to load license config dll displayed:

Reason: If the command/opath provided by the user is first written in MS Word and then copy pasted to Command prompt, some special characters(not visible in command prompt) gets inserted and on execution, license config dll is not found.
Solution: Type the command manually or copy paste the command/iopath from notepad.

11.3 Configuration.netsim

11.3.1 Invalid attribute in configuration file attributes:

Specific attributes in the Configuration file are highlighted with zigzag lines

Reason: If invalid input is given in the Configuration file, then the corresponding attribute is highlighted as blue lines as shown in the figure given below.

Solution: To resolve this issue mouse over the corresponding attribute, in order to get the tooltip that furnishes the details about the valid input for that attribute.

Note: If the schema file and the configuration file are not present in the same folder, the zigzags won’t appear. So place the Configuration file and Schema File in the same location or change the path of schema file in the configuration file.

11.3.2 Error in tags in configuration file attributes:

Simulation does not commence and error is displayed at the command prompt. Also, red lines appearing at the tag specifying the Layer in the Configuration file

Reason: This issue arises mainly when the closing tag is not specified correctly for a particular layer in the Configuration file.
**Example:** If the closing tag is not specified for the Data link Layer, then the zigzag lines appear at the starting tags of Data link Layer and the Network Layer.

When NetSim is made to run through CLI, then the following error gets displayed in the command prompt.

**Solution:** The bug can be fixed by setting the closing tag correctly in the Configuration file

11.3.3 Error lines in configuration.xsd in the Configuration file:

Blue lines appear at configuration.xsd in the Configuration file

**Reason:** This issue arises when the schema and the configuration file are not in the same folder.
Solution: The bug can be fixed by placing the Configuration file and schema in the same folder.

11.4 Simulation terminates and “NetSim Backend has stopped working” displayed:

Simulation terminates and exhibits unpredictable behavior. An error message stating, “An exe to run NetSim backend has stopped working” is thrown

Example:

![Error message](image)

This problem arises if there is any flaw in the Configuration.netsim or in the dll.

Solution: Check whether the desired scenario has been configured properly in the Configuration.netsim.

11.5 Monitor screen resolution is less than 1024X768:

While starting NetSim, error shows the monitor screen resolution is less than 1024 X 768.

Reason: This error will come if monitor resolution is less than 1024 and 768. For example, 1260 X 720 will also show this error

Solution: Change your monitor resolution to 1024 X 768 or above.
11.6 Licensing

11.6.1 No License for product (-1) error

NetSim dongle is running in the server system. When running the NetSim in the Client system showing “No License for product (-1)” error.

Possible Reasons

1. Firewall in the client system is blocking the Network traffic.
2. No network connection between Client and Server.
3. License Server is not running in the Server system.

Solution

1. The installed firewall may block traffic at 5053 port used for licensing. So either the user can stop the firewall, or may configure it to allow port 5053.
2. Contact the Network-in-charge and check if the Server system can be pinged from client.
3. Check whether License Server is running in the Server system or not.

11.7 Troubleshooting VANET simulations that interface with SUMO

11.7.1 Guide for Sumo

- In case sumo Configuration files do not open, Right click on any Sumo Configuration file, go to properties→open with→sumo.
- While Running NetSim Vanet Simulation – If any message pops up as “SUMO_HOME” Not found→ Go to My computer → System Properties → Advanced system settings → Environment Variables. Add an Environment variable as “SUMO_HOME”.
- Sumo Configuration File must contain the paths of the Vehicle routes and Networks file.
- Set the exact End Time for Sumo Simulation in Sumo Configuration File.

11.7.2 Guide for Python

- Any Python 2.7 version Installer would work fine for running simulations.
- If you have installed python by an external Installer, make sure the Python Path is set. It would be set automatically by python installer that comes with NetSim.
- In case “Pywin 32” is not getting installed, or during simulation, error occurs as “win32 modules not found” try the code below (Run it as a python Code).
import sys
from _winreg import *
# tweak as necessary
version = sys.version[:3]
installpath = sys.prefix
regpath = "SOFTWARE\Python\PythonCore\%s\" % (version)
installkey = "InstallPath"
pythonkey = "PythonPath"
pythonpath = "%s;%s\Lib;%s\DLLs\" % (installpath, installpath, installpath)

def RegisterPy():
    try:
        reg = OpenKey(HKEY_CURRENT_USER, regpath)
    except EnvironmentError as e:
        try:
            reg = CreateKey(HKEY_CURRENT_USER, regpath)
            SetValue(reg, installkey, REG_SZ, installpath)
            SetValue(reg, pythonkey, REG_SZ, pythonpath)
            CloseKey(reg)
        except:
            print "*** Unable to register!"
            return
        print "--- Python", version, "is now registered!"
        return
    if (QueryValue(reg, installkey) == installpath and
        QueryValue(reg, pythonkey) == pythonpath):
        CloseKey(reg)
        print "=== Python", version, "is already registered!"
        return
    CloseKey(reg)
    print "*** Unable to register!"
    print "*** You probably have another Python installation!"
    if __name__ == "__main__":
        RegisterPy()
11.7.3 VANET Simulation
   i. Changing Vehicle (Node) Names, Moving or deleting vehicles etc are disabled in Vanets Simulation.
   ii. On running simulation, Backend calls Python file.
   iii. NetSim protocol engine waits for the Pipes connection to be established.

11.7.4 Python
   • SUMO_HOME Environment variable is checked. If Environment variable is not present, Error is displayed as “key interrupt error” in SUMO_HOME.
   • Python File waits for Pipes connection. (“waiting for pipes to connect”).
   • It reads initial data as GUI enable/disable from backend.
   • “Checking sumo” is printed. If the environment variable SUMO_HOME points to wrong directory, error is displayed.
   • Sumo Simulation is started where Sumo Binary is checked (To check Sumo.exe or Sumo GUI are working in the system or not). Then a TCP connection is made
   • A while loop runs – It follows the following procedure
     i. Send Garbage value to Backend to clear pipe buffers (pipes).
     ii. Read Vehicle name from NetSim (pipes).
     iii. Compare with each vehicle present in Sumo. If vehicle is present – Then write confirmation (pipes) and read its position from NetSim (2pipes for X and Y coordinates). Also, sumo is stepped forward for every first vehicle in the list of current vehicles in sumo.
        • If vehicle not present, fail (‘f’) is sent.
        • Pipes and TCP closed.

11.7.5 NetSim Core Protocol Library
   • After establishing the connection, NetSim VANET Library checks for GUI flag, and sends ‘1’ if animation status is online.
   • As simulation proceeds, NetSim VANET library sends vehicle name to python, and receives XY positions, which are passed from python.
   • Positions are updated and simulation proceeds.
12 Known Issues in NetSim v11.1

List of known issues in v11.1 is available at

https://tetcos.freshdesk.com/solution/articles/14000089935-list-of-known-issues-in-netsim-v11

13 NetSim Videos

In order to have a better understanding of NetSim, users can access YouTube channel of Tetcos at www.youtube.com/tetcos and check out the various videos available

14 R&D projects in NetSim

Example R & D projects in NetSim is available in www.tetcos.com/file-exchange.

15 NetSim FAQ/Knowledgebase

NetSim knowledgebase with hundreds on FAQs on how NetSim works is available at https://tetcos.freshdesk.com/support/home